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Preface

The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available
on your network from which you can access the Agile PLM documentation (PDF) files.

Note To read the PDF files, you must use the free Adobe Acrobat Readeré, ¢ version 7.0 or
later. This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals
in both the Agile Web Client and the Agile Java Client. If you need additional assistance or
information, please contact support http://www.oracle.com/agile/support.htmi
(http://www.oracle.com/agile/support.html) for assistance.

Note Before calling Agile Support about a problem with an Agile PLM manual, please have the
full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.htmi

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.
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Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Import Basics

This chapter includes the following:

ADOUL the IMPOIt WIZAIU ...t 1
What's New in Importing Data for 9.2.2.57 ... s 3
Before Using the IMPOrt WIZAH. ...ttt

Privileges Required to Use the Import Wizard
Recommended Sequence for Importing Data
WHen t0 IMPOIt LAIGE FIES ....vvcvevieceeiiieriscieisies ettt
Starting the IMPOMt WIZAIH ..........ceiceiccces ettt nnenns
IMPOTT WIZAIT SEEPS v.vvvievrireeiireieieierets ettt b bbbttt

About the Import Wizard

Agile’s Import wizard is a tool used to import data into the Agile PLM system. The supported
formats are Excel workbooks, delimited text files, Product Data Exchange Packages, and Agile XML
(aXML) files. Objects that you can import for different PLM modules are listed below. For more
information and procedures, see Preparing and Selecting Source Data on page 7

Product Collaboration

Objects that you can import into the PC module are:

m]

m]

u]

u]

Iltem
Manufacturer
Manufacturer Part

Part Group

Product Cost Management

Objects that you can import into the PCM module are:

u]

m]

m]

Sourcing Projects

Quote histories
Published prices
Suppliers

Supplier RFQ responses

Currency conversion tables

Agile Product Lifecycle Management Page - 1
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Product Service & Improvement

Objects that you can import into the PS&M module are:

= Product Service Request
= Quality Change Request

o Customer

Product Governance & Compliance

Objects that you can import into the PG&C module are:

@ Declarations
B Substances

o Specifications
Product Portfolio Management

Objects that you can import into the PPM module are:
= Program
= User

@ User Group

Page - 2
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What’s New in Importing Data for 9.2.2.5?

No new features or enhancements were implemented in the Import component in this release. The
only changes made were new Part and Release numbers and the publication date.

Before Using the Import Wizard

Before using the Import wizard, make sure you have the necessary software and privileges.

= Toimport data into the Agile PLM system, you must have the appropriate Agile PLM privileges.
See the next section, Privileges Required to Use the Import Wizard on page 3.

o To create PDX packages, use the Agile Content Service (ACS), Agile Web Client, or Agile
Integration Services.

Note Creating PDX packages is similar to creating aXML files.

@ To view PDX packages, use Agile eXpress. You can download Agile eXpress from the
following Website, or extract the Agile PDX package into the aXML file;which you can view
using any XML viewer:

http://www.myagile.com/eservices/express/

o To create aXML files, use the Agile Web Client, Agile Content Service (ACS), Agile Integration
Services (AIS), or use the Export aXML command from the Actions menu of a declaration. You
can view aXML files in any XML viewer, including Internet Explorer.

= Make sure the Agile PLM system has the necessary disk space to accommodate importing
large PDX packages and axXML files.

= If you are importing data from text files, check your source data to make sure that it is properly
formatted. Do not skip this step. The little time spent here will save you far more time in the
end. I "Importing Currency Values" on page 12

Privileges Required to Use the Import Wizard

To import Agile data, you must have Create, Discover, Read, and Modify privileges for each type of
Agile object you are importing. You must also have the ability to either create and modify change
orders or discover and read them. Change orders are needed to redline BOMs, AMLs, and
published prices. In addition, you must also have the Import privilege.

If you have questions about privileges, contact your Agile PLM administrator or refer to the Agile
PLM Administrator Guide.

To launch Import, you must have the My User Profile role, the Read User privilege, and the Import
privilege.

Page - 3


http://www.myagile.com/eservices/express/

Import/Export Guide

Recommended Sequence for Importing Data

Although you can import objects in any order, it makes sense to import parent objects before
importing data for the children.

Sequence for Importing Product Content

If you are importing product content, use the following recommended import sequence:
1. Manufacturers

Manufacturer parts

Items

Bills of material (BOMSs)

Approved manufacturers lists (AMLS)

o g A~ w D

Part Groups

Note If you are importing data from aXML or PDX packages, you can import these
objects in one session.

When you import data following this recommended sequence, parent items as well as
manufacturers and manufacturer parts will already exist and populated with data when you reach
steps 4, 5, and 6 in the preceding list. If you do not follow the recommended sequence, the Import
wizard creates objects referenced in the import data. You can go back to a previous step in the
sequence (for example, importing items) to import data to objects you created with the Import
wizard.

Sequence for Importing Published Prices

A price object references an item or manufacturer part, supplier, and customer. Therefore, those
objects need to be imported before prices.

Sequence for Importing Product Service Requests

Product service requests reference customers and suppliers. Therefore, you must import customers
and suppliers before Product service requests:

1. Customers
2. Suppliers

3. Product service requests
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Sequence for Importing Quality Change Requests

Quality change requests reference customers and suppliers. Therefore, you must import customers
and suppliers before Quality change requests:

1. Customers
2. Suppliers

3. Quality change requests

Sequence for Importing Supplier Manufacturer Offerings

Manufacturers referenced by a supplier's manufacturer offerings must already exist before the
offerings are imported. Therefore, you should import manufacturers before supplier manufacturer
offerings.

Sequence for Importing Product Governance & Compliance Objects

If you are importing Product Governance & Compliance data, use the following recommended
import sequence:

1. Substances
2.  Specifications

3. Declarations

Objects that You Can Import in Any Sequence

You can import the following data at any time in any sequence:
o Attachments
@ Programs

= Suppliers and supplier commodity offerings (See Sequence for Importing Supplier
Manufacturer Offerings on page 5 above)

o Supplier RFQ Responses

= Currency Exchange Rates

When to Import Large Files

Agile Import Server supports aXML files and PDX packages, which can contain thousands of
objects. For example, you could import hundreds of items from a PDX package, and each item
could have several hundred BOM components. Due to the potential for such large source files,
when you perform import sessions is important.

If you are importing large amounts of data during one import session, you should perform the
session during non-business hours—on evenings or during the weekend—when system usage is
low.
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How much data is considered a large amount? It depends on your Agile PLM system and the size
of your database. Use your best judgment. If you plan to import a large amount of data, do it after
hours.

After the import session is finished, you can view the log file in a browser or save it to a file.

Note For faster results, uncheck the Log Transformations preference before importing a large
file. For more information, see Setting Import Preferences on page 35.

Starting the Import Wizard

The Import wizard provides a simple process for importing data into the Agile PLM system.
o To start the Import wizard in either the Java Client or Web Client, choose Tools > Import.

= Toimport an RFQ response or items, BOMs, and AMLSs for a sourcing project, you can start the
Import wizard from an RFQ or a sourcing project. For more information, see Importing Supplier
and System Data 75 and Importing Data into a Sourcing Project on page 85.

= Toimport an item using level template, select ltem >Actions >Microsoft Excel > Import from Excel.

Note You can also start the Import wizard by clicking the Import button on the
Attachments tab of a package. For more information, see “Importing
Attachments from an Agile Package "Importing Attachments from an Agile
Package" on page 73.

Import Wizard Steps

When you import data into the PLM, the Import wizard displays the following steps:
1. Import Source — Specifies the import file and the file type.
2. Select Contents to Import — Specifies the type of data to import.

3. Select Change Order and Mapping File — If you are importing items or prices in Redlining mode,
specify a change order for the import session. Also specify how fields in the import data should
be mapped to Agile fields.

4. Select Transformation Definition File — Specifies how to modify the import data for the target Agile
PLM system by replacing, prefixing, or suffixing certain fields. This is an optional step.

5. Review Settings and Begin Import — Lets you review your selections and begin the import process.
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Preparing and Selecting Source Data

This chapter includes the following:

SUPPOIEA FilE FOMMALS ....v.vvcveeieceisscie st s s n e
ADOUL AQIIE PLM FIBILS ..ottt s
Supported Formats for Date Values
IMPOTING CUITENCY VAIUES ..ottt ettt
Importing Money Values............ccoovverrnenirnnnnn,

IMPOTEING MASS VAIUES ....o.vuvecvieicieiescisie ettt se s
Importing GeographiCal LOCAtIONS .......cccvviveeiireiricreisiisesisisesissees s ssss s ss s snsesesnsseens
Importing Values to Dynamic Lists ....................

IMPOTING CASCAAING LISLS .....cveerieeiietirire ettt ettt bbbt
Using BOM Reference Designators
Guidelines for Excel Files and Delimited TEXE FIlES........oirriiniieiineseiseisessss s sssnns
Importing Data from Microsoft Excel Files
Importing Data from Delimited Text Files
Importing Data from PDX Packages and aXML Files
Using TemMPIAes t0 IMPOM DAL .......cvcueurieieereeieireeie ettt bbbt
Importing Objects into RelationShip TADIES .......ccvieriiiricies e

Supported File Formats

The Import wizard lets you import data in the following data formats:

Format Description

Delimited Text File A standard flat text file where each field of data is delimited by a special
character, such as a comma or a tab.

Excel Workbook Microsoft Excel workbook files. The Import wizard supports files created
with Microsoft Excel 2000, 2002, and 2003.

Product Data eXchange An industry standard format for product data based on XML (eXtensible

(PDX) Package Markup Language) technology.

Agile XML (aXML) File Agile’s proprietary XML format that includes data that is not supported by

PDX, such as declarations, substances, prices, or suppliers.
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About Agile PLM Fields

Before you import data from source files into the Agile PLM system, you should understand the
requirements for each field for which you can import data. Certain fields are required, which means
they must be mapped in the Import wizard. Fields also have data types, which determine how the
data should be formatted, and maximum lengths, which the Agile PLM system validates on import.

Each Agile object has several fields, which are instances of the attributes defined for that object’s
class or subclass. There are many Agile classes and subclasses, and the Agile Administrator can
customize the system with additional subclasses that are applicable to the site.

Printing the Agile Classes Report

Before importing data, print the Agile Classes Report from the Web Client. Read the report and
become familiar with the Agile data model. Make sure your source data conforms to the data
requirements specified in the report.

To run the Agile Classes Report from the Web Client:

1. Click Reports in the Navigation pane.

2. Select Administrator Reports > Agile Classes Report.
3.  Click Execute.
4

Specify parameters used to run the report. Click Finish. After a few seconds a File Download
window prompts you to save or open the file.

5. Save the report your computer.

The Agile Classes Report is a comma-separated text file. It lists the attributes available on each
table of each class. It also indicates whether a field is required for the Import wizard. If a field is
required for the Import wizard, source data must be mapped to the target field. Otherwise, the
object cannot be imported.

Data Types

Each read/write Agile PLM field has one of the following data types:

Data type Description
Text A string value.
MultiText Text that can span multiple lines.
Date A date value.
Numeric A number rounded to two decimal places.
Money Similar to the number data type, but it defaults to four decimal places and its unit is a particular currency.
List A string value selected from a list of possible values.
MultiList One or more string values (in comma-delimited format) selected from a list of possible values.
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Data type Description

Unit of Measure (UOM) A numerical quantitative measurement. The value is expressed as a number multiplied by a standard
unit (for example, gram or ounce).

Maximum Length Values for Fields

Many Agile PLM fields have a maximum length. If a value exceeds the maximum length for a field, it
is invalid and cannot be imported. The Import wizard has a preference that lets you handle values
that fail length validation. You can choose to either reject such values or truncate them so they can
be imported. For more information, see Setting Parsing and Validation Options on page 35.

All text fields have a maximum length. Some text fields are restricted to just a few characters.
Others, such as the Parts Class > BOM > BOM Notes field can be much longer.

Date fields do not have a maximum length, but all date values must be a date format supported by
the Agile PLM system. For more information, see Supported Formats for Date Values on page 9.

Parent and Child Fields

Several read-only fields have a child relationship with other parent fields. Child fields derive their
values from parent fields. Examples of child fields include BOM table attributes like “BOM.Item
List02” and “BOM.Item Text01,” whose parent fields are located on Page Two.

It's important for the Agile PLM administrator to ensure that all child fields are configured identically
to their parent fields. Otherwise, problems could occur when you import data.

Supported Formats for Date Values

The Import wizard supports a variety of date formats based on several different criteria, including
user preferences and locale.

Note The upper limit for dates is today’s date + 150 years. Date values later than that are
invalid and cannot be imported.

Setting the Preferred Date Format and Time Zone

Each Agile user can select a preferred date format.

To change date format preferences for your Agile account:

1. Use one of the Agile clients to set user preferences:
* Inthe Agile Web Client, click Settings > User Profile > Preferences > Edit.
* Inthe Agile Java Client, click Settings > Current User > Preferences.

2. Select the desired date format in the Preferred Date Format field.
3. Select a GMT time zone in the Time Zone field.
4. Click Save.
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Supported Date Formats

The Import wizard supports all combinations of date and time formats available in the
java.text.DateFormat class as well as additional formats. DateFormat provides many date and time
formatting styles based on locale. The following table shows date formats available for the U.S.

locale, evaluated in order:

Date Format

Example

MMM-dd-yyyy HH:mm:ss

Jul-10-2001 14:08:35

MMM-dd-yyyy HH:mm

Jul-10-2001 14:08

MMM-dd-yyyy hh:mm:ss a

Jul-10-2001 02:08:35 PM

MMM-dd-yyyy hh:mm a

Jul-10-2001 02:08 PM

MMM-dd-yyyy

Jul-10-2001

dd-MMM-yyyy HH:mm:ss

10-Jul-2001 14:08:35

dd-MMM-yyyy HH:mm

10-Jul-2001 14:08

dd-MMM-yyyy hh:mm:ss a

10-Jul-2001 02:08:35 PM

dd-MMM-yyyy hh:mm a

10-Jul-2001 02:08 PM

dd-MMM-yyyy

10-Jul-2001

EEEE, MMMM d, yyyy

Thursday, June 25, 1998

EEEE, MMMM d, yyyy h:mm a

Thursday, June 25, 1998 1:32 PM

EEEE, MMMM d, yyyy h:mm:ss a

Thursday, June 25, 1998 1:32:19 PM

EEEE, MMMM d, yyyy h:mm:ss a z

Thursday, June 25, 1998 1:32:19 PM GMT-05:00

MMMM d, yyyy

June 25, 1998

MMMM d, yyyy h:mm a

June 25, 1998 1:32 PM

MMMM d, yyyy h:mm:ss a

June 25, 1998 1:32:19 PM

MMMM d, yyyy h:mm:ss a z

June 25, 1998 1:32:19 PM GMT-05:00

MMM d, yyyy

Jun 25, 1998

MMM d, yyyy h:mm a

Jun 25, 1998 1:32 PM

MMM d, yyyy h:mm:ss a

Jun 25, 1998 1:32:19 PM

MMM d, yyyy h:mm:ss a z

Jun 25, 1998 1:32:19 PM GMT-05:00

Midlyy 6/25/98

M/dlyy h:mm a 6/25/98 1:32 PM

M/dlyy h:mm:ss a 6/25/98 1:32:19 PM

M/dlyy h:mm:ss a z 6/25/98 1:32:19 PM GMT-05:00
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Each date format is specified using a time pattern string where

y = year

M = month in year

d = day in month

H = hour in military time (24-hour clock)
h = hour in AM/PM (1~12)
m = minute in hour

s = second in minute

E = day in week

a = AM/PM marker

z = time zone

' = escape for text

" = single quote

The count of each letter such as “M” in the time pattern determines the format. For example, three
“M” characters indicate that the month is represented as text instead of a number; less than three
“M” characters means that the month is represented by a number.

For more information about Java date formats and time pattern syntax, see Sun’s documentation for
the SimpleDateFormat and DateFormat classes:

http://www.javasoft.com/j2se/1.3/docs/api/index.html

Specifying Time Zones

Date values can specify a GMT time zone. If a date value omits the time zone, the user's time zone
preference is used. Time zones must be entered in the following format:

GMT Sign hh:mm

where:
GMT = Greenwich Mean Time
Sigh =+ or -
h = hour in AM/PM (1~12)

m = minute in hour
For example, “GMT-05:00" and “GMT+02:00" are valid time zones.

Note Do not use three-character codes (such as PST or PDT) to specify time zones. Three-
character time zone codes are unreliable because some are used for multiple time zones.
Consequently, the Agile PLM server might resolve a three-character time zone code to an
incorrect time zone.

aXML and PDX Package Date Formats

For aXML and PDX packages, the Import wizard supports a relaxed version of the ISO String date
format:
yyyy/MM/ddTHH:mm:ssZ. However, the T and Z characters are required.
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Importing Currency Values

Price Line and Supplier objects allow you to import values to currency fields. Currency values can
be imported if they are entered as a three-letter ISO 4217 currency code or the full currency name.
For example, “USD” and “U.S. Dollar” are both valid currency values that can be imported. “U.S.

Dollar (USD)” cannot be imported.

Agile supports many different currencies. The list of available currencies is determined when the
Agile PLM system is installed. For more information about ISO 4217 currency codes, see the

following Web site:

http://www.iso.org/iso/en/prods-services/popstds/currencycodeslist.html

@ ADP - Andorran
Peseta

@ AED - UAE Dirham

o ALL - Bulgarian Lek
ALL

o AMD - Armenian Dram
(A

o ANG - Netherlands
Antillean Guilder

o AON - New Kwanza

o AOR - Kwanza
Reajustado

= ARP - Argentine Peso
@ ATS - Austrian Shilling
@ AUD - Australian Dollar
@ AWF - Aruban Florin

o AWG - Aruban Guilder

o AZM - Azerbaijanian
Manat

@ BAK - Bosnia -
Herzegovina
Convertible Mark

o BBD - Barbados Dollar

o BDT - Bangladeshi
Taka

= BEF - Belgian Franc
= BGL - Bulgarian Lev

[u]

CRC - Costa Rican
Colon

CUP - Cuban Peso

CVE - Cape Verde
Escudo

CYP - Cyprus Pound
CZK - Czeck Koruna
DEM - Deutsche Mark
DJF - Djibouti Franc
DKK - Danish Krone
DOP - Dominican Peso
DZD - Algerian Dinar

ECS - Ecuadorian
Sucre

EEK - Estonian Kroon
EGP - Egyptian Pound
ERN - Eritrean Nakfa

ESP - Spanish Peseta
ESP

ETB - Ethiopian Birr
EUR - Euro

FIM - Finland Markka
FJD - Fiji Dollar

FKP - Falkland Islands
Pound

FRF - French Franc

o

o

o

GBP - Pound Sterling
GEL - Georgian Lari
GHC - Ghanaian Cedi
GIP - Gibraltar Pound
GMD - Gambian Dalasi
GNF - Guinean Franc
GRD - Greek Drachma

GTQ - Guatemalan
Quetzal

GYD - Guyanan Dollar

HKD - Hong Kong
Dollar

HNL - Honduran
Lempira

HRK - Croatian Kuna
GTG - Haitian Gourde

HUF - Hungarian
Forint

IDR - Indonesian
Rupiah (IDR)

IEP - Irish Pound
ISL - Israeli Shekel
INR - Indian Rupee
IQD - Iraqui Dinar
IRR - Iranian Rial

ISK - Icelandic Krona
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ITL - Italian Lira

JMD - Jamaican Dollar
JOD - Jordanian Dinar
JPY - Japanese Yen
KES - Kenyan Shilling

KGS - Kyrgyzstani
Som

KHR - Cambodian Riel
KMF - Comorian Franc

KPW - North Korean
Won

KRW - South Korean
Won

KWD - Kuwaiti Dinar

KYD - Cayman Islands
Dollar

KZT - Kazakhstani
Tenge (KZT)

LAK - Laotian Kip
LPB - Lebanese Pound

LKR - Sri Lankan
Rupee

LRD - Liberian Dollar
LSL - Lesotho Loti
LTL - Lithuanian Litas

Luxembourg Franc
(LUF)

LVL - Latvian Lats
LYD - Libyan Dinar

MAD - Moroccan
Dirham

MDL - Moldovan Leu
MGF - Malagasy Franc

MKD - Macedonia
Denar

MMK - Myanmar Kyat

MNT - Mongolian
Tugrik

MOP - Macau Pataka

MRO - Mauritania
Ouguiya

MTL - Maltese Lira

MUR - Mauritius
Rupee

MVR - Maldives
Rufiyaa

MWK - Malawian
Kwacha

Mexican Nuevo Peso
(MXP)

MYR - Malaysian
Ringgit

MZM - Mozambican
Metical

NAD - Namibian Dollar
NGN - Nigerian Naira
NIO - Cordoba Ora

NLG - Netherlands
Guilder

NOK - Norwegian
Krone

NPR - Nepalese
Rupee

NZD - New Zealand
Dollar

OMR - Omani Riyal

PAB Panamanian
Balboa

PEN - Peruvian Nuevo
Sol

PGK - Papua New
Guinea Kina

PHP - Philippine Peso
PKR - Pakistan Rupee
PLZ - Polish Zloty

PTE - Portuguese
Escudo

PYG - Paraguay
Guarani

QAR - Qatari Riyal
ROL - Romanian Leu
RUR - Russian Ruble
RWF - Rwanda Franc
SAR - Saudi Riyal

SBD - Solomon Islands
Dollar (SBD)

SCR - Seychelles
Rupee

SDD - Sudanese Dinar
SEK - Swedish Krona

SGD - Singapore
Dollar

SHP - St. Helena
Pound

SIT - Slovenian Tolar
SKK - Slovak Koruna

SLL - Sierra Leone's
Leone

SOS - Somali Shilling
SRG - Surinam Guilder

STD - Sao Tome
Dobra

SVC - El Salvador
Colon

SYP - Syrian Pound
SZL - Swazi Lilangeni
BHT - Thai Baht

TJR - Tajik Ruble

TMM - Turkmenistan
Manat

TND - Tunisian Dinar

TOP - Tongan
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Pal'anga
TLR - Turkish Lira

TTD - Trinidad and
Tobago Dollar

TWD - New Taiwan
Dollar

TZS - Tanzanian
Shilling

UGX - Uganda Shilling
USD - U.S. Dollar
UYU - Uruguayo Peso

UZS - Uzbekistan Som

VEB - Venezuelan
Bolivar

VND - Viet Nam Dong
VUV - Vanuatu Vatu
WST - Samoa Tala

XAF - Central African
Franc

XCD - East Caribbean
Dollar

XPF - CFP Franc

(French overseas
possessions)

YER - Yemeni Rial

YUN - Yugoslav New
Dinar

ZAR - South African
Rand

ZMK - Zambian
Kwacha

ZWD - Zimbabwe
Dollar

Importing Money Values

The money datatype is a compound datatype that includes a numeric value and a currency code,
such as j°USDijz for U.S. Dollars. Import supports both money value and currency. The user
preferred currency is chosen if currency is not specified in source file. If the source file is a delimited
text file or an Excel file, money values can be combined with currency code, in this format USD:100,
or separate money value and currency code in two fields. The Import wizard will reject non-numeric
money values. If the source file is:

= An aXML file, the Import wizard will load the currency code from the source file.

o A PDX package, the Import wizard will load the user specified preferred currency, because
there is no currency code in the source PDX file.

To change or view your currency settings:
= In Web Client, click Settings > User Profile > Preferences > Edit.
= In Java Client, click Settings > Current User > Preferences.

Be sure to save changes when applicable.

Importing Mass Values

Several Product Governance & Compliance objects, including items, have Mass fields. Mass fields
have both a numeric value and a unit of measure, for example, grams, kilograms, ounces, or
pounds. The Import wizard allows you to import both the numeric portion of a Mass value and the
unit portion. When you import Mass values, make sure you map both the Mass and Mass-measure
fields.

Note The default standard unit for Mass fields is Gram, although your Agile PLM administrator
can choose a different standard unit.
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Importing Geographical Locations

Customer, Supplier, and Manufacturer objects all have country and region fields. You must specify
valid country and region names in your source data. Otherwise, the values won't be imported.

To see valid country names and region names in the Agile Java Client:

Click the Admin tab.

Choose Data & Workflow Settings > Product Cost Management > Ship-To Location.
Click the New button.

Click the Continent list, and select a continent.

Click the Country list, and select a country.
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Click the Province/Region/State list, and select a region.

Importing Values to Dynamic Lists

The Import wizard supports importing values to list fields that use dynamic lists. Dynamic lists
contain a selection of values that are updated at run time based on data that has been added to the
system. The Items, Changes, Users, and Suppliers lists are examples of dynamic lists. Because
dynamic lists can contain thousands of value objects, you can't enumerate values for them.

The Import wizard can’t validate whether a dynamic list requires upper-case or lower-case values
before sending the data to the server. Consequently, any list values that are the wrong case are
rejected.

Note Prior to Agile 9.0 SP3, the Suppliers list was a static, enumerable list. Now it's a dynamic
list. Although Web Client displays the Supplier field in the form supplierName -
supplierNumber, you can import data to that field using either the supplier number or the
composite form, supplierName - supplierNumber.

Importing Cascading Lists

An Agile PLM list field can be configured to be a cascading list. A cascading list presents its values
in multiple hierarchical levels, letting you drill down to a specific value in the hierarchy.

To import values into a cascading list field, make sure you use the correct delimiter character to
separate each level. The Cascade Delimiter Character preference specifies the character used to
delimit cascading list values. For information about setting the Cascade Delimiter Character
preference, see Setting Parsing and Validation Options on page 35. The default setting for the
Cascade Delimiter Character preference is vertical bar (|).

The following example shows source data that includes cascading list values for a Page Two field
called Regional Contact, which has three levels.

Part Number Regional Contact

P10011 Central|Chicago|Jeff Whaley
P10012 Western|Los Angeles|Jason Wong
P10013 Southern|Atlanta|Hsing-Hua Zhang
P10014 Northern|Boston|Leslie Ickes
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Using BOM Reference Designators

Reference designators are commonly used in the electronics industry as a labeling system to refer
to components. If your company uses reference designators, you can use the BOM > Ref Des field to
assign and edit reference designators.

You can specify reference designators in several ways:

= Delimited using comma (,), semicolon (;), or vertical bar (]). By default, the Import wizard uses a
comma for the reference designator delimiter. To change the delimiter, see Setting Business

Rule Options on page 36.
= Individually (R1,R2,R3) or compressed, using the specified range character (R1-3 or R1-R3). By

default, the Import wizard uses a hyphen for the reference designator range character. To
change the range character, see Setting Business Rule Options on page 36.

o Uppercase, lowercase, or mixed case (they will be converted to whatever format is specified by
the Agile PLM administrator).

= Using continuation rows if there are too many reference designators to fit in one cell. All other
cells must be left empty in these rows.

If you have few reference designators, you can enter them one by one (for example, R1,R2,R3).

To add groups of reference designators that begin with different letters, separate each group with a
parse character, usually a comma. For example, to enter the 10 designators Al, A2, A3, B4, B5,
B6, B7, C8, C9 and C10 you would type:

Al-3,B4-7,C8-10

Depending on how your Agile database has been configured, the Agile Web Client may
automatically contract ranges of reference designators. If you enter 1,2,3,4,5, when you press Tab,
the Ref Des field shows 1-5.

If your Agile database has been configured to expand reference designators, then reference
designators connected by hyphens (or another specified range character) are expanded when they
are imported into the Agile database. For example, R1-5 becomes R1,R2,R3,R4,R5.

Reference designators that end in a letter (for example, R1a,R2a,R3a) must be entered individually.
For more information about how Agile Import handles reference designator ranges, see Reference
Designhator Ranges on page 16.

Reference Designator Ranges

The following rules determine how ranges of reference designators are treated by the Import
wizard. If a reference designator does not qualify for expansion, the Import wizard treats the range
as one reference designator.

o The two reference designators in a range statement must end in a numeric character to qualify
for expansion. If the last value in a reference designator string is a text character, it does not
qualify for expansion.
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Examples:

A202-A210 qualifies for expansion.
A202-A210a does not qualify for expansion.
A202a-A210a does not qualify for expansion.

= If two reference designators in a range statement have prefixes, they must have the same
prefix to qualify for expansion. Prefixes must be in <CHAR> format.

Examples:
RB202-RB210 qualifies for expansion.

RB202-RC210 does not qualify for expansion.

= If only the first reference designator in a range statement has a prefix, then the range qualifies
for expansion.

Example:
RB202-210 qualifies for expansion.

= If neither reference designator in a range statement has a prefix, then the range qualifies for
expansion.

Example:
202-210 qualifies for expansion.

Using Leading Zeros in Reference Designator Ranges

If your Agile database has been configured to remove leading zeros in the numeric portion of
reference designators, you should avoid using leading zeros in reference designator ranges in your
import file. For example, the Import wizard may parse R0203-R0225 as R203-R225, removing the
leading zeros.

In the Agile Java Client, you can click the Admin tab and choose Server Settings > Preferences >
Reference Designators Allow Range Expand Collapse to see whether reference designators can be
expanded and collapsed on your Agile PLM system. If this preference is set to No, all reference
designator range behavior is turned off. This prevents leading zeros from being removed from
reference designators, but it also causes each reference designator range, such as R0203-R0225,
to be treated as one reference designator. In this case, to enter reference designators with leading
zeros, you must enter them individually and not as ranges.

Note For information about how to change the Reference Designators Allow Range Expand
Collapse preference setting in the Agile Java Client, contact Agile Technical Support
http://www.oracle.com/agile/support.html.

Importing Reference Designators from aXML and PDX Packages

To ensure that reference designator fields in aXML and PDX packages are parsed correctly when
they are imported, follow these guidelines:
= Use a comma to separate multiple reference designators (R1,R2,R3).

o Use a hyphen to indicate a range of reference designators (R1-R3).
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Guidelines for Excel Files and Delimited Text Files

Agile PLM will export all delimited text files. However, to import table files, including the special
table exported files of user group table of user object, user table of user group objects, and price
line table of price object files, you must specify the header row and the last row. Otherwise, Agile
PLM will not export these files.

Make sure Microsoft Excel files and delimited text files conform to the following structural guidelines
before importing them:

= Although a Microsoft Excel workbook can contain multiple sheets, you can import data from
only one sheet at a time. Therefore, set up Excel sheets appropriately.

= Numeric values in Microsoft Excel files are converted to either integers or decimals before
being imported. If you want an integer to be treated as a decimal, enter the value as text by
preceding it with a single quotation mark. For example, to import the number 1.0 instead of 1,
type '1.0 in the Microsoft Excel cell.

= Formulas in Microsoft Excel files must calculate to a numeric value. Otherwise, the Import
wizard imports the formula string. If your Microsoft Excel file has formulas that calculate to
nonnumeric values, you can save the file to a .CSV file to ensure that the formula values will be
imported correctly.

@ Column headers cannot be blank. For example, in a comma-separated file the following header
row would be invalid due to the blank header between Number and Description:

Number, ,Description,Product Lines,Category

= The first row of import data, which is not necessarily the first row in an Excel file, must be the
“header” row, which contains field names. When you select the source file, you can click
Configure to set the location of the header row.

= Field names in the header row must be unique. Duplicate field names are not allowed. If the
source file contains multiple data sections, you must set the Header and Last rows to specify
the data that you want to import. This is applicable to the Table Format Export. When you
select the Table Format Export, data in Page one, Page Two and Page Three are exported to
one row in the exported Excel/CSV file.

o Fields in the header row must not contain carriage returns or linefeed characters. If they do, the
Import wizard will not parse the file correctly. For more information, see Removing Carriage
Returns and Linefeed Characters on page 19.

8 The header row cannot end with a delimiter character, such as a comma.

= Rows that follow the header row must contain data. There should not be empty rows between
rows of data.

= Any rows of data that you do not want imported into the Agile database must be removed.
= All fields that are required for the particular object type you are importing should contain data.

o Fields must use the same delimiter character. For example, for a comma-separated values file,
each field should be separated by a comma.
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@ Your import data must conform to the maximum lengths specified for each Agile field by the
Agile PLM administrator. Otherwise, the Import wizard’s Length Validation preference will either
reject or truncate the value.

= An entry for a MultiList field (for example, the Product Line(s) field on the Title Block tab) must
delimit separate list values. The default MultiList delimiter is a comma; you can also choose to
use a vertical bar (|) or semicolon (;). For more information, see Setting Parsing and Validation
Options on page 35.

This is an example of a comma-delimited list of values for a MultiList field:

Scorpio, Taurus,Capricorn

Note If you are importing user names into a Multilist field, you must use the following
format:
Lastname,spaceFirsthname;spacelLastname,spaceFirstname;spacelLastname;
and so on.

= Money fields must contain numeric values. They should not include currency codes. Import
supports currency codes and the user's preferred currency is selected if the currency code is
not specified.

o For BOMs, parent item rows must be grouped contiguously. That is, all BOM components for a
parent item should appear in one group of rows.

= For BOMs, the maximum length of individual reference designators is 19 characters.

= For BOMs, reference designators can continue on subsequent rows. On each reference
designator continuation row, the only field with data should be the reference designator field.
Other fields should be blank.

o= For BOMs, the value in the Quantity field should equal the number of reference designators.
Otherwise, the Import wizard may display a warning message when you import the data.

o For delimited text files, enclose text values within text qualifier characters (for example,
guotation marks). Qualifying a text field allows the field’s delimiting character, such as a
comma, to be used within the field’s text. In the following example, 21" Monitor, Tilt Pedestal is the
item’s description, which has both a comma (the field delimiter) and a quotation mark within the
text:

Number,Description,Rev,BOM Component Number,QPA
170-50,"21"" Monitor, Tilt Pedestal",A,172-92,1

Removing Carriage Returns and Linefeed Characters

To avoid file parsing errors when importing Excel files or delimited text files, make sure the header
fields do not contain carriage returns or linefeed characters. Such characters may be hard to spot in
a delimited text file, but you can easily find them and remove them in Excel.
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To find and remove carriage returns or linefeed characters from header fields in Excel:

1. Click the Select All button, the gray rectangle in the upper left corner of the worksheet where
the row and column headings meet.

2. Choose Format > Row > AutoFit.

Any header fields that have carriage returns or linefeed characters will have more than one line
of text. In the following figure, fields A1 and C1 both have carriage returns.

A | B | c | b |

[term Fart
1 |Mumber Fevision Description Part Type

Delete any extra carriage returns or linefeed characters in the header.
4. Save the file.

Sorting BOM Components

Before importing a BOM from an Excel file or a delimited text file, make sure all BOM components
for a parent item are grouped together in contiguous rows. If BOM components for a parent item are
listed on noncontiguous rows, the Import wizard imports only the last group of BOM components for
that parent item.

For example, the following BOM data is incorrect because the rows 4 and 5 are out of order.

A | B | C |
1 |Parent ltem Humber BOM ltem Humber Part Description
2 |POMM FO10 COM HOR 2%4 8,1 R P LNSTH
3 |FOM PO CLP GMDFLM RIS
4 |PO02 FO12 RES 10K 1A10% 1% THRFLR 0305
5 |FPO02 FPO13 CAP A7OLF 20% 25% AL 10X12.5
B |[FO01 Fa14 DIODE, 5kY 304 80A MBRS330,5M
7 |FOM FO15 RES 2 7K 116w 5% THKFLK 0603

This is the BOM data after it is correctly sorted. BOM components for PO0O1 are now grouped
together.

A | B | C |
1 |Parent tem Number BOM ltem Number Part Description
2 P00 FO10 COMHDR Z=4 M1 R P LNSTH
4 |POO1 PO CLP GMD FLM RS
4 |POO1 P14 DIODE,SKY 304 50A MERS330,5M
5 |POO1 PO15 RES 27K, 1716V 5% THKFLM 0603
B |POOZ P12 RES 10K, 1410%Y,. 1% THNF LK 0305
/ |POO2 PO13 CAP A70UF 20% 25 AL 10K12.5

To sort the BOM, open the source file in Microsoft Excel and sort the rows in ascending order by the
Parent Item Number column.
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Note BOMs in aXML and PDX packages are automatically sorted appropriately.

An XML file declares its encoding within the file. Therefore, you don’t need to specify file
encoding when you import data from aXML or PDX packages.

Importing Data from Microsoft Excel Files

Microsoft Excel is a popular spreadsheet program, which lets you format data in a matrix of rows
and columns. The Import wizard supports Microsoft Excel 2000 and 2002 versions.

Excel workbook files, which have an XLS filename extension, can have multiple sheets per file.
Make sure you specify the sheet to import and the location of the header row on that sheet.

To import data from an Excel file:
1. Choose Tools > Import.

2. Specify the import source. Select File. Type the filename, or click Browse to select it.

Note The file must be a valid Excel 2000/2002 file.
Click Excel Workbook.

If necessary, click Configure to specify the file configuration. You can specify the template type,
worksheet, and the location of the header row. When you are finished, click OK.

Click Next to proceed to the next wizard step.
Select the type of object to import, then click Next.

Select a change order and a mapping file. Click Next.

Note A change order is required when you use Redlining mode to import. For more
information about redlining, see Using Redlining or Authoring Mode on page
65.

Select or create a transformation definition file (optional). Click Next.

Review your import settings, then click Import to begin importing.

Editing Delimited Text Files in Excel

If you open a delimited text file in Excel, all cells use the General number format by default. This
causes large numbers, such as item numbers and manufacturer part numbers, to be converted into
scientific notation (for example, 8.1E+22). You can fix that problem by formatting the cells to use
Text format.

To format numbers as text in Excel:

1. Select the cells you want to format.

Choose Format > Cells. The Format Cells dialog box appears.
Click the Number tab.

In the Category list, select Text, and then click OK.
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If there are any cells that still display in scientific notation, click each cell, press F2, and then
press Enter to reenter the number as text.
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After you format cells to use Text format, save the file as an Excel (XLS) file to preserve the
formatting. If you save the file as a CSV file, the next time you open it in Excel the sheet will again
use the General number format.

Importing a Delimited Text File into Excel

If a delimited text file has many item numbers or manufacturer part numbers that need to be
reformatted as text, it may be more practical to import the file into a new Excel workbook. Excel's
Text Import Wizard allows you to format the columns appropriately.

To import a delimited text file into an Excel workbook:

1. Open a new workbook.

2. Choose Data > Get External File > Import Text File.

3. Choose the file and choose Import. The Text Import Wizard appears.

4. Choose Delimited. Click Next.

5. In the Delimiters box, make sure only Comma is checked. Click Next.

6. Inthe Data Preview box, select columns to change the data format. For example, select the Iltem
Number or Manufacturer Part Number column, and click Text in the Column Data Format box.

7. Click Finish.

Select Existing Worksheet, and click OK.

How the Import Wizard Parses Excel Data

When you select an Excel file to import, the Import wizard parses the data into a delimited text
format before importing it. That is why many of the guidelines for importing delimited text files also
apply to Excel files. The parser handles the following types of Excel values specially:

= Number format — Numeric values in Excel files are converted to either integers or decimals
before they are imported.

o Date format — The parser supports native Excel date formats as well as any custom date
formats that contain all three of the following identifiers: d m yy. For example, yyy/mm/dd and dd-
MM-YYY hh:mm are supported date formats, but mm/yy is not.

= Currency format — The parser treats any cells containing currency values as numbers.
Therefore, a cell with the value $9.99 is treated as 9.99.

Specifying the Excel File Configuration

When you select an Excel file to import, you can specify how the file is configured. This allows the
Import wizard to identify the template you're using, the worksheet to import, and the header row
where data starts.
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To specify the configuration of an Excel file:

On the first step of the Import wizard, select File.

Enter the path of the file, or click Browse to select it.

Choose Excel Workbook.

Click Configure. The Excel Workbook Configuration window appears.

Specify the template type (Level Template, Parent-Child Template, or Standard).
Specify the sheet to import. The default is the first worksheet in the Workbook.
Enter the location of the header row and last row. The default is 1.

If necessary, enter the location of the last row. The default value is "N/A".

Click OK.
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Note The Import wizard maintains Excel file settings for the current import session
only.

Importing Data from Delimited Text Files

Delimited text files are flat text files where each field of data is delimited by a special character,
such as a comma or a tab. You can create delimited text files in a text editor. You can also export
delimited text files using many applications, including Microsoft Excel and other spreadsheet
programs.

Caution A delimited text file must have a CSV or TXT filename extension. Otherwise, the file is
invalid and cannot be imported.

Generally, text files allow you to import only one type of Agile object at a time. However, when you
import BOMs, AMLSs, or price lines from a text file, you can also import the parent items or prices at
the same time.

Text files should have a header row. If you are importing a text file, make sure you specify the
location of the header row.

To import data from a text file:

Choose Tools > Import.

1. Specify the import source. Select File. Type the filename, or click Browse to select it.
Note The filename must have one of the following extensions: CSV or TXT.

Click Delimited Text File.

If necessary, click Configure to specify the delimited text file configuration. You can specify the
location of the header row, the type of file encoding, and characters used for field delimiters
and text qualifiers. When you are finished, click OK.

4. Click Next to proceed to the next wizard step.
Select the type of object to import, then click Next.

Select a change order and a mapping file. Click Next.
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Note A change order is required when you use Redlining mode to import. For more
information about redlining, see Using Redlining or Authoring Mode on page
65.

7. Select or create a transformation definition file (optional). Click Next.

8. Review your import settings, then click Import to begin importing.

About Delimited Text Files Saved by the Agile Export Wizard

Agile's Import wizard doesn't support delimited text files saved by the Agile Export wizard, mainly because the
Export wizard adds a header section to the file and includes multiple tables in a flat format. You can reformat
the data to import it successfully.

Specifying the Delimited Text File Configuration

When you select a delimited text file, you can specify how the file is configured. This allows the
Import wizard to identify the template you're using, the header row, field delimiter, and text qualifier
used in the file.

To specify the configuration of a text file:

1. On the first step of the Import wizard, select File.

2. Enter the file path, or use Browse to select it.

3. Choose Delimited Text File.

4. Click Configure. The Delimited Text File Configuration window appears.

5. Specify the template type (Level Template, Parent-Child Template, or Standard).

6. Choose the field delimiter. The default is Comma (,).

7. Choose the text qualifier. The default is Double quotation mark (*).

8. Enter the location of the header row. The default is 1.

9. If necessary, enter the location of the last row. The default value is "N/A".

10. Choose the file encoding type. The default is based on your locale. For the U.S. (English)
locale, the default is ISO-8859-1, which includes all US and Western European characters. For
Japan and China, the default encoding is Big5 and SJIS, respectively.

11. Click OK.

Note The Import wizard maintains delimited text file settings for the current import
session only.
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Importing Data from PDX Packages and aXML Files

The Import wizard supports importing data from two different XML formats:

u]

Product Data eXchange (PDX) — A standardized XML format for representing structured product
content. It provides a means for partners in the e-supply chain (OEMs, EMS providers, and
component suppliers) to exchange product content and changes (BOMs, AMLs, ECRs,
ECOs). You can import items, BOMs, manufacturers, manufacturer parts, AMLs, and
attachments from a PDX package. You can create PDX packages in the Web Client. In
addition, Agile provides a free, Web-based application called Agile eXpress that lets you create
and view PDX packages.

For more information about PDX, including a link to the DTD, see following Web page:
http://webstds.ipc.org/2571/2571.htm

Agile XML (also known as aXML) — Agile XML format is an XML representation of Agile's business
schema. aXML contains all product content managed in Agile including items, change details,
manufacturer information, cost, drawings and other files. As a representation of schema
elements across all Agile products, aXML will evolve with Agile's business schema over time.
Agile Content Service (ACS) and Agile Integration Services (AIS) both export Agile data in
aXML format. Agile does not provide a separate tool to view aXML packages. However, you
can open the XML file contained within an aXML package in any XML viewer. For example,
Internet Explorer can be used to view XML files.

For the latest aXML schema, please see the following Web site:
http://support.agile.com/misc/axml/2008/05/

Note The Import wizard does not support importing changes or packages, even
though these can be contained within a PDX package or an aXML file.

PDX packages that you want to import must adhere to the following guidelines:

u]

The embedded XML file contained in a PDX package must be well formed and meet the
structural requirements specified by PDX DTD Revision 1.0. (If you have a PDX 0.7 file, you
can open it in Agile eXpress 8 and save it as a PDX 1.0 file.)

The PDX package must contain values for attributes that correspond to Agile key fields.

The PDX package must not contain multiple revisions of the same item. If you try to import
items from a PDX package with multiple revisions, the Import wizard rejects the file.

The Import wizard supports PDX packages that use Agile’'s multi-site PDX 1.0 implementation.
It does not support multi-site PDX implementations from other vendors.
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To import data from a PDX package or an aXML file:
1. Click Tools > Import.

2. Specify the import source. Select File. Type the filename or click Browse to select it.

Note PDX packages have a pdx extension, and aXML files have an axml extension.
Click Product Data eXchange Package or Agile XML (aXML) File. Click Next.
Select one or more types of objects to import, then click Next.

Select a change order and a mapping file. Use the default PDX mapping. Use the default PDX
or default aXML mapping. You can edit the default mapping to add or remove field mappings.
Click Next.

Note A change order is required when you use Redlining mode to import. For more
information about redlining, see Using Redlining or Authoring Mode on page
65.
6. Select or create a transformation definition file (optional). Click Next.
7. Review your import settings. Click Import to begin importing.

Objects that You Can Import from PDX Packages

If you select Product Data eXchange Package as the File Type on the first page of the Import wizard,
you can import the following objects:

8 Manufacturer
*  Manufacturer Attachment

8 Manufacturer Part
*  Manufacturer Part Attachment

o ltem
*  Bill of Material
* Approved Manufacturer List
* |tem Attachment
* Sites
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Objects that You Can Import from aXML Files

If you select Agile XML (aXML) File as the File Type on the first page of the Import wizard, you can
import the following objects:

m]

Man

Man

ufacturer
Relationship
Manufacturer Attachment

ufacturer Part

Relationship

Composition

Bill of Substances

Approved Supplier List
Specifications

Manufacturer Part Attachment

Substance

Composition
Substance Attachment

Declaration

ltems

Manufacturer Parts
Part Groups

Item Bill of Substances

Manufacturer Part Bill of Substances

Part Group Bill of Substances
Specification
Declaration Attachment

Bill of Material

Composition and Bill of Substances
Approved Manufacturer List

Sites

Approved Supplier List
Specifications

Relationships

Item Attachment

Published Price

Published Price Lines
Price Attachment
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o Quote History
®* Quote History Lines
o Specification
® Substances
* Specification Attachment

= Part Group
* Parts
* Approved Supplier List
* Specifications
* Relationships
* Part Group Attachment
@ Product Service Request (PSR)
Affected Items
Related PSRs
* Relationships

* Attachments

@ Quality Change Request (QCR)
* Affected Items
* Relationships
* Attachments

Using Templates to Import Data

An import template is a predefined format you can use to import items, BOMs, and AMLSs from
delimited text files or Microsoft Excel files. If you format your data according to one of the provided
templates, the import process is simple. Once you specify the source file and select the default field
mappings, you can click Import to begin importing.

The Import wizard provides the following templates:

= Level Template

*  BOM Only Level Template — Represents the hierarchical levels of a BOM by specifying a
numeric Level column. The relationship between a parent item and its components is set
by the numeric level. Approved manufacturers are not included with this template.

* BOM & AML Level Template — Represents the hierarchical levels of a BOM by specifying a
numeric Level column. The relationship between a parent item and its components is set
by the numeric level. This template includes approved manufacturers for each part.

= Parent-Child Template — Represents the relationship between a BOM and its components by
Parent Number and Child Number columns.
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If you use the BOM & AML Level Template or Parent-Child Template to import AMLs, remember
that manufacturers listed in the AMLs must already exist in the Agile PLM system. Otherwise, the
AML is rejected.

To import data using an import template:

1. Format the data appropriately using one of the templates.

Note Make sure the source file includes a header row and at least one row of data.
Start the Import wizard.

On the Import Source page, select File. Type the path of the file, or click Browse to select it.
Select Delimited Text File or Excel Workbook, and then click Configure.

For Template Type, select Level Template, or Parent-Child Template from the list.

Select other configuration options if necessary. When you are finished, click OK.

N o gk~ wD

Select a change order and a mapping file. Use the default mapping. Click Next.

Note A change order is required when you use Redlining mode to import. For more
information about redlining, see Using Redlining or Authoring Mode on page
65.

8.  Click Import to begin the import operation.

Using the Level Templates

There are two level templates:
= BOM Only Level Template
o BOM & AML Level Template

They both share the same “Template Type” option. If the source doesn't include any AML data,
Import will choose the BOM Only Level Template type. Otherwise, BOM&AML Level Template is
chosen.

In addition, Item supports the export BOM&AML tables as Level Template. The format is similar to
the previous Level Template. Field names in the Admin setting are dynamic and are not fixed
attribute names as before. However, the previous format with fixed attribute names is also
supported.

The source file for Level Templates can include the fields shown in the table below.

Important The column headers in your source file must match the specified field names exactly as
they appear in the table below in English. You can not localize these field names.

Category Field Name Required
ltem Level Yes
Item Number Yes
Description
Type
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Category

Field Name

Required

Sites

Revision

Product Line

Lifecycle Phase

Size

Category

Effectivity Date

Commaodity

BOM

Quantity

Yes

Find Number

Reference
Designator

BoM Notes

BoM Site

AML2

MFR Name

Yes

MFR Part Number

Yes

MFR Part Site

Preferred Status

Reference Note

Note:

o The level for the first record must be zero or any non-numeric value. Child items have a level
other then zero, such as 1, 2, 3, and so on. After the first record, the Import wizard ignores any
non-numeric characters in the Level col

= If you are using the BOM Only Level Template, do not include AML fields in your source file.
The MFR Name and MFR Part Number fields are not required for BOM Only Level Template.

The following figure shows an example of level template data for items and BOMSs.
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A B | C | o E | F |
1 |Level Item Number Description Revision Sites Quantity
2 0 BO233897C MTEXO1AD XFPh FRAME A San Jose 1
3 1/910-134-B CEL BAYST TR REDLUND C San Joge 1
4 1 /960-460-C TESTED TOKEM RING CCC Austin 1
] 2920-431-E BAYSTACK TOKEM RING A Taipei 1
3] 3111063 IC F4HCTOO MAND 4 2-1M, B Taipei 1
7 3111042 IC F4HCT123 RETRIG MO A Hong Kong 2
g 3/111-170 IC F4ABT245 5 »WCR S0Z6E San Jose 2
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When the level template data includes AML information, each item can have multiple AML rows.
The item information does not need to be repeated for each AML row. The following figure shows
an example of level template data for items, BOMs, and AMLs.

A B | c | o | E | F | G | H | | |
| 1 |Level ltem Number Description Revision Sites Quantity MFR Name MFR Part Humber Preferred Status
| 2 | 0 BO0233897C  NTEXD1AD XPM FRAME A San Joge 1 ADVANCED CABLE TECHNOLIZ10-073-B Preferred
| 3 | 13M0-134-B CBL BAYST TR REDUNDC San Joge 1 JPM COMPANY 910-134-B Preferred
| 4 | 1/960-460-C TESTED TOKEM RING C(C Austin 1 SOLECTRON TECHNOLOGY In960-460-C Freferred
| 5 | 2 920-481-E BAYSTACK TOKEN RINGA Taipei 1
| 6 | 3111-063 C 7AHCTOO NAND 4 2-IM B Taipei 1 TERAS INSTRUMENTS WALTH, SN74HCTOOD Preferred
| 7| PHILLIPS ELECTRONICS F4HCTOOD Preferred
| & | MOTOROLA INC MC74HCTODAD Alternate
ER HARRIS SEMICONDUCTOR  CO74HCTOOM Alternate
|10 FAIRCHILD SEMICONDUCTOR MW7 4HCTOOM Alternate
|11 3111-042 IC,7AHCT123 RETRIG MCA Hong Kong 2 PHILLIPS ELECTRONICS FAHCT123D Freferred
| 12 HARRIS SEMICONDUCTOR  CO74HCTIZ23M Alternate
| 13 | J1n-17a IC 7AABT245 3 %/CR 50.B San Jose 2 TEXAS INSTRUMENTS WALTH, SN74ABT24580W  Preferred

Using the Parent-Child Template

To use the parent-child template, the source file can include the following fields. Column headers in
your source file must match the specified parent-child template field names as shown in the table
below.

Important The column headers in your source file must match the specified field names exactly as
they appear in the table below in English. You can not localize these field names.

Category Field Name Required

[tem Parent Number Yes

Parent Revision

Parent Type
Child Number Yes
Child Revision
Child Type

Description

Sites

Product Line

Lifecycle Phase

Size

Category

Commaodity
BOM Quantity Yes

Find Number

Reference Designator
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Category Field Name Required
BoM Notes
BoM Site

AML MFR Namen2 Yes
MFR Part Numbern2 Yes

MFR Part Siten2

Preferred Statusn2

Reference Noten?2

Note:

* Parent Revision and Child Revision fields are imported only if both are included in the
source file.

® To include multiple manufacturer parts per item, expand the row horizontally. That is, add
separate columns for each manufacturer part. Append a number to the manufacturer part
field names from 1 to m, where m is the total number of manufacturer parts in the item.

The following figure shows an example of parent-child template data for items and BOMs.

A, | B | c | D
_1 |Parent Number Child Number Quantity Description
_ 2 [70965G01 70964-01 1 PF PWE-FAB-REG SDB 1PML FLBLYR FTH
_ 3 |70965G01 70953-00 0 SCHEMATIC: BREANCH MODE  SERIAL DATA BOARD
4 70965601 70993-00 0 OUTLINE DWYs PEG SDE
_ 5 70965601 71495-00 0 SDB MECH ASSY DWW
_ B [70965G01 BO454-51 2 RAIC-SMD 74F85 4BIT* COMPAR S0O16
7 (70965501 B0312-51 3 RRIC-3MD FAHCIET SYMC * CNTR S016
_ 8 (70965501 A3013-54 1 RR IC-SMD 74HCA0E0 ASYMNC * CHNTR S016
_9 70965601 F1137 607 1/IC HW PROGRAMMED
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The next example shows a parent-child template data for items, BOMs, and AMLs. Multiple
manufacturer parts are specified for each component, and revision information is included in the
optional Parent Revision and Child Revision columns.

Parent Number|Child Number [Description Quantity
AXAI00 MTOX9501 CAELE BRA 1
A0 MTOXIE04 BUSS BAR A 1
ArA200 MTEXD1E2 PYWR CABLE 1
ArA300 MTOX9535 CABLE BRA 1
AxA400 STANDOFF INSULATOR, 3
Ax30a MOUNTING BRACKET K 3
Ard0d SCREW . 250-20x 375% 3]
AxAG00 WE FL 2581056200 3

MFR Name1
JPM COMPANY

MFR Part Humber1
910-134-B

MFR Hame2 MFR PartHumber?| MFR Hame3 |MFR PartNumberd |Parent Revision | Child Revision

SOLECTRON TECHNOLO

SR0-480-C

TERAS INSTRUME

SN74HCTO0D

PEMSTAR

0323-0

HARRIS SEMICONDUCT(

CO74HCTIZ3M

TEXAS INSTRUMENTS

SN7AABT245B0W

FAIRCHILD SEMICONDL

MM74HCTOOM

PHILLIPS ELECTR

J4HCT123D

PEMSTAR

0323-002

PHILLIPS ELECTRONICS
MOTOROLA INC
HARRIS SEMICONDUCT(

74HCTOOD
MC74HCTORAD
CO74HCTOOM

=|oloolx=|=]x|=

IR = R =

Grouping and Sorting Parent ltems

Before importing parent-child data, make sure all parent items are grouped together in contiguous
rows. If the same parent item is listed on noncontiguous rows, the Import wizard imports only the
last group of component parts for that parent item. This requirement to presort the parent-child data
is similar to the way BOM data in Excel files and text files must be sorted. For more information, see
Sorting BOM Components on page 20.

Importing Objects into Relationship Tables

You can import all Agile supported objects into relationship tables of Iltem, Manufacturer,
Manufacturer Part, and Part Group objects. In addition, you can insert all flex fields and relationship
rules via Import. For more information about Relationship tables, refer to Getting Started with Agile
PLM.
Note Import always selects the complete replace mode. That is, Import will always replace the
existing relationship data with the relationship table data of the imported source file.

Page - 33






Chapter 3
Setting Import Preferences

This chapter includes the following:

B ADOUEL PIEIBIBNCES ..ottt bbb 35
= Setting Parsing and Validation OPtioNS ...........cceieerrininiessesissssese st sssssessssessssens 35
® Setting BUSINESS RUIE OPHIONS ...ccvieriiiieiiseisiseeeisie ettt 36
= Accepting/Rejecting NON-EXIStING DALA.........ccreiiririeirrieir ettt 39
= Persistence of Import SEttings IN USEr SESSIONS..........ciiviieiieieieieiiisssissseessssessssesssss et sssesssssessssssssessssesssanes 42
= Persistence of Import Preference Settings in File SYStEMS........cocovvveviiriercsre s sssssess s 43
B SEttiNG DEfAUIL TYPES ..ovvieceiseicee ittt as st 46

Ahout Preferences

The Import wizard has several preference settings that you can set from any step in the wizard.
These preferences set how the Import wizard behaves. Import wizard preferences persist during the
current Agile PLM client session, but they are not permanently saved with each user’s profile.

To set import preferences:

1. Click the Preferences button in the bottom left corner of the Import wizard. The Specify
Preference Settings window appears.

2. Select one of the following preferences groups from the list: Parsing and Validation Options,
Business Rule Options, Default Types, or AutoNumber Sources.

3. Select preference settings, and then click OK.

Setting Parsing and Validation Options

When you select the Parsing and Validation Options preference group, the following options appear:

Log Transformations The Log Transformations checkhbox sets whether to record all value transformations in the import
log file. If you are importing an extremely large file, uncheck the Log Transformations box to achieve
faster results.

Multilist Delimiter The MultiList Delimiter Character list specifies the character used in the import file to delimit values
Character for MultiList fields. You can select a semicolon (the default), a comma, or a vertical bar.

Cascade Delimiter The Cascade Delimiter Character list specifies the character used in the import file to delimit values
Character for cascading list fields. You can select a vertical bar (the default), a comma, or a semicolon.
Whitespace Validation The Whitespace Validation Action preference sets how the Import wizard handles a value with
Action whitespace characters (space, linefeed, newline, or tab) in a field that does not allow them. Select

Reject (the default) to reject the value or Strip to remove the whitespace characters.
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Case Validation Action

Length Validation Action

Some Agile fields can be configured to require upper case or lower case values. The Case Validation
Action preference sets how the Import wizard handles a value that has the wrong case for a field.
Select Convert (the default) to convert the value to the proper case or Reject to reject the value.

The Length Validation Action preference sets how the Import wizard handles a value that exceeds
the maximum length for a field. Select Reject (the default) to reject the value or Truncate to remove
any characters from the value that exceed the maximum length.

Setting Business Rule Options

When you select the Business Rule Options preference group, the following options appear:

= Smart Rules Warning Violation Behavior

o Reference Designator Quantity Mismatch Behavior

= Behavior upon non-existing objects

= Change Mode

= Change Number

o Redline Mode Behavior

= BOM & AML Import Behavior

o Multi Row Update Mode

= Price Quantity Break Default

= Sourcing Project QTY Rollup

o Reference Designator Range Character

o Reference Designator Delimiter Character

These options are described in the following paragraphs.

Smart Rules Warning Violation Behavior

These are the Smart Rules that were set to Warning in the Java Client. It does not apply to Smart
Rules that were set to other values, such as Allow or Disallow.

o DuplicateFindNumbers

o DuplicateltemNumbers

o DuplicateRefDes

= MultipleltemsPerManufPart

= Qerlap Price Line Effectivity Periods

If you select Reject Objects (the default), any object that triggers a Smart Rules warning is rejected.
If you select Accept Objects, the Smart Rules warnings are logged, but objects are imported.
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Reference Designator Quantity Mismatch Behavior

The Reference Designator Quantity Mismatch Behavior drop down list provides the option to Accept/Reject imports
as follows:

= If you select Accept, Import will ignore the Reference Designator Quantity Mismatch warnings and will import the
data

= Ifthe you select Reject , Import will fail when there is a Reference Designator Quantity Mismatch warning and will
save the warnings in the Import log file

Behavior upon non-existing objects

When importing a non-existing PLM object, you have the option to:
@ Accept importing all PLM objects that are not in the system before import validation
o Reject importing all PLM objects that are not in the system before import validation

o Selectively Accept or Reject importing PLM objects that are not in the system's databases after
import validation. To support this option, Import will list the non-existing objects in the Validation
summary page.

See Accepting/Rejecting Non-Existing Data on page 39 for more information.

Change Mode

The Import wizard enables you to import items, BOMs, and AMLSs, prices, and price lines in
Redlining or Authoring mode.

In Redlining mode, the default setting, the Import wizard uses the redlining process to update BOM,
AML, and price lines rows. Any fields that have changed are highlighted in red. A change order is
required regardless of the revision state. Redlining mode is required to import data to any item or
price with a pending change or a released revision.

In Authoring mode, the Import wizard does not use the redlining process to update BOM, AML, and
price lines rows. It therefore doesn't require a change order. Authoring mode is useful if you are
importing data to preliminary items and you don’t want to roll the revision.

Note If you select Authoring mode, you can still specify a change order in the Change Number
field. If you specify a change order, items with a pending change or a released revision
are redlined and are added to the Affected Items tab of the change order. If you don't
specify a change order, the Import wizard rejects any items that have a pending change or
a released revision.

Change Number

The Change Number preference allows you to specify a change order for this import session. The
change order is used to redline any items or prices that have a pending change or a released
revision.

Note If you selected Redlining for the Change Mode preference, a change number is required.
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Redline Mode Behavior

The Redline Mode Behavior preference allows you to determine which items get added to the Affected
Items tab of a change when you import them in Redlining mode. You can choose to add all items to
the change, add only new items, or add new items and existing items that require redlining.

Select one of the following options:

= New/Existing items onto the change (default) — adds new items and existing items that have been
redlined to the Affected ltems tab of the change. Any existing items contained in the import
data that have not been redlined are not added to the change.

= Allitems onto the change — adds all items listed in the import data to the Affected Items tab of the
change, regardless whether the items are new or whether they have been redlined.

@ New items only onto the change — adds only new items to the Affected Items tab of the change.
Existing items, whether they have been redlined or not, are not added to the change.

Note You can redefine BOM and AML fields, and Title Block fields that are under change
control, such as Title Block > Description, Title Block > Lifecycle Phase, and Title Block > Rev.

BOM & AML Import Behavior

The BOM & AML Import Behavior preference specifies the behavior to use when importing BOMs and AMLs. You can
import all items (including BOM components) or only items that have BOMs or AMLs. Select one of the following
options:

= Import assys, amls, and components (default) — imports all items, including BOM components.

o Only import assys and amls — imports only items that have BOMs or AMLs. BOM components
are not imported.

Multi Row Update Mode

The Multi Row Update Mode preference determines how source data should be used to update the
target tables such as BOMs, AMLs, and price lines. You can choose “Complete Replace” (the
default) or “Add/Update Only.” If you choose “Complete Replace,” the target data is completely
replaced with the source data. Any rows in the target data that don’t appear in the source data are
deleted. If you choose “Add/Update Only,” new rows in the source data are added and existing rows
are modified but no rows are deleted. The Add/Update Only setting is helpful if you want to import
partial BOM, AML, or price lines data.

Note This option is only applicable to BOM, AML, and Price Line data imports. It is always
Add/Update mode for other import types
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Price Quantity Break Default

A price object has a General Information field named Allow Qty Breaks that determines whether
prices are broken out by different quantities. If the Import wizard automatically creates a new price
object during the import of price lines, it sets the value of the Allow Qty Breaks field based on the
Price Quantity Break Default preference.

If you want to allow quantity breaks for new price objects created by the Import wizard, select Yes. Otherwise, select No
(the default).

Note You can't change the Allow Qty Breaks setting for an existing price object. You can only
set its value for a new price.

Sourcing Project QTY Rollup

This rule applies to PCM only. The quantity value are set in PCM's table menus. For example,
Sourcing project item import, or imports in Supplier Response, and RFQ Response Status for non-
web suppliers. In Import/Export you can set it to Yes/No.

Reference Designator Range Character

Select either Hyphen (-) (the default), Backward Slash (), Forward Slash (/), or Vertical Bar (]). The
range character separates reference designator values that expand to a sequence of values. For
example, R4-R6 expands to R4,R5,R6.

If you are importing BOMs from a PDX package or an Agile XML (aXML) file, the reference
designator range character must be a hyphen. For more information about reference designators,
see Using BOM Reference Designators on page 16.

Reference Designator Delimiter Character

Select either Comma (,) (the default), Semicolon (;), or Vertical Bar (|). The delimiter character
separates reference designator values that don’t need expansion, for example: R1,R2,R3.

If you are importing BOMs from a PDX package or an Agile XML (aXML) file, the reference
designator delimiter must be a comma.

Accepting/Rejecting Non-Existing Data

This option was introduced and briefly described in Setting Business Rule Options (on page 36).
The choices are:to:

= Accepting/rejecting all non-existing objects during import

o Selectively accept/reject non-existing objects after import validation. .
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Accepting/Rejecting Non-Existing Objects During Import

When you:

u]

Select Accept, all PLM objects that are not in the system are imported before import validation.
The Import module will list the new objects that were created for the non-existing objects in the
import status message. Print out import status message for all non-existing objects
(BOM/AML/Others) during import summary page

Note You must select the Accept check box during import validation

Select Reject, all PLM objects that are not in the system before import validation are rejected
during import. The Import module will list the non-existing objects that were rejected in the
import status message. Print out import warning message for all non-existing objects
(BOM/AML/Others) during validation summary page

Note You must de-select the Accept check box for all non-existing objects during
import validation

To accept/reject importing non-existing objects into Agile PLM:

1.
2.

In PLM Web Client, select Tools > Import. The Specify Preference Settings dialog opens.

In Specify Preference Settings, select Business Rule Options. The Business Rule Options list
appears.

In Behavior upon non-existing objects, select Accept or Reject.

Click OK to complete the remaining import tasks. To validate, see Validating Source Data
Before Importing (on page 47).
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Note The import Validation feature is only supported for PC objects.

Specify Preference Settings

D Perzizt preference settings to be shared by ather uzers

Ok Cancel
Select & group from the list belovw to set the values for its options:
Business Rule Options w
Stnart Rules Warning Yiolation Behavior: | Reject objects A
Reference Designator Guantity Mismatch Behavior: | Reject ]
‘Behavior upon non-existing objects: | &coept B

Change Mode: P

Change Mumber: |

Redline Mode Behavior: | M Fedlined tems onto the change ‘
BOM & AML import behavior: | Import assys, amls and component ‘
bulti Roww Update Mode: | Complete Replace ]
Price Quarntity Break Default: | Mo ]
3 Sourcing Project v Rollue: [ we-- }. s

Selectively Accepting/Rejecting Non-Existing Objects After Validation

When you choose to selectively import or reject PLM objects that are not in the system's databases
after validation, Import will list the non-existing objects in the Validation summary page. You then
have the option to import or reject the objects the are not present in the PLM database.

Note The import Validation feature is only supported for PC objects.

To selectively accept/reject importing non-existing objects after validation:
1. In PLM Web Client, select Tools > Import. The Specify Preference Settings dialog opens.

2. In Specify Preference Settings, select Business Rule Options. The Business Rule Options list
appears.

3. In Reference Designator Quantity Mismatch Behavior field, select Accept or Reject.
Note For purposes of this example, select Accept.

4. InImport Source click Browse and select the file that you want to import. The Select Contents
to Import panel appears.

5. In Select Contents to Import, click Validate.The Validate Summary Results report will list the non-
existing items and gives you the option to Accept.

6. Check or do not check the Accept check box to import or not import the non-existing item.

Click Import to complete the remaining steps.
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Time information

Time validation started 022102005 10:19:19 PM GhT
Time validation completed 0252152005 10:19:13 PM GWT

Validate Result Summary

error

warning %

2 2

Message summary

fatal

Record Info Meszage Detail Accept
[Line: 3 Part - Mumber: PODSET; BOM: ttem |The BOM component 'BORM_MNONEXISTOZ' for "Part' object doesn't exist in system, would you D
MMumber: BORM_MOMEXISTOZ] like to creste or reject 7
[Line: 2, Part - Mumber: PODBET; BOM: ttem |The BOM component 'BOM_MNONERXISTON for "Part' object doesn't exist in system, would you D
Mumber: BOR_MOMEXISTO ] like to creste or reject t7
[Line: 3 Part - Mumber: PODGSET; BOM: kem |Could not process the BOM andfior AWML for fem 'PO0EET - BOMIAMLIAEachments will ke
Fumber: BOR_MONEXISTOZ] rejected: Adding tem with life cycle phasze of Prefiminary to BOM i not alloweed.
[Line: 2; Part - Mumber: PODEEY; BOR: ttem |Could not process the BOM andfiar AkL for temn 'PO0EET" - BOMIAMLIAtachments will be
Fumber: BOR_NONEXISTO ] rejected: Adding tem with life cycle phaze of Prefiminary to BOM iz not allowed.

Restart  Save Log _Impart Done

Persistence of Import Settings in User Sessions

When you use the Import wizard in the Agile Web Client, its settings persist as long as you maintain
the session. Persisted Import wizard settings include:

o Import preferences

@ Source file configuration (but not the file name and path, which are not persisted)

o Selected content to import

@ Selected mapping file

o Selected transformation file

If you choose a different type of source file, the Import wizard resets the selected content, mapping
file, and transformation file. If you log out of the Agile Web Client and then log back in, the Import
wizard resets to the default settings.

Page - 42

Agile Product Lifecycle Management



Chapter 3

Persistence of Import Preference Settings in File
Systems

Unlike User Sessions, an authorized administrator can enable a user to set and save Import
preferences on a global basis. In this process, this administrator defines/selects a user in Java
Client and then enables the Save Import Preferences Setting option for the selected user. Then this
user can set and save Import preferences setting from the Agile Web Client. Moreover, these
settings, unlike settings in user sessions, are not lost if and when the user logs out and and logs
back in. The necessary procedures are provided in the following paragraphs.

Enabling a User to Save (Persist) Preference Settings

In the following example, the Administrator defines a user called Test Admin and enables the Save
Import Preference Setting option for this user. This user is then able to save the preference setting
in the Agile PLM Web Client.

To define a user and enable the Save Import Preference Setting option:
1. InJava Client, log in as Administrator and select Admin > Users. The Users panel opens.

2. In Users panel define a user called Test_ Admin. For procedures refer to the Agile PLM Getting
Started Guide.

In Admin > Privileges for Administrator, create administrator privileges (for Test_ Admin).

4. Double click Test_ Admin. The Privilege: Test Admin panel opens.

In Privilege: Test_Admin, select Applied to > Save Import Preference Setting.

Selected:
Save Import Preference Setting

Hff | Account Policy !
—Hl |Adrmin History i S T A R Ve e e
el | autarumbers =
|| Character Sets

Y (Classes

Commadities

#8l Company Profile

i Content Service Settings
1 ol Cost Status
“ M Criceria L

Show visible attributes only sed | Histary |

|

EEa

—
R Wahe " Test_admin |
FE Supplier Groups
g Roles Diescripion | |
[tz Privileges
- Al Privileges Enabled [yes i
{83 add Approver/Ohserver I

Privilege

Adriniistrator

& ApprovefReject
{83 Attachment Redines For Ot
% attachment Redlines For Se
{3 Cancel Checkout

Fatul ol [Tl 8= =+ Impart Preference Sething

- {87 change Status
- {Z Checkin ]
i | Adriristrator, Test (admin) | ormiz//9224demo.ga.aglesoft.comfagile |9.2.2.4.09 | i
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Assigning Roles and Privileges

To assign roles and privileges:
1. InJava Client, select Admin > Privileges.

2. In Privileges, select, define, apply the following privilege masks (actions). Be sure to save the
setting after each each step. For procedures, refer to the Agile Product Lifecycle Management

Administrator Guide. ..

Privilege Assigned Name Applied Criteria
Checkin Test_check in All File Folders
Checkout Test_check out All File Folders
Discovery Test_Discovery All File Folders
Import Test_Import

Modify All File Folders All File Folders
Read All File Folders All File Folders

3. In Admin, select User Settings > Roles > New (button) The Create Role dialog opens.

oy BEE

Marne iTest_Ru:uIe| |
Descripkion
Enabled l Yes v |
Privilege | !
MEE
Users [ Groups | [+
< [ o] 4 ] [ Cancel ] >

Figure 1: Create Role Object

4. In Create Role dialog, define a role called Test_Role. and click the down arrow in the Privilege
field. The Select Privileges dialog opens.
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5. In Select Privileges dialog, locate the privileges you defined earlier (They all had Test_ in their
names).

6. Make your selection and the click OK.

Select Privileges 3
Filter By |Hame o | Match TF [ starts with ~ | value iTest_ | E Apply |
Chaices: Selected:

Test_Admin

test_Chech-In
Test_Check_uut
Test_Discovery
Test_Impork
test_Modify file folders
Test_Read File Foder

78|53
&

Setting and Saving Import Preferences

The user Test_Admin can set and save Import preference settings as follows:

1. Log on to Agile Web Client as Test_Admin Agile Web Client and in the Tools drop-down menu
select Import.

Select a file to import and configure the file.
3. Inthe lower left corner, click Preferences. The Specify Preference Settings dialog opens.
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4. In Preference Settings dialog opens check the Persist preference settings to be shared by
other users.

Specify Preference Settings

¥ Persist preference zettings to be shared by other users

_cancel |
Zelect a group from the list below ta set the walues for its options:
Parzing and “alidstion Options :]
Log transformations: Ird
huttilist delimiter character: Isemicu:ulnn 0 LI
Cascade delimiter character: IVer‘ticaI bar () LI
Wihitespace walidation action: IReject LI
Case validation sction: ICu:um-'er‘t |
Length walickstion action: IRejec:t |

To verify these settings will persist, log off and log back on as Test Admin .

Setting Default Types

To create a new object on the Agile PLM system, you must specify the subclass of the object. Every
Agile PLM system can be configured to have different subclasses. To simplify the importing of new
objects, you can specify the default subclass to use for each object type that can be imported. If the
subclass is not specified by one of the mapped fields (such as Parts Class > Title Block > Part Type), the
Import wizard creates the new object using the default type.

The default type is also used when the Import wizard automatically creates parent items for BOMs,
AMLs, and price lines.

To set default types for the Import wizard:

1. Click the Preferences button in the bottom left corner of the Import wizard. The Specify
Preference Settings window appears.

2. Select Default Types.

3.  Specify default subclasses for each object type, and then click OK.
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Validating Source Data Before Importing

This chapter includes the following:

B OVBIVIBW .ooecaeeser et R 47
= Data Validation Procedures and EXaMPIES .........ceriririininininseni st sssssessssssssnns 51
Overview

Using Import Validation, you can check the source data for compliance with Agile PLM server rules
before importing the data into PLM databases. When you invoke this feature, Import will generate a
report displaying errors that it encountered during the validation process. Using this report, you can
make the necessary corrections and then import the data into PLM databases. Invoking Validation
does not import any data; it only checks it for compliance with server rules.

Supported File Types

Source import validation is applicable to aXML, PDX, CSV (delimited text files), and Excel source
files. For CSV and Excel formats, you must provide a mapping definition similar to import. For axML
and PDX, there is no need for a mapping definition because Import will provide the default mapping
settings.

Validation is performed on data fields belonging to objects in the following groups:
= Parsing and Validation Options

= Business Rule Options

o Default Types

@ Autonumber Sources

Supported Tables

Validation is performed on data in the following classes and tables:

= ltem
* Title Block
* Page Two
* Page Three
*  Bill of material
* Approved Manufacturer Part
® Relationship
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Attachments

8 Manufacturer

Cover Page
Page Two

Page Three
Relationship
Attachments

8 Manufacturer Part

Cover Page
Page Two
Page Three
Relationship
Attachment

o Part Group

= Product Service Requests (PSR)

o Quality Change Requests (QCR)

Cover Page
Page Two

Page Three
Relationship
Attachments

Afftected Item
Cover Page
Page Two
Page Three
Related PSR
Relationship
Attachments

Afftected Items
Cover Page
Page Two
Page Three
Relationship
Attachments
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Validation Support in Agile SDK and Agile Integration Services

Agile Integration Services (AIS) and Agile Software Developer Kit (SDK) also support source data
validation.

= AIS— Provides a new operation called importer.validateData to validate source import
data.

@ SDK — Provides two interfaces called IImportManager.importData () and
IImportManager.validateData () to perform import and validation.

Validation Results Log File

An XML Document Type Definition (DTD) file is embedded in the import.log to provide the following
post validation information:

o Classified and sorted according to severity

1. Note
2. Warning
3. Error
4. Fatal

@ A summarized validation results that shows the number of warnings, errors, and fatal errors
that were encountered during the validation process.

Sample Validation Log File Output

<?xml version='1l.0' encoding='UTF-8'?>

<!DOCTYPE import-log [

<!ELEMENT import-log (begin-import, (note|warning|error|fatal)*,validate-
summary?, record-summary*, end-import) >

< !ELEMENT begin-import (#PCDATA) >

<!ATTLIST begin-import timestamp CDATA #REQUIRED>

<!ELEMENT note (#PCDATA) >

<!ATTLIST note

context CDATA #IMPLIED
line CDATA #IMPLIED
type CDATA #IMPLIED

>
<!ELEMENT warning (#PCDATA) >
<!ATTLIST warning

context CDATA #IMPLIED
line CDATA #IMPLIED
type CDATA #IMPLIED

>
< !ELEMENT error (#PCDATA) >
<!ATTLIST error

context CDATA #IMPLIED
line CDATA #IMPLIED
type CDATA #IMPLIED

>
<!ELEMENT fatal (#PCDATA) >
<!ATTLIST fatal

context CDATA #IMPLIED
line CDATA #IMPLIED
type CDATA #IMPLIED
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>
<!ELEMENT validate-summary EMPTY>
<!ATTLIST validate-summary

warning NMTOKEN #REQUIRED

error NMTOKEN #REQUIRED

fatal CDATA #REQUIRED
>
<!ELEMENT record-summary EMPTY>
<!ATTLIST record-summary

accepted NMTOKEN #REQUIRED

ignored NMTOKEN #REQUIRED

import-type CDATA #REQUIRED

rejected NMTOKEN #REQUIRED
>
< !ELEMENT end-import (#PCDATA) >
<!ATTLIST end-import

fatal NMTOKEN #REQUIRED

timestamp CDATA #REQUIRED
>] >
<import-log>
<begin-import timestamp="27/04/2007 07:45:49 AM BST">Begin
validate.</begin-imports>
<note line="6">Value for property &apos;Title Block.Number&apos; changed
during Case validation; value &apos;a2&apos; became
&apos;A2&apos; .</note>
<note line="6">Value for property &apos;BOM.Item Number&apos; changed
during Case validation; value &apos;a2&apos; became
&apos;A2&apos; .</note>
<error type="com.agile.imp.pc.adapter.ImportProductContentAPIException"
line="7" context="Part - Number: A2; BOM: Item Number: A21">Could not
process the BOM and/or AML for item &apos;A2&apos; - BOM/AML/Attachments
will be rejected:
Reference designator/quantity mismatch: There are 10 reference
designators and quantity is 5.</error>
<error type="com.agile.imp.pc.adapter.ImportProductContentAPIException"
line="5" context="Part - Number: Al2; BOM: Item Number: Al23">Could not
process the BOM and/or AML for item &apos;Al2&apos; - BOM/AML/Attachments
will be rejected:
Reference designator/quantity mismatch: There are 8 reference designators
and quantity is 5.</error>
<error type="com.agile.imp.pc.adapter.ImportProductContentAPIException"
line="4" context="Part - Number: Al; BOM: Item Number: Al2">Could not
process the BOM and/or AML for item &apos;Al&apos; - BOM/AML/Attachments
will be rejected:
Reference designator/quantity mismatch: There are 7 reference designators
and quantity is 3.</error>
<error type="com.agile.imp.pc.adapter.ImportProductContentAPIException"
line="3" context="Part - Number: A0; BOM: Item Number: Al">Could not
process the BOM and/or AML for item &apos;AO&apos; - BOM/AML/Attachments
will be rejected:
Reference designator/quantity mismatch: There are 6 reference designators
and quantity is 2.</error>
<validate-summary warning="0" error="4" fatal="0"/>
<end-import timestamp="27/04/2007 07:45:50 AM BST" fatal="false">Complete
validate.</end-import>
</import-log>
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Data Validation Procedures and Examples

When you invoke the Import Wizard, it will open in the Import Source page. To validate source data,
you must select the option group using the Preferences dialog. The following procedure and example
describe the Preferences dialog and validating a source aXML file.

To view parameters and settings in each group:
1. In Agile PLM, select Tools > Import. The Import Wizard opens in the Import Source page.

2. Click Preferences. The Specify Preferences Settings dialog opens in the Parsing and Validation
Options group and displays the data elements that you can set for this group.

3. Using the drop-down list, you can view and set the data elements for Business Rule Options,
Default Types, and Autonumber Sources.

A Data Validation Example

The following procedure is an example of validating a source aXML file for compliance with BOM
and AML.

To validate a source aXML data file:
1. In Agile PLM, select Tools > Import. The Import Wizard opens in the Import Source page.
2. Use Browse to select the Import source and for File Type, select Agile XML (aXML) Package.

3. Click Preferences and select Business Rule Options. The other options that you can select are
Parsing and Validation Options, Default Types, and Autonumber sources.

4. In Business Rule Options page, set Change Mode to Authoring (it is also applicable to the Redline
mode).

Click Next. The Select Contents to Import page opens.
Choose Item > Bill of Material > Approved Manufacturer List.

Click Next. The Select Change order and Mapping page opens.

© N o u

Click Validate. The validation results are displayed on the screen.
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Selecting Product Content Objects to Import

For Excel files and delimited text files, you can select only one object type to import. If the source
format is an aXML or PDX package, you can select multiple object types to import.

The following table describes the types of objects you can import.

Object

Description

Manufacturer

A manufacturer with which your organization collaborates

Manufacturer Part

A manufacturer part that your organization uses. A manufacturer part is identified by its
manufacturer part number, not an internal part number.

Item A unique part, material, subassembly, or product. Agile provides two out-of-the-box Item
classes, Parts and Documents.
Bill of Material (BOM) A listing of all the subassemblies, parts, and raw materials that go into a parent assembly.

It shows the quantity of each part required to make an assembly.

Approved Manufacturer List (AML)

The list of manufacturers that have been approved to supply a particular item. The list
identifies the manufacturer part for that item.

Quote History and Quote History Lines

Price quotes from previous projects or legacy data.

Published Price and Published Price
Lines

Published prices or contract prices on current items and manufacturer parts.

Product Service Request (PSR)

A routable object used to issue problem reports and nonconformance reports for
products.

Agile Product Lifecycle Management
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Object Description

Quality Change Request (QCR) A routable object used to generate reports addressing changes to improve product quality
and conformance requirements.

Customer A customer that provides feedback on your company’s products, alerting you to quality
issues or problems they encounter.

Attachment File(s) attached to an object.

Substance Elements or compounds used in the composition of items, manufacturer parts, and part
families.

Declaration Declarations are routable objects used to bring information concerning the environmental
compliance of parts (Items, Manufacturer Parts, and Part Families).

Specification A list of banned substances (or substances of concern) and their threshold values.

Part Groups A group of similar items or manufacturer parts. For PG&C, items and manufacturer parts

are similar if they have the same chemical composition and thus similar compliance
requirements. For PCM, items and manufacturer parts are similar if they belong to the
same commodity class.

Relationship of Item, Manufacturer, Replace relationship data from source into existing relationship data.
Manufacturer Part, part Group

Root Program Update P1,P2,P3, action items, and discussion of root program.

User Create buyer/supplier user, update user preference, and user group information.
User Group Create user group, update user group, and user information.

For information about importing supplier data, currency conversion tables, Root Programs, users,
and user groups, see Importing Supplier and System Data on page 75.

You can also import project items, project BOMs, and project AMLs from within a Sourcing Project.
For more information, see Importing Data into a Sourcing Project. "Importing Data into a Sourcing
Project" on page 85

Importing ltems

An item is any unique manufactured or purchased part, material, subassembly, or product. An item
can contain a BOM, which defines relationships with other items or subassemblies, and an AML,
which defines the approved manufacturers and their respective manufacturer parts for that item.
The composition, bill of substances, and part families belong to Product Governance & Compliance
module of Agile PLM. For information on these items, refer to the Product Governance &
Compliance User Guide.

Items in the Item Master represent the approved product content for your enterprise. Because an
item can go through several changes during a product lifecycle, it can have multiple revisions. The
Item Master stores an item'’s revision history. ltems contained within a project do not have multiple
revisions. They serve as temporary data used to generate RFQs.

To import an item, you must map the Title Block > Number field. To specify a particular revision, you
must also map the Title Block > Rev field. You can import items into the Item Master or a sourcing
project.
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Importing Parts and Documents

Agile provides two classes of items, Parts and Documents. If you want to import both Parts and
Documents from the same source file you must map fields for both. If you only map field for
Documents and your source file contains both Parts and Documents, only the Documents are
imported. Remember, the Import wizard ignores any fields that aren’t mapped.

The Parts class has an optional field called Part Type. Documents has a similar field called
Document Type. These fields specify the subclass for a Part or Document. If you don’t map these
fields, the Import wizard uses the Default Part Type and Default Document Type set in Import
Preferences; for more information, see Setting Default Types on page 46.

Note Once an item is created, the Part Type and Document Type fields cannot be modified.

Importing Parent ltems with BOMs or AMLs

Each bill of material and approved manufacturers list is contained within an item. An item has
separate BOM and Manufacturers tabs that hold the bill of materials and approved manufacturers,
respectively.

When you import bills of material or approved manufacturers lists, you can also import the parent
items. This is true regardless of the source format. If you import data from a delimited text file or an
Excel file, you can import parent items and BOMs or parent items and AMLs in one import
operation. If you import items from an aXML file, a PDX package, or one of the predefined template
formats, you can import parent items, BOMs, and AMLs all at once.

Importing Items with Multiple Revisions

For speed and efficiency, the Import wizard imports items in batches and will process multiple
revisions of the same item as follows:

= If you try to import items from an aXML file or a PDX package containing multiple revisions of
the same item, Import will process the source files and will replace the earlier copy with the
new version. In this process, no error is generated.

Note Export will output same items with different revisions in the order of the release
dates of the pending version, introductory version, and released version. The
latest release date is outputted last.

= If you try to import items from an Excel file or a delimited text file, and the file contains multiple
revisions of the same item in adjacent rows, the Import wizard imports only the first revision. It
does not log an error.

= If you try to import items from an Excel file or a delimited text file, and the file contains multiple
revisions of the same item in non-adjacent rows, the Import wizard rejects all revisions of the
item.
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Impo

rting Bills of Material

A bill of material is a listing of all the subassemblies, parts, and raw materials that go into a parent
assembly. It shows the quantity of each part required to make an assembly.

You can

import bills of material into the Item Master or a sourcing project. If you are importing

BOMs from a text file or a Microsoft Excel file, make sure all BOM components for a parent item are

grouped
20.

Note

together in contiguous rows. For more information, see Sorting BOM Components on page

When you import bills of material, the Import wizard automatically creates any items listed
in the source data that don't already exist in the Agile PLM system.

To import BOMs from a text file or an Excel spreadsheet:

1. Start the Import wizard.

a.

2. Set
a.

g.

Click Tools > Import.

import preferences.

Click the Preferences button in the bottom left corner of the Import wizard. The Specify
Preference Settings window appears.

From the Preferences list, select Business Rule Options. For more information on these
options, see Setting Business Rule Options on page 36.

For Change Mode, select Redlining (the default) or Authoring. If you select Redlining, the
Import wizard redlines any BOM fields that changed as a result of the import session. For
more information about redlining, see Using Redlining or Authoring Mode on page 65.

For Change Number, click H to select a change order. A change order is required only if
you selected Redlining for the Change Mode preference. You can search for an existing
change order or create a new one. After you finish selecting or creating a change order,
click Finish to return to the Specify Preference Settings window.

For Redline Mode Behavior, select which items to add to the specified change order: all
items, new items, or new items and existing items that have been redlined.

For Multi Row Update Mode, select Complete Replace or Add/Update Only. If you are
importing data that includes partial BOMs and not complete BOM structures, select
Add/Update Only.

Click OK to save your import preferences for this session.

3. Select the Import source file.

a
b.
c
d

Specify the import source. Select File. Enter the filename, or click Browse to select it.
Click Delimited Text File or Excel Workbook.

If necessary, click Configure to specify the template type or file configuration. Click OK.
Click Next to proceed to the next wizard step.

4. Select the BOM type.

a.
b.

Select Item, and then select Bill of Material.
Click Next.
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5. Select a mapping file.
a. Choose Use an Existing Mapping File or Create a New Mapping.
b. If you selected Use an Existing Mapping File, click Browse to select the file.

c. If you selected Create a New Mapping, click the Create a New Mapping button to define the
mapping. The Edit Mapping File window appears. Map the import fields to target Agile
fields, and then click Finished.

d. Click Next to proceed to the next wizard step.
6. Select or create a transformation definition file (optional). Click Next.

7. Review your import settings, and then click Import to begin importing.

Importing Existing and Non-existing BOM Components

When you import BOMs, the Import Wizard will automatically create the items that do not exist in
the Agile PLM system. You have the option to specify the class type of the BOM component using
the Agile bom.item type field. If you do not specify the class type of the BOM component using the
bom.item type field, Import will assign the default item type and will generate the following warning
message when it automatically creates the BOM component:

"The Item/Manufacturer Part ***' is auto created during import BOM/AML table without required
fields provided."

If a BOM item is already in the Agile PLM system, the Import wizard associates the item with its
latest revision.

Under either of the following two conditions, the Import wizard fails to automatically create child
items on a BOM:

= If the parent item’s required fields (such as Cover Page > Number) are invalid

= If you imported BOMs to a project and the BOMs were subsequently rolled back

Importing Find Numbers
If the BOM > Find Num field isn’t mapped, its default value is 0.

Importing Partial BOMs

To update a BOM without deleting existing BOM components, set the Multi Row Update Mode
preference to “Add/Update Only.” The Import wizard imports new BOM components and updates
any existing components. For more information, see “Setting Business Rule Options on page 36".

Importing Manufacturers and Manufacturer Parts

Each manufacturer name in the Agile PLM system is unique, just as an item number must be
unigue to an item.

While different manufacturers can use the same manufacturer part number, the combination of
manufacturer plus manufacturer part number must be unique to one manufacturer part.

You can import manufacturers and manufacturer parts into the Item Master but not into a project.
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Note You must follow the recommended sequence and import manufacturers first, then
manufacturer parts. Agile PLM doesn't allow you to import a manufacturer part for a
manufacturer that doesn't exist.

Importing BOMs with Duplicate ltem and Find Numbers

When Import encounters rows of duplicate Item Number and Find Number, it assumes it is processing
a different BOM component even if the Item Number and Find Number are the same. Import will reject
or accept the content based on smart rules settings that allow or refuse duplicate BOM component
with duplicate Item Number and Find Number. If the same Item Number and Find Number are already in
the system, Import will select the last BOM component (with the same Item Number and Find Number)
from source file to update the last BOM component (with the same Item Number and Find Number).

Importing Approved Manufacturers Lists

An approved manufacturers list, or AML, is the list of manufacturers that were approved to supply a
particular item. The list identifies the manufacturer part for that item.

You can import approved manufacturers lists into the Item Master or a project. The Import wizard
does not automatically create manufacturers when you import AMLs. However, it will automatically
create manufacturer parts listed on AMLs. You also have the option to specify the class type of the
AML component using the aml.manufacturer type field. If you do not specify the class type of the AML
component using this field, Import will assign the default item type. Import will generate the following
warning message when automatically creating the AML component:

"The Item/Manufacturer Part ***' is auto created during import BOM/AML table without required
fields provided."

Note When you import AMLs to the Item Master, manufacturers listed in the AMLs must already
exist in the Agile PLM system. Otherwise, the AML is rejected.

Automatic Creation of Child Manufacturer Parts

When you import AMLs, the Import wizard checks whether manufacturer parts listed in the AMLs
exist in the Agile PLM system. If they don't, the Import wizard automatically creates them. Under
either of the following two conditions, the Import wizard fails to automatically create manufacturer
parts:

o If the parent item’s required fields (such as Cover Page > Number) have invalid data.

= If you imported AMLs to a project and the AMLs were subsequently rolled back.

Importing Partial AMLs

To update an AML without deleting existing AML rows, set the Multi Row Update Mode preference to
“Add/Update Only.” The Import wizard imports new AML rows and updates any existing rows. For
more information, see “Setting Business Rule Options on page 36".
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Importing Quote Histories, Published Prices, and Price
Lines

A price object is used to manage the price terms for a part with relation to a supplier, customer, and
program. Each price object has a Price Lines table that stores the prices and terms related to
shipping locations, effectivity periods, and quantities.

There are two classes of price objects that can be imported: Quote Histories and Published Prices.
Functionally, there is no difference in importing either type of price object. However, if you are
importing data from delimited text files or Microsoft Excel files, you must import Quote Histories and
Published Prices in separate import operations. You must also maintain separate mapping files for
them.

Note When you import price lines, your source data must provide the same consistent set of
parent price fields for each row. For example, if your data uses the General Information >
Number field to identify the parent price object, every row of the source data must include a
value for that field. Otherwise, the import session may produce unexpected results.

Key Price Fields

The price object can be defined in many ways due to the number of required and optional key fields
the object has. A price is associated with either an item or a manufacturer part. At a minimum, your
source data should include one of the following sets of key fields:

Set 1 Set 2 Set 3
General Information > Mfr. Part General Information > Item Number General Information > Item Number
Number General Information > Item Rev 1 General Information > Supplier

General Information > Mfr. Name . .
General Information > Supplier

General Information > Supplier

Note The Item Rev field specified in Set 2 above is required only for items with released or
pending revisions.

The General Information > Supplier field supports two types of source values, either the supplier
number or “supplierName - supplierNumber”. In either case, values are case-insensitive. If you use
the “supplierName - supplierNumber” format for supplier values, the spaces and hyphen are
required.

Your data can include other optional fields, such as Manufacturing Site, Program, and Customer. Values
for the Customer field should be the customer name, not the customer number. Customer names are
case-sensitive; the Import wizard rejects a price record if the customer name has the wrong case. If
your source data doesn’t include Program and Customer, the Import wizard automatically assumes a
value of “All” for those fields.

The General Information > Allow Qty Breaks field determines whether prices are broken out by different
quantities. If the Allow Qty Breaks field is not mapped, the Import wizard uses the Price Quantity Break
Default preference to determine which value to use for it; for more information, see Setting Import
Preferences on page 35. After a price object is created, you cannot change the value of its Allow Qty
Breaks field.
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Optionally, the source data can also include the General Information > Number field. If you are
importing data to an existing price object, the General Information > Number field and all other required
fields must match the target system exactly. Otherwise, the Import wizard rejects the object. If you
don’t provide the price number, the Import wizard attempts to find the price object using other key
fields. If a price object with the specified key fields doesn't exist in the system, the Import wizard
creates it and assigns it a number based on the AutoNumber sequence for the price class.

Note You cannot import price lines in Redline mode if the parent price object has a pending
change order.

Key Price Lines Fields

At a minimum, your source data for Price Lines must include General Information > Price Number or the
minimum fields that identify a price object (see “Key Price Fields” above) and the following key Price
Lines fields:

8 Price Lines > Price Effective From Date

B Price Lines > Ship To

In addition, if the Allow Qty Breaks field is set to Yes for the price object, then the Price Lines > Qty field
is required and must be mapped.

All list fields on the Price Lines table, such as Ship From, Ship To, Currency, Country of Origin, and
Transportation Terms must have valid values. For Ship To, only values listed in the Authorized Ship
To list in the user’s profile are supported. For Transportation Terms, you can enter three-letter
abbreviations like FOB or the full description, “FOB - FREE ON BOARD VESSEL.” Here’s a full list
of values for Transportation Terms:

Value Full Description
CFR CFR - COST AND FREIGHT
CIF CIF - COST INSURANCE AND FREIGHT
CIP CIP - CARRIAGE AND INSURANCE PAID TO
CPT CPT - CARRIAGE PAID TO
DAF DAF - DELIVERED AT FRONTIER
DDP DDP - DELIVERED DUTY PAID
DDU DDU - DELIVERED DUTY UNPAID
DEQ DEQ - DELIVERED EX QUAY (DUTY PAID)
DES DES - DELIVERED EX SHIP
EXW EXW - EX WORKS
FAS FAS - FREE ALONGSIDE SHIP
FCA FCA - FREE CARRIER
FOB FOB - FREE ON BOARD VESSEL
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Importing Partial Price Lines

To update a Price Lines table without deleting existing rows, set the Multi Row Update Mode
preference to “Add/Update Only.” The Import wizard imports new price lines and updates any
existing rows. For more information, see “Setting Business Rule Options on page 36”.

Importing Customers and Product Service Requests

If your Agile PLM system includes the Product Service and Improvement license, you can use the
system to manage quality issues that arise with customers. A customer can submit problem reports
or nonconformance reports that alert you to quality issues or problems they encounter. Problem
reports and nonconformance reports are two types of Product Service Requests.

Importing Customers

Customer data may be created in a Customer Relationship Management (CRM) system. If you
haven’t integrated your CRM system with the Agile PLM system, you can use the Import wizard to
import customers and Product Service Requests.

The Customer class is the only out-of-the-box subclass for customers. You can define other
Customer subclasses.

The Customers > General Info > Customer Name field is required to import customers. All other fields are
optional.

The Customers > General Info > Customer Number field is a key field, but it does not need to be mapped.
If you do not map the Customer Number field, the Import wizard uses the AutoNumber preference to
assign numbers to new customers. For more information, see “Setting Default AutoNumber
Sources”.

Importing Product Service Requests

Similar to Customers, you can create Product Service Requests (PSRs) in a CRM system that is
integrated with the Agile PLM system. If the two systems are not integrated, you can import the
PSR data into the Agile PLM system.

Importing PSR Objects

The Import module supports importing and validating PSR objects. The supported file formats are
aXML, Excel, and delimited text files. The supported tables and components include Cover
Page/P1, P2, P3, Related PSRs, Affected Items, Relationships, and Attachments.

To import a PSR object:
1. Click Tools > Import.
The Import Wizard appears in the left panel and the Import Source dialog in the main panel.

2. Inthe Import Source dialog, select the source file with PSR data (aXML, Delimited text file,
Excel).

3. Click Next. The Select Contents to Import dialog appears.

Page - 61



Import/Export Guide

4. In Select Contents to Import check PSR and other applicable check boxes Affected Items, Related
PSR, Relationships, and Attachments).

Click Next. The Select Mapping File dialog appears.

Check the applicable option (use an existing mapping, create a new mapping, or use the
default mapping).

7. Click Edit Chosen Mapping to specify the required fields for Affected Items, Relationships, Related
PSRs, and Attachments.

Note The required fields to import these objects appear next. You also have the
option to validate the imported object now and in the remaining steps of the
Wizard.

* _If you choose Validate, the validation results summary is displayed. You have the option to
save the log file. Click Restart to repeat the process, or Done.to import the content.and
bypass the remaining two steps (Select Transformation Definition File and Review Settings
and Begin Import )

* If you choose Next, the next dialog in the Select Transformation Definition File dialog
appears.

8. Click Done to complete the process.
Importing PSRs Only

The following fields are required to import PSR only:
@ Problem Reports > Cover Page > Number
= Non-Conformance Reports > Cover Page > Number

If you are importing only one class of PSR at a time, you don’t need to map fields for both Problem
Reports and Non-Conformance Reports. If your source data includes both Problem Reports and
Non-Conformance reports, you must map fields for both classes.

Other Cover Page PSR fields you can map include PSR Type, Description, Customer, Supplier, Severity,
Disposition, and Expected Resolution Date. Values for the Customer field should be the customer name,
not the customer number. Customer names are case-sensitive.

Note All importable PSR fields are supported in the SDK and AIS.

Importing PSR Affected Items

You can import items to the Affected Items table of a PSR. The following fields are required to
import PSR Affected Items:

o Problem Reports > Affected Items > Item Number
= Problem Reports > Affected Items > Rev Found
= Non-Conformance Reports > Affected Items > Item Number

= Non-Conformance Reports > Affected Items > Rev Found

Note The system supports importing duplicate affected items into a PSR.

Page - 62 Agile Product Lifecycle Management



Chapter 5

Affected items for a PSR can be in any revision state, including Introductory. If you try to import an
affected item and it does not exist, the Import wizard will reject the row.

Importing Related PSRs

You can import PSRs to the Related PSR table of a PSR. The following fields are required to import
related PSRs:

= Problem Reports > Related PSR > PSR Number

@ Non-Conformance Reports > Related PSR > PSR Number

If you try to import an PSR that does not exist, the Import wizard will reject the row.
Importing PSR Relationships Tables

You can import objects to the Relationships table of a PSR. The following fields are required to
import PSR Relationships:

o Problem Reports > Relationships > Number
= Problem Reports > Relationships > Type
= Non-Conformance Reports > Relationships > Number

= Non-Conformance Reports > Relationships > Type

If you try to import an object that does not exist, the Import wizard will reject the row.
Importing PSR Attachments

You can import PSR attachments. The following fields are required to import a PSR Attachment:
= Problem Reports > Attachments > File Identifier

= Problem Reports > Attachments > File Name

2 Non-Conformance Reports > Attachments > File Identifier

= Non-Conformance Reports > Attachments > File Name

Importing Quality Change Requests

Similar to PSRs, you can create Quality Change Requests (QCRSs) in a CRM system that is
integrated with the Agile PLM system. If the two systems are not integrated, you can import the
QCR data into the Agile PLM system.

Importing QCR Objects
The Import module supports importing and validating QCR objects. The supported file formats are

aXML, Excel, and delimited text files.The supported tables and components include Cover Page/P1,
P2, P3, Affected items, Relationships, and Attachments.
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To import a QCR object:

1. Click Tools > Import.
The Import Wizard appears in the left panel and the Import Source dialog in the main panel.
In the Import Source dialog, select the QCR object (aXML, Delimited text file, or Excel).
Click Next. The Select Contents to Import dialog appears.

In Select Contents to Import check Quality Change Request and other applicable check boxes
(Affected Items, Relationships, Attachments).

Click Next. The Select Mapping File dialog appears.

Check the applicable option (use an existing mapping, create a new mapping, or use the
default mapping.

7. Click Edit Chosen Mapping to specify the required fields for Affected Items, Relationships, and

Attachments.

Note The required fields to import these objects appear next. You also have the
option to validate the imported object now and in the remaining steps of the
Wizard.

* .If you choose Validate, the validation results summary is displayed. You have the option to
save the log file. Click Restart to repeat the process, or Done.to import the content.and
bypass the remaining two steps (Select Transformation Definition File and Review Settings
and Begin Import )

* If you choose Next, the next dialog in the Select Transformation Definition File dialog
appears.

8. Click Done to complete the process.
Importing QCR Affected Iltems

You can import items to the Affected Items table of a QCR. The following fields are required to
import QCR Affected Items:

o Audits > Affected Items > Iltem Number

B Corrective and Preventive Actions > Affected Items > Item Number

Note The system supports importing duplicate affected items into a QCR.

Affected items for a QCR can be in any revision state, including Introductory. If you try to import an
affected item and it does not exist, the Import wizard will reject the row.
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Importing QCR Attachments

You can import QCR attachments. The following fields are required to import a QCR Attachment:
o Audits > Attachments > File Identifier

@ Audits > Attachments > File Name

@ Corrective and Preventive Actions > Attachments > File Identifier

o Corrective and Preventive Actions > Attachments > File Name
Importing QCR Relationships Tables

You can import objects to the Affected Items table of a QCR. The following fields are required to
import QCR Relationship Tables:

= Audits > Relationships > Number

o Audits > Relationships > Type

o Corrective and Preventive Actions > Relationships > Number
= Corrective and Preventive Actions > Relationships > Type

If you try to import an object that does not exist, the Import wizard will reject the row.

Using Redlining or Authoring Mode

If you use the Import wizard in Redlining mode (the default setting), you must specify a change
order to import items, BOMs, AMLs, and prices. Redlining mode, as its name implies, highlights in
red any fields that have changed. All items and prices imported in Redlining mode are placed on the
Affected Items and Affected Prices tabs of the specified change order.

For released items and prices, the Import wizard redlines data based on changes made to the latest
released revision. For prices, the Import wizard doesn't allow you to redline the Price Lines table if
the price object has a pending revision.

When you import items in Redlining mode, all items are unconditionally added to the Affected Items
tab of the selected change order. The Import wizard does not allow you to interactively select which
items should be placed on the Affected Items tab.

When you make changes to a BOM, Manufacturers, or Price Lines table in Redlining mode, entire
rows and partial rows can be redlined. If you add or remove a row, the entire row is treated as a
redline addition or deletion. If you modify only a few fields in a row but do not update its key fields,
the Import wizard redlines only the fields you have changed. For example, if you modify some BOM
fields but don't modify the BOM > Item Number field, then the row is partially redlined.

If you use the Import wizard in Authoring mode, you can update an existing BOM, AML, or price
lines if the parent item or price is unreleased and does not have a pending change. Authoring mode
is helpful when you are importing BOM, AML, or price lines data for preliminary items or prices.
Once an item or price has a pending change, you can no longer use Authoring mode to update its
BOM, AML, or price lines.

For information on how to set the Change Mode preference to Redlining or Authoring mode, see
“Setting Business Rule Options on page 36”.
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Selecting a Change Order

On the Select Change Order and Mapping File step of the Import wizard, you can specify a change
order to use for the import session. In Redlining mode, a change order is required to import items,
BOMs, AMLs, prices, and price lines. In Authoring mode, a change order is optional.

Click H to select a change order. The Select Change For Import window appears. This new
window is another wizard that lets you specify the change order to use for the current import
session. You can search for an existing change order or create a new ECO, MCO, SCO, or PCO, or
a change order of a similar user-defined subclass.

Note If you search for an existing change order, make sure it is in a non-released state. If you're
importing prices in Redlining mode, search the Agile PLM system to see if there is a
pending PCO for the price object. If there is already a pending PCO associated with a
price, you cannot add the same price object to a different PCO.

BOM, AML, and Price Lines Rollbacks

To preserve the integrity of BOMs, AMLs, and Price Lines imported to the Agile PLM system, the
Import wizard doesn’t allow you to import partial import data to a new revision. If a BOM, AML, or
Price Line row cannot be imported because it is invalid, the revision is rejected and the Import
wizard rolls back the entire table to its original state prior to the import session.

During BOM, AML, and Price Lines rollbacks, parent items and prices are not removed from the
Affected Items or Affected Prices tabs of the specified change order. Also, changes made to Title
Block, Page Two, or Page Three fields are unaffected by rollbacks.

If a fatal error (for example, a database error) occurs while you are importing to a new revision of an
item, the Import wizard rolls back the revision. Despite the rollback, any child items automatically
created during the import process are not removed; they remain in the Agile PLM system.

If you import a BOM, AML, or Price Lines table to the latest revision and a validation error occurs,
the replacement table is rejected.

If a fatal error occurs while you are importing BOMs, AMLSs, or Price Lines to the latest revision, any
replacement tables that were accepted before the error occurred cannot be rolled back. If this
happens, try importing to the latest revision again.

If there are existing redlines for a pending Change order, the Import wizard clears them before
importing new redline data from the import file. The clearing of redlines and the importing of new
data are separate operations. After the redlines are cleared, the transaction is committed, and then
the import process starts. Therefore, if the import operation fails for any reason (such as a duplicate
item number), the table rolls back to its pre-redlined state.
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The following table shows how import errors affect released BOMs, AMLs, and Price Lines tables:

Revision Type of Error Result
New revision — importing a new Validation error The new revision and the related BOM, AML, or Price Lines table
revision to the parent item or price rejected.
Fatal error The new revision and the related BOM, AML, or Price Lines table

are rolled back.

Current revision — importing Validation error The replacement BOM, AML, or Price Lines table is rejected.

changes to the current revision of the
parent item or price

the fatal error cannot be rolled back.

Note The Import wizard rolls back BOM, AML, or Price Lines data only when there are errors
with the data. It does not roll back BOMs, AMLs, or Price Lines if the warnings or errors
pertain only to associated objects, such as fields for items, manufacturers, manufacturer
parts, and prices.

Importing Site-specific BOMs and AMLs

You can import site-specific BOMs and AMLs from all supported import file formats except MS
Project Export File. However, you must format the site-specific data appropriately and map the
fields correctly. In particular, you must include the following:

o Title Block > Sites field for the parent item
= Compliance > Compositions > Bill of Substances field for item supported tables.
o BOM > Site field for BOMs

o Manufacturers > Site field for AMLs

The Title Block > Sites field is a virtual field that represents the list of sites on the Sites tab of an item.
You do not need to map the Title Block > Sites field to import BOMs or AMLs. If you don’t map the
field, the Import wizard assumes that the value for Title Block > Sites is the complete list of site names
specified for BOM > BOM Site or Manufacturers > Site in your source file.

Note The Import wizard does not remove site associations from existing parent items. That is,
although you can add sites to the Title Block > Sites field, you cannot use the Import wizard
to remove sites from the Sites tab of an item.

When you import site-specific BOMs and AMLs, the Import wizard imports data only for sites
specified in your source file. If your source file does not include a particular site already specified for
an existing item, the Import wizard will not update that section of the site-specific BOM or AML.

Note You can import Substances to the Bill of Substances tables for Declarations, Manufacturer
Parts, and Item from aXML files only.
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The following figure shows a BOM import source file with site-specific information. There are two
columns with site information: Item Sites and BOM Site.

A | E | C D | E |
1 |Parent ltem |ltem Sites BOM ltem Oty |BOM Site
2 |FPO0O1 =an Jose, Bangalare, Taipei BO001 1
3 |FPO0O1 =an Jose, Bangalore, Taipei BOOOZ2 1
4 |PO001 man Jose, Bangalore, Taipei BOO03 1
5 |POOO1 =an Jose, Bangalore, Taipei BOOD4 Site 1 San Jose
B |POOO1 =an Jose, Bangalore, Taipei BOODS Site 1 Bangalare

The Item Sites column is mapped to the Title Block > Sites field in the mapping window. It contains a
comma-delimited list of the sites with which the parent part is associated.

The columns BOM Item, Qty, and BOM Site pertain to BOM components. The BOM Site column is
mapped to the BOM > Site field in the mapping window. It indicates the site to which a component
applies. Each row in this column can contain only one site. If the BOM Site field is empty, the
component is used for all sites.

In the preceding figure, BO001, BO002, and BO003 do not have a specified BOM site. Consequently,
those BOM components are common to all sites. BO004_Site has San Jose as the BOM site. This
means that BO004_Site applies only to the portion of the BOM specific to the San Jose site.

The following figure shows an AML import source file with site-specific information. There are two
columns with site information: Item Sites and Mfr Site.

A | B | C | D | E |
_1 |Parent ltem ltem Sites Mfr Hame Mir Part Mifr Site
_ 2 |POoo1 oan Jose, Bangalore, Taipel  MARTEX MPDS14T
_ 3 (PO0OY San Jose, Bangalore, Taipei MOTOROLA  MPDI14LTH
_ 4 |PO007 =an Jose, Bangalare, Taipei  PHILIPS/SIG MPDS14T/R
_ 5 |PO0OY oan Jose, Bangalare, Taipei | ZETEX MFDI14TA, San Jose
_B [FO007 =an Jose, Bangalore, Taipei PSS DICDES A POOT Bangalare

The Item Sites column, like the same column in the BOM import source file discussed previously, is
mapped to the Title Block > Sites field in the mapping window.

The columns Mfr Name, Mfr Part, and Mfr Site are related to approved manufacturers. The Mfr Site
column is mapped to the Manufacturers > Site field in the mapping window. It indicates the site to
which an approved manufacturer applies. Each row in this column can contain only one site. If the
Mfr Site field is empty, the approved manufacturer is used for all sites.

In the preceding figure, ZETEX has San Jose as the Mfr Site. This means that this approved
manufacturer applies only to the portion of the AML that is specific to the San Jose site.

Note If you use an SCO to import site-specific BOMs and AMLs in Redline mode, you can
specify only one site per BOM/AML. BOMs or AMLs with multiple sites will be rejected.
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Importing Agile Product Governance & Compliance Data

Agile PG&C has several different declaration classes. Based on the declaration class and the type
of source file, there are restrictions on the tables that you can import.

Declaration Types, Supported Tables, and Importable Objects

The following table lists the Agile PG&C-related objects that you can import. For more information
on these objects and applicable procedures, refer to the Importing and Exporting Data section of the
Agile Product Governance & Compliance User Guide.

Declaration Type

Supported Tables

aXML File Types

Delimited Text or Excel File
Types

Declarationl

Cover Page, Page Two, Page Three, Iltems1,
Manufacturer Parts, Part Groups, Item Bill of
Substances?, Manufacturer Part Bill of Substances?2,
Part Group Bill of Substances2, Specifications,
Attachments

Cover Page, Page Two, Page Three,
Item1, Manufacturer Parts, Part
Groups, Specifications

Supplier Declaration of

Conformance

Cover Page, Page Two, Page Three, Specifications,
Attachments

Cover Page, Page Two, Page Three,
Specifications

Part Declaration

Cover Page, Page Two, Page Three, Items,
Manufacturer Parts, Part Groups, Specifications,
Attachments

Homogeneous Material
Declaration

Cover Page, Page Two, Page Three, Items,
Manufacturer Parts, Part Groups, Item Bill of
Substances, Manufacturer Part Bill of Substances, Part
Group Bill of Substances, Specifications, Attachments

Cover Page, Page Two, Page Three,
Items, Manufacturer Parts, Part
Groups, Specifications

IPC 1752-1 Declaration

IPC 1752-2 Declaration

JGPSSI Declaration

Substance Declaration

Substance Declaration

Item

Title Block, Page Two, Page Three, BOM,
Manufacturers, Sites, Compliance > Specifications3,
Suppliers, Attachments, Compliance > Composition,
Compliance > Bill of Substances3

Title Block, Page Two, Page Three,
BOM, Manufacturers, Sites,
Compliance > Specifications4,
Suppliers5

Manufacturer Part

General Info, Page Two, Page Three, Compliance >
Specifications, Compliance > Compositions > Bill of
Substances?, Suppliers4, Attachments, Compliance >
Composition Compliance > Bill of Substance3

General Info, Page Two, Page Three,
Compliance > Specifications,
Suppliers5
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Declaration Type

Supported Tables

aXML File Types

Delimited Text or Excel File

Types
Part Group General Info, Page Two, Page Three, Parts, Compliance General Info, Page Two, Page Three,
> Specifications3, Suppliers, Attachments Parts, Compliance4> Specifications3,
Suppliers
Specification General Info, Page Two, Page Three, Substances5 General Info, Page Two, Page Three,
Substances?
Attachments
Substance General Info, Page Two, Page Three, Compositions, General Info, Page Two, Page Three
Attachments
Notes:

1. If you don't map the Items > Item Rev field, the latest modified ECO or MCO of the latest
released revision of the item is imported. If revision is specified, then the latest released
modified ECO or MCO of the specified revision is imported. When the item has multiple
revisions, use “Introductory” instead of revision to import the introductory revision of the
item into the declaration. If the item doesn't have a released revision, then the Introductory
revision is imported.

2. Substances can be imported to the Bill of Substances tables for Declarations,
Manufacturer Parts, and Items from aXML files only. This integration is supported if you
have Agile Product Interchange, which allows you to retrieve Item and Bill of Substances
information from external content sources.

3. Specifications can be imported into the Compliance table of Items, Manufacturer Parts,
and Part Groups. Note that, specification, supplier, compositions, and Bill of Substances
that are imported into Item are Change Number specific.

4. Compositions, Bill of Substances and/or Supplier, and Specifications are version specific.
To import them, you must specify the change number in the source file. You can’t import
these four tables as you do BOM, AML, Site, or Attachments tables, because to import
them, you must Redline them first. It is also necessary to specify the change number in the
import file. You can import specifications and suppliers into Item using comma-delimited
(CSV) or Excel format. To import compositions and bill of substances, you must import
them in the aXML format.

5. Only Substances that belong to the Substance Groups or Substances class are added to
the Substances table of specifications. Subparts and materials will not add to
specifications. Only substance groups and substances are added to specifications.

6. The Composition table varies per class as shown below.

-- Substances class: The Composition table is not supported.

groups, and substances.

- Substance Groups class: The Composition table can have only substances.
- Materials class: The Composition table can have substance groups or substances.
- Subparts class: The Composition table can have other subparts, materials, substance

Several Agile PG&C objects, including items, have Mass fields. For information about importing
data to Mass fields, see Importing Mass Values on page 14.
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For a list of Agile PG&C fields that must be mapped to be imported, see Key Fields and Required

Fields on page 89.

Note In Release 9.2.2, the Declared Weight attribute on Item > Compliance > Composition and Mfr
Part > Compliance > Composition, Part Group > Compliance > Composition tables is changed to

Mass.

Using Special Export and Import Commands to Complete Declarations

Declaration classes have special export and import commands that let suppliers integrate the data
with other Agile PLM systems or complete the compliance request form in other clients, such as
Microsoft Excel or Adobe Reader. The following table lists these export and import commands.

Class(es) Commands Description
All Declaration classes Export AXML Exports and imports Agile XML for integration with Agile PLM systems.
Import AXML

IPC 1752-1 Declaration
IPC 1752-2 Declaration

Export IPC XML
Import IPC XML

Exports and imports XML data that can be used to complete IPC-1752-1
and IPC-1752-2 data compliance request forms.

JGPSSI Declaration Export JGPSSI Exports and imports a text file in block format for integration with the
Import JGPSSI JGPSSI Excel template.
Open In Excel Opens the Declaration in Microsoft Excel.

Note The commands in the table above are enabled by process extensions that are assigned to

Declaration classes. If the commands are not available, your Agile PLM system has a
custom configuration.

The data format for these special export and import commands is predefined by Agile’s aXML
format, the JPGSSI template, and the IPC-1752-1 and IPC-1752-2 forms. For more information
about these commands, refer to the Product Governance & Compliance User Guide.

Importing Attachments from aXML and PDX Packages

You can import attachments—such as CAD drawings, images, and documents—from a PDX
package or an aXML file. Attachments are usually binary files, sometimes quite large.
Consequently, they cannot be imported from a text file. The following table shows the objects for
which you can import attachments from PDX and aXML files.

Object Attachments in PDX Attachments in aXML
Item Yes Yes
Manufacturer Yes Yes
Manufacturer Part Yes Yes
Price Yes Yes
Substance Yes
Declaration Yes
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Object Attachments in PDX Attachments in aXML
Specification Yes
Part Group Yes
Product Service Request Yes
Quality Change Request Yes

When you import a BOM or an AML, attachments are not automatically imported for the associated
items, manufacturers, and manufacturer parts; you must explicitly import them.

Importable Attachment Fields

The following fields can be imported to the Attachments tab:
= File Description

@ File Name

aXML and PDX packages also support custom fields on the Attachments tab. If the Agile PLM
administrator enables Attachments fields such as Text01, List01, and NumericO1 by making them
visible, you can import data into them.

Importing the Latest Version of Attachments

The Import wizard always imports the latest version of attachments. For example, if an item has
attachments Rev A version 1, Rev A version 2, and Rev B version 1, then Rev A version 2 and Rev B version
1 are imported.

Items can have multiple revisions with different attachments for each revision. For example,
suppose there is an item with three revisions, A, B, and C. Each revision can have different
attachments and different versions of those attachments.

For example, say you import attachments for each revision in five separate import sessions:
Session 1: Revision A with File 1 Version 1
Session 2: Revision A with File 1 Version 2
Session 3: Revision B with File 1 Version 3
Session 4: Revision C with File 1 Version 4

Session 5: Revision C with File 1 Version 5 and File 2 Version 1

After completing the five import sessions, the following table shows the attachments that would be
visible for each revision.

Revision Attachments
Rev A File 1 Version 1, File 1 Version 2

RevB File 1 Version 3

RevC File 1 Version 4, File 1 Version 5, File 2 Version 1
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URL Attachments

You can attach a Uniform Resource Locator (URL) instead of an actual file. A URL is the address of
a file on the Internet, which means the file is not secured on the Agile file management server and
can be modified without the knowledge of the Agile application. URL attachments have a file size of
0 bytes and cannot be checked out from the file management server. Similar to files, you can also
import URLs.

Attachments and Rollback of Parent ltems

If for some reason an attachment is not imported, its parent object (an item, manufacturer, or
manufacturer part) is not rolled back.

Transforming Values for Attachments

Do not use a transformation definition file to modify attachment filenames. Otherwise, the Import
wizard will fail to import the files.

Importing Multiple-file (Folder) Attachments

PDX supports multiple-file attachments. In previous versions of Agile software, multiple-file
attachments were represented as a folder. When you import an attachment folder from a PDX
package, the Import wizard imports each file in the folder as a separate attachment.

Attachment Redlines

The Agile PLM system supports attachment redlines, that is, annotation layers added to the file.
Attachment redlines cannot be imported. Only the attached file and its associated fields can be
imported.

Importing Attachments from an Agile Package

An Agile package is an object that has files and documents describing a proposed product. You can
route an Agile package, to other Agile users, including supply-chain partners.

Once an Agile package is reviewed and approved by the approvers and accepted by the program
manager, the program manager can process the Agile package data using the internal procedures
specific to your company. When the package is accepted, its attachments that are PDX files or
delimited text files can be imported into your Agile PLM system.

To import an attachment from an Agile package:

1. Open the Agile package in the Agile Web Client.

2. Click the Attachments tab.

3. Select an attachment (either a PDX file or a delimited text file).
4

Click Import.

Page - 73



Import/Export Guide

Note The Import button is enabled only when the package is released. For the
default package workflow, the released status is called Accepted.

5. A message box appears. Click OK.

6. The Import wizard appears. Follow the steps in the wizard.
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Importing Supplier and System Data

This chapter includes the following:

{1100 (14T TS0 o 1= ST 75
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= |Importing & Currency CONVEISION TADIE ........cvureriieirieirreciree st 82

Importing Suppliers

You can collaborate with external suppliers to gather and prepare product content. Suppliers also
negotiate pricing and directly respond to Requests for Quotes (RFQs).

The following two fields are required to import suppliers:

o Suppliers > General Info > Name

= Suppliers > General Info > Corporate Currency
The Suppliers > General Info > Number field is a key field, but it does not need to be mapped.

If you don’t map the Suppliers > General Info > Number field, the Import wizard uses the supplier name
to find an existing supplier. If the supplier name matches the names of multiple existing suppliers,
the Import wizard rejects the row. If no supplier with that name exists, the Import wizard creates a
new supplier and uses the AutoNumber preference to assign a number to it. For more information,
see Setting Default AutoNumber Sources.

In the source data, make sure you specify the supplier type. There are five out-of-the-box supplier
types, but you can add more to your Agile PLM system. The five supplier types are:

= Broker

@ Component Manufacturer
@ Contract Manufacturer

= Distributor

= Manufacturer Representative

The Suppliers > General Info > Maximum Number of Licensed Contact Users and Suppliers > General Info >
Maximum Number of Power Contact Users fields specify the maximum number of contact users and
power users that can be added to the supplier organization, respectively. Both contact users and
power users can respond to RFQs, but only power users can generate and view reports.

Currency values for the Corporate Currency field must be specified using a three-letter code. For
more information, see Importing Currency Values on page 12.
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Importing Supplier Manufacturer and Commodity Offerings

A supplier's manufacturer offerings define which manufacturer’s products are sold by the supplier.
For example, a supplier called ACME might sell Motorola and Kemet products. When you import
manufacturer offerings, the Import wizard validates the manufacturer name against existing
manufacturer names in the Agile PLM system. If the manufacturer doesn't exist, the Import wizard
rejects the offering.

The following fields are required to import supplier manufacturer offerings:
o Suppliers > General Info > Name

o Suppliers > General Info > Corporate Currency

= Suppliers > Manufacturers > Mfr. Name

The Suppliers > General Info > Number field is a key field, but it does not need to be mapped. If you do
not map the Number field, the Import wizard uses the AutoNumber preference to assign numbers to
new suppliers. For more information, see Setting Default AutoNumber Sources.

A supplier's commodity offerings define the product categories sold by the supplier. For example, a
supplier called ACME might sell commodities like fuses, integrated circuits, and resistors. When you
import a supplier's commodity offerings, the Import wizard validates the commodity name against
existing commodity names in the Agile PLM system. If the commodity doesn't exist, the Import
wizard rejects the offering.

The following fields are required to import supplier commodity offerings:
o Suppliers > General Info > Name

o Suppliers > General Info > Corporate Currency

= Suppliers > Commodities > Commodity

Once again, the Suppliers > General Info > Number field is a key field, but it does not need to be
mapped. If you do not map the Number field, the Import wizard uses the AutoNumber preference to
assign numbers to new suppliers.

You can import either the Ship-To location or geographical values (Continent, Country/Area, and
Region/Province/State fields) for each offering.

Only valid Ship-To locations can be specified. Otherwise, the offering is ignored. The Ship-To value
can consist of multiple delimited locations (for example, “Milwaukee, Nagoya, Taipei”). If multiple
Ship-To locations are specified for a particular row, multiple offerings are created when you import
the file.

Note The Agile PLM administrator can define valid Ship-To locations by logging into
the Agile Java Client and choosing Admin > System Settings > Product Cost
Management > Ship To Locations.

Offerings can be given a rating for each Ship-To location. This rating allows the buyer to describe
their relationship with the supplier and a specific offering. Although suppliers have restricted access
to the Agile PLM system, they do not have privileges to view the assigned ratings.
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By default, there are four possible values for the Rating field:
= Approved

o Offered Active

o Offered Inactive

o Strategic

Note The Agile PLM administrator can configure the available values for the Rating
field by logging into the Agile Java Client and choosing Admin > Data & Workflow
Settings > Lists > Supplier Offering Rating.

Importing Offerings and Ratings in One Operation

To import supplier offerings and ratings in one operation, you must provide either the Ship-To
location or geographical values for the offering. Again, only valid Ship-To locations can be specified.

If a row in the source data includes a Ship-To value and it corresponds to a valid Ship-To location that
has not yet been associated with the supplier, the Import wizard creates a new offering with the
Ship-To value and the Rating value (if provided). If the specified Ship-To location is already associated
with the supplier, the Import wizard updates the Rating field (if provided). If the specified Ship-To
location isn’t valid, the entire row is rejected.

If a row in the source data doesn’t include a Ship-To value but does include geographical values
(Continent, Country/Area, and Region/Province/State fields), the Import wizard creates an offering and
automatically associates the appropriate Ship-To locations with it. However, the following rules

apply:

o The Continent value is required. If values for Country/Area or Region/Province/State fields are blank
or missing, the default value “All” is used, which results in a broad offering.

= Only single values can be imported for each geographical value. Multiple delimited values (for
example, “Arizona, California, Texas”) are not supported.

Note When you create an offering, make sure the geographical data you specify isn’'t narrower
than an existing offering for the same manufacturer or commodity. For example, if the
Region/Province/State field for an existing offering is set to “All,” you can’t create a new
offering for the same manufacturer or commaodity with the Region/Province/State field set to
“California” because the existing offering covers a broader region.

Importing Supplier RFQ Responses

Suppliers that quote on items in an RFQ can export items to prepare a response. When a supplier
exports items, the Agile PLM system generates a comma-delimited text file. The exported supplier
response file is named RFQNumber.csv. Suppliers can use a spreadsheet program, such as
Microsoft Excel, to edit the file. They can also use a quoting tool to complete responses offline. After
suppliers complete the fields in a response file, they can import the file back into the Agile PLM
system to send the response to the sourcing manager.

Unlike other types of objects that you can import, supplier responses do not require that you map
import fields to Agile PLM fields. Since the response is a modified version of the exported text file,
the mapping is automatic.
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To import a supplier response:

1.

a > w DN

Select an RFQ.

Click the Responses tab.

Choose Responses > Import. The Import wizard appears.
Click Browse, select the file, then click Open.

Click Import.

Importing Responses from Non-Web Suppliers

If a supplier does not have Web access to the Agile PLM client, the sourcing manager can import
the supplier’s response file. Since the response is a modified version of the exported text file, the
Import wizard maps response fields automatically.

To import an RFQ response from a non-Web supplier:

1.
2.
3.

o g &

Select an RFQ.
Click the Response Status tab.

Select a non-Web supplier.

Note Non-Web suppliers are indicated by the L icon.
Click Import. The Import wizard appears.
Click Browse, select the file, then click Open.

Click Import.

Guidelines for Editing Supplier Response Fields

To successfully import a supplier response text file, you must follow these guidelines when you edit
the file:

u]

You can reorder column headings, but do not edit or add any data to the headings. If you
modify column headings, the file cannot be imported.

Do not add new columns of data.
Do not modify any date fields except for EOL Date and Expiration Date.

Do not enter values in any fields with the comment “do not fill out.” Those fields are not
supposed to contain data, and the “do not fill out” comment is intended to prevent you from
editing the fields. For component parts, Nonmaterial Price fields should not be filled out. For
assembly items, Material Price fields should not be filled out.
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u]

A required field has an asterisk (*) to the right of its column heading. In the following figure, all
columns shown are required.

If you fail to complete all required fields, you can still successfully import the file. However, you
won't be able to send the response to the sourcing manager. Required and requested fields are
specified by the sourcing manager that set up the project.

Empty fields are not imported. They are not equal to 0. To set a numeric field or a price field to
0, you must explicitly enter the value 0.

If you prefer, you can remove the <HEADER> section at the top of the file since it is not
imported. To remove this section, make sure you remove the two rows containing the
<HEADER> and </HEADER> tags and all rows in between.

When you import the supplier response file, the imported data replaces existing response field
data.

When you edit a supplier response file, make sure you edit only fields you are allowed to edit.
Generally, this means the Bid Decision field and fields to the right of it. Other fields are for
viewing only.

You can import the supplier response file multiple times. Each time you import the file, only the
editable fields are imported, replacing the previous values. The fields that appear in a supplier
response file depend on whether the sourcing manager specified them as requested and required.

The Agile PLM system supports different price scenarios, so RFQ fields vary based on the price
periods and/or quantity breaks specified for a particular project. Prices can be based on multiple
quantity breaks (up to 6) or on multiple price periods, with one or more quantities per price period.
The following table shows all editable and non-editable supplier response fields.

Field Editable?

Adderl Yes

Bid Decision Yes

Country of Origin Yes

EOL Date Yes

Expiration Date2 Yes

Inventory Yes

Item Number

Item or Mfr Part Description
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Field Editable?

Lead Time Yes

Material Cost Yes

Min Yes

Mult Yes

Mfr Name

Mfr Part Number

NCNR Yes
Nonmaterial Pricel Yes

NRE Yes

Period Start Date Quantity Break 1...6 - Quantity?2

Period Start Date Quantity Break 1...6 - Target Price3 Yes

Quantity Break 1...63

Response Flex Fields1, 3 Yes

RFQ Number

Rev

Terms of Sale Yes

UuoM

Notes:

1. This field can be configured by the sourcing manager. Consequently, it may have a
different display name.

2. The availability of this field depends on the price scenario selected for a particular project.

3. There are 25 response flex fields that can be configured and enabled in the Agile PLM
system: 5 date fields, 10 text fields, 5 number fields, and 5 currency fields.

Adding Suggested Alternate Parts to the Response File

Suppliers are often requested to quote on parts they are unable to supply for various reasons. For
example, the part may be obsolete, on allocation, or have an End of Life (EOL) status. The part may
also be unnecessarily expensive, or perhaps the supplier doesn’t have the full quantity available
within the required lead time. To remedy this problem, the supplier can suggest alternate parts in
the RFQ response.

When you suggest an alternate part, you can also suggest new manufacturers for the part, including
manufacturers the sourcing manager did not consider.
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To add suggested alternate parts to the RFQ response:

1. Open the exported response file in a spreadsheet program (such as Microsoft Excel) or
another application that supports comma-delimited files.

2. Insert a row for the part you wish to replace.

3. Enter appropriate values in the Mfr Part Number, Mfr Name, and Item or Mfr Part Description fields.
The value in the Item Number field must be identical to the part you're replacing. In the Bid
Decision field, enter Bid - Alternate. Leave the Rev and UOM fields blank; those fields are inherited
from the parent item. Fill out other fields as appropriate.

You can insert additional rows to suggest more alternate parts.

4. Save the file in comma-delimited (CSV) format.

Importing Responses to Price Scenarios

Supplier response files display price scenarios horizontally. The supplier can therefore fill out all
response information for each component part on a single row.

Each price scenario represents either one quantity break or one quantity per price period. The
following table shows quantity breaks and target prices that have been entered for one period for
several different items.

[tem Number Q 4 30-Dec-2002 Q 4 30-Dec-2002 QuantityBreakl
QuantityBreakl - Quantity - Target Price

10-007 1 0.04

10-008 10 12.80

10-009 1 0.04

10-010 10 16.60

10-011 1 0.04

10-012 1 0.09

10-013 5 2.95

10-014 100 122.00

The Import wizard ignores empty fields. To set a price value to 0, you must explicitly enter 0.

Note Price values in the exported supplier response file are formatted according to the user’s
currency preference. To change your Agile user preferences in the Web Client, click
Settings > User Profile > Preferences > Edit.
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Valid Values for Supplier Response Fields

Certain supplier response fields require specific values that must be spelled correctly. If you type an
invalid value in the field, it won’t be imported. The following table shows the valid values for the
supplier response fields that require specific values.

Note The header for the supplier response file also lists values for these fields.
Field Valid values Note

Bid Decision Bid, Bid - Alternate Part, No Bid - Non-
Franchise, No Bid - Obsolete Part, No Bid -
On Allocation, No Bid - Other, No Bid -
Unknown Part, Not Responded

Country of Enter a valid country name. Make sure

Origin the spelling is correct.

NCNR Yes, No

Terms of CFR Cost and Freight

Sale
CIF Cost, Insurance, and Freight
CIP Carriage and Insurance Paid To
CPT Carriage Paid To
DAF Delivered at Frontier
DDP Delivered Duty Paid
DDU Delivered Duty Unpaid
DEQ Delivered Ex Quay (Duty Paid)
DES Delivered Ex Ship
EXW EX Works
FAS Free Alongside Ship
FCA Free Carrier
FOB Free on Board Vessel

Note In addition to the three-letter abbreviations for Terms of Sale, you can enter the full Terms of

Sale value, for example, “CFR - COST AND FREIGHT” or “CIF - COST, INSURANCE

AND FREIGHT.” The value must be all uppercase.
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Importing a Currency Conversion Table

Agile allows you to maintain up-to-date currency conversion rates that convert currency values to
the selected corporate currency. You can use the Import wizard to update the conversion rates for
all currencies enabled in the Agile PLM system. To import a currency conversion table, you must
log in as a user assigned the Administrator role.

The

m]
m]

u]

currency conversion table that you import must meet the following requirements:
It must be either a Microsoft Excel file or a delimited text file.
The file should have two columns containing the currency code and the conversion factor.

Each currency specified in the source file must be enabled in the Agile PLM system. To check
which currencies are enabled, log into the Java Client as an administrator and choose Admin >
System Settings > Product Cost Management > Currency Exchange Rates.

Currencies must be specified using three-letter codes. For example, EUR and USD are the
codes for the Euro and the U.S. Dollar, respectively. For a complete list of currency codes, see
Importing Currency Values on page 12.

Make sure you map the following Agile fields:

u]

m]

Currency Conversion > Currency Exchange Rates > Currency Code

Currency Conversion > Currency Exchange Rates > Conversion Factor

The following figure shows an example of a currency conversion table:
A | E |

_1 |Currency Code Conversion Factor

2 |GBF 0.71

_ 3 |FRF 0.52

4 |RUR 160.1

5 |=GD 22

B IMNR 4717

7 PY /8.05

To import a currency conversion table:

© N o o b~ 0w DN E

Format the source file appropriately using either a Microsoft Excel file or a delimited text file.
Start the Import wizard.

On the first step of the Import wizard, select Delimited Text File or Excel Workbook.

Type the path of the file, or click Browse to select it.

Click Next.

Select Currency Conversion. Click Next.

Select a mapping file, or create new field mappings.

Click Import to begin the import operation.
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Importing Data into a Sourcing Project
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About Sourcing Projects

A project holds data you gather during product sourcing activities. Buyers can use projects to gather
information to prepare RFQs, assign suppliers, track and analyze responses, and negotiate final
pricing. Buyers can also perform cleanup of AMLs in a project and publish them to the Item Master,
where they are available for all future projects.

You can create a project using one of the following price scenarios:

o Quantity Breaks — prices are based on multiple quantity breaks to determine the best suppliers
and components for a product.

o Effectivity Periods — prices are based on multiple effectivity periods, with one or more quantities
per period, to manage the ongoing cost of products throughout a product’s lifecycle. This price
scenario provides forward-looking visibility into product costs to help you uncover opportunities
to reduce costs and meet targets.

Starting the Import Wizard from a Sourcing Project

Project objects, such as items, BOMs, and AMLs, are different from Item Master objects. They have
different sets of fields, and therefore different field mappings, than Item Master objects. When you
import items into a project, they are not imported automatically into the Item Master.

Note After you import BOMs into a project, you may need to recalculate quantities
for BOM components. For more information, see Calculating Rollup Quantities
on page 86.

To import data into a new sourcing project:
1. Choose Create > Sourcing Project.and complete the Project Creation wizard.
2. Onthe Add Items step of the wizard, click Add. The Add Project ltems wizard starts.

3. Under Create New Items, select Importe > Next. The Import wizard appears. Follow the wizard
steps.
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To import items and BOMs into an existing sourcing project:
1. Open a sourcing project.
2. Click the Items tab.

3. Choose Items > Import. The Import wizard appears. Follow the wizard steps.

Note If items you import from the Items tab have both BOMs and AMLs, you can
import them at the same time.

To import ltems and AMLs into an existing sourcing project:

1. Open a sourcing project.

2. Click the AML tab.

3. Choose AML > Add/Modify > Import. The Import wizard appears. Follow the wizard steps.

For a list of the Import wizard steps, see Import Wizard Steps on page 6.

Importing Level Templates and Parent-Child Templates into Sourcing
Projects

You can import a Level Template or a Parent-Child Template into Sourcing Projects as follows:
= Create a Sourcing Project using the Wizard andthen import the desired template

o Serach for an existing Sourcing Project and then import the Level Template or Parent-Child
Templates into the Sourcing Project

= Import an Item from an external file

To import a Level or Parent-Child Template into a Sourcing Project:

1. Inthe selected (or defined) sourcing project, click Items.
The drop down menu appears.

2. Inthe drop down menu, select Import....

The Import Wizard dialog appears.
Note Level Templates or Parent-Child Templates are Delimited Text Files.

3. Use the Browse button to locate the file that you want to import and the Configure button to
specify the File Type (Level Template, Parent-Child Template, or Standard Template). Unlike
Standard Templates, Level Templates or Parent-Child Templates only require Item and
Quantity fields.
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Calculating Rollup Quantities

After you import data into a sourcing project, you need to calculate the quantities for BOM
components. At the top of the Items and AML tabs of a project, it shows the date and time when
guantities were last calculated. When the calculated date and time is red, you need to click & to
recalculate quantities.

Within a sourcing project, you specify quantities for top-level assemblies, not for BOM components.
For BOM components, you specify quantities per assembly (QPA).

For each price scenario in your project, component level quantities are based on the assembly
guantities and the QPA. When you calculate quantities, the project aggregates the quantities across
assemblies for common items. If partner splits have been specified, the project also applies the
splits to the calculated quantities.

Types of Data You Can Import into a Project

You can import the following object types into a project:
= Project items

= Project bills of material

o Project approved manufacturers lists

= Project item attachments

An assembly item is any item that has a BOM. Any project items that have a BOM can also have an
AML. You can import a BOM and an AML into the same project item.

Publishing AMLs from a Project to the ltem Master

Although you can import product content from the Item Master into a project, you cannot copy items
and bills of material from a project into the Item Master. Approved manufacturers lists (AMLS),
however, are different. You can validate AMLs in a project against the Item Master. You can also
perform cleanup on AMLs in a project. After you finish cleaning up an AML, you can publish the
AML changes back to the Item Master.

Mapping and Importing Quantity Breaks and Target Costs

Depending on the price scenario specified for a particular project, you can import multiple quantity
breaks per item, or multiple effectivity periods per item with one or more quantities per period. This
means that you can import quantity breaks or quantities per price period for each top-level
assembly. You can also import the target cost per quantity break or target cost per price period,
depending on the price scenario you select.

If the project’s price scenario is based on quantity breaks, you can select up to six quantity breaks.
The Edit Mapping File window lets you map Cover Page > QuantityBreak fields for the number of
quantity breaks in your project.
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If the project’s price scenario is based on multiple effectivity periods, the Edit Mapping File window
lets you map the quantity breaks and the target costs for each specified period.

How Projects Handle Revisions

Projects do not hold multiple revisions of items. Consequently, you can import preliminary, pending,
and released revisions of an item into a project. If you reimport an item, it replaces the previous item
in the project. This means that you can import preliminary items as well as back, current, or pending
revisions to replace released or unreleased revisions in a project.

Important When you reimport an item into a project, all data for the original item (such as BOMs and
AMLSs) are removed before the new data is imported. Therefore, you should always export
complete BOMs and AMLs before updating the data and then reimport the data. Also,
make sure you map the Title Block > Rev field when you import items. Otherwise, items will
be imported as an Introductory revision.
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About Mapping Files

When you import data into the Agile PLM system, you must indicate where to put the data. You do
this in the Import wizard by mapping fields in the source data to Agile fields. Only mapped fields are
imported. The Import wizard ignores any source fields that are not mapped.

Mapping files are XML files that can be reused to map data for subsequent import sessions. You
can save the files locally or on a network drive. They are not stored on the Agile PLM system.

Note The Import wizard does not support mapping files created with previous Agile Product
Cost Management or Agile Product Collaboration releases.

Key Fields and Required Fields

Key fields uniquely identify an object in the Agile PLM system. Therefore, key fields are required to
import all objects, whether they are new or already exist. An example of a key field is the Title Block
> Number field for a part. In fact, most of the key fields for Agile PLM objects are used to set the
unique number for objects. When you map fields for import, all key fields in the Edit Mapping File
window are shown in blue boldface type.

The following table lists key fields for all objects supported by the Import wizard. You must map
these fields

Object Tab Key Fields

Currency Conversion Currency Conversion Currency Code

Customer General Info Customer Name

Customer Numberl

Declaration Attachment File Identifier, File Name

Cover Page Name, Supplier
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Object Tab Key Fields
Item Composition Item Number, Item Revision
Substance Name
Substance Type
Items Item Number, Revision Number
Manufacturer Parts Mfr Name
Mfr. Part Number
Manufacturer Part Composition Mfr Name
Mfr. Part Number
Substance Name
Substance Type
Part Group Composition Name
Substance Name
Substance Type
Part Groups Name
Specifications Specification
Item Attachments File Identifier
File Name
BOM [tem Number
Compliance Specification
Manufacturers Mfr. Name
Mfr. Part Number
Sites Site Name
Suppliers Supplier, Change Number
Title Block Number
Composition Composition Type, Change Number
Substance Substance Name, Substance Type
Manufacturer Attachments File Identifier
File Name
Manufacturer Part General Info Name
File Identifier
File Name
Compliance Specification
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Object Tab Key Fields
Composition Composition Type2
General Info Manufacturer Name
Manufacturer Part Number
Substance Substance Name
Suppliers Supplier
Part Group Attachments File Identifier
File Name
Compliance Specification
General Info Name
Parts Part Number
Suppliers Supplier
Cover Page Numberl
Affected Items [tem Number
Project Item AML Manufacturer Name
Manufacturer Part Number
Attachments File Identifier
File Name
BOM Component Part Number
ltems Number
Published Price Attachments File Identifier
File Name
General Information Customer
[tem Number
ltem Revision

Manufacturing Site

Manufacturer Name

Manufacturer Part Number

Numberl

Price Type

Program

Supplier

Price Lines

Price Effective From Date

Price Effective To Date
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Object Tab Key Fields

Qty

Ship From

Ship To

Quote History General Information Customer

[tem Number

[tem Revision

Manufacturing Site

Manufacturer Name

Manufacturer Part Number

Numberl

Price Type

Program

Supplier

Price Lines Price Effective From Date

Price Effective To Date

Qty
Ship From
Ship To
Specification Attachments File Identifier
File Name
General Information Name
Substances Name, Substances Type
Substance Attachments File Identifier

File Name, Substances Type

Composition Name
General Information Name
Supplier Commodities Commaodity
Continent
Ship-To
General Information Name
Numberl
Manufacturers Continent
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Object Tab Key Fields
Manufacturer Name
Ship-To
Programs General Information Name

Number

Action Items Assigned To

Discussion Subject

User General Info User ID

User Group group name

User Group General Info Name

Users user names in group

Notes:

1. If you don’t map the Number field or the data is not provided in the source file, the Import
wizard uses an AutoNumber source to assign a number to a new object it creates. You can set
the default AutoNumber sources used by the Import wizard. For more information, see Setting
Default AutoNumber Sources.

2. Composition Type determines what type of substances can be imported into the composition:
®  Substance Composition — Substances and substance groups can be imported.

*  Homogeneous Materials Composition — Subparts, materials, substance groups, and
substances can be imported.

*  Part Composition — No substances can be imported.

In addition to key fields, Agile PLM also has required fields. The Agile PLM administrator can
configure any field on Page One (Title Block, Cover Page, or General Information), Page Two, or Page
Three of an object to be a required field. To import new objects in Agile PLM, you must complete all
required fields. However, if you are importing data to existing objects, required fields don't need to
be mapped. When you map fields for import, all required fields in the Edit Mapping File window are
shown in green boldface type.

For a full list of required Agile PLM fields, print the Agile Classes Report from the Web Client.

Some Agile PLM objects have special mapping requirements. See the following sections for more
information.

BOM Mapping Requirements

Title Block > Number and BOM > Iltem Number are required fields. However, BOM > Find Num and BOM >
Qty are optional key fields. If you don’t map the BOM > Find Num field, the BOM tab shows 0 as the
find number for all imported items. If you don’t map the BOM > Qty field, all quantities on the BOM tab
use the default quantity value set by the Agile PLM administrator.
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Quote History and Published Price Mapping Requirements

Quote histories and published prices have special mapping requirements due to the multiple
required and optional key fields that can be used to import them. For more information about the
minimum required fields for quote histories, published prices, and price lines, see Importing Quote
Histories, Published Prices, and Price Lines on page 59.

Mapping Classes and Subclasses

For item, BOM, and AML imports, there are two separate target classes that may need to be
mapped depending on what the source file contains. If the source file contains both parts and
documents, then you must map both the Parts class and Documentation class, even if the
mappings are the same.

If you do not map the Type field for the object, or the Type column of a particular row is blank, then
the default type for the object is used, regardless of whether the object currently exists or not. For
example, if your import file contains documents, but you don’t map the Type field, documents could
be imported as parts if that is the default item type selected in Import preferences. For items in the
import file that already exist in the target system, a type mismatch rejection error occurs if the
default type assumed by import does not match the existing object in the target system.

For information about how to specify default types for an import session, see Setting Default Types
on page 46.

Selecting a Change Order and Mapping File

When the Select Change Order and Mapping File page appears in the Import wizard, you can
specify a change order and select a mapping file using the following options:

o Change Order — If you are importing in Redlining mode (the default), click H to select a
change order. If you are using Authoring mode, you may optionally specify a change order. For
more information about redlining, see Using Redlining or Authoring Mode on page 65.

Note To change from Redlining mode to Authoring mode, click Preferences, select
Business Rule Options, and change the value for the Change Mode field.

@ Use an Existing Mapping File — After selecting this option, type the path of a mapping file or click
Browse to select one. The mapping file must exist on your local system or on a network
computer. Mapping files are not stored on the Agile PLM server.

= Create a New Mapping — After selecting this option, click Create New Mapping to define a new
mapping file.

o Use Currently Defined Mapping Definition — Use a mapping definition previously selected during
this import session. If you have not specified a mapping file yet, this option does not appear.

o Use Default Mapping Definition — Use the default field mappings for the specified file type. This
option is not available for Excel files and delimited text files that do not use a predefined
template format.

= Edit Chosen Mapping — Display the Edit Mapping File window for the selected mapping
definition.
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Once you select or create a mapping definition, the Import wizard stores it in memory for the current
import session. After this, you can click Import to begin the import process, or click Next to select
other options.

Creating a New Mapping File

If you are importing data from a new source, you need to create a mapping file. To create a
mapping file, you select fields from the import data and map them to Agile fields.

To create a new mapping file:
1. Inthe Import wizard, proceed to the Select Change Order and Mapping File page.

2. Select Create a New Mapping, and then click the Create New Mapping button. The Edit Mapping File
window appears.

Note If the Edit Mapping File window has no fields, the source file may be invalid. If
the source file is a delimited text file, make sure fields in the header row do not
have carriage return or linefeed characters.

3. Click a field in the Import Fields list.

Note Only one field can be selected at a time in the Edit Mapping File window.
However, you can map an import field to multiple Agile PLM fields.

4. Navigate to the corresponding field in the Agile Fields list. Click the field to map it. An arrow «—
appears next to the field along with the name of the import field to which it is mapped.

5. Repeat steps 3 and 4 for all fields that you want to map.

6. When you finish mapping all fields, click Save As. The File Download dialog box appears.
7. Select Save this File to Disk. Click OK.

8. Type the name of the file, and click Save.

9

Click Finished to close the Edit Mapping File window.
To unmap a field in the Edit Mapping File window:
Click ¥l to the right of the mapped field.
To show all fields in the Edit Mapping File window:
Click Expand All.

Mapping Page Two and Page Three Fields

Only visible Agile fields can be mapped in the Edit Mapping File window. To map source fields to
Page Two or Page Three fields, the Agile PLM administrator must configure those fields to be
visible.
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How Fields are Sorted in the Edit Mapping File Window

When you are importing data from a PDX package, the Edit Mapping File window displays import
fields sorted in alphabetical order within each node in the package. The following figure shows how
fields in a PDX package are sorted for the Item subclass.

EHj Iterns
EHj Itern
- glabalLifeCyclePhaseCode
- glabalProductTypeCode
- isTopLewvel

- iternlIdentifier

- itermUnigueldentifier

When you import data from a delimited text file, the Edit Mapping File window does not sort the
import fields. Instead, it displays the fields in the order in which they appear in the text file, as shown
in the following figure.

Import Fields

é----F‘arent Itern Nurmber
BOM Cormponent Mumber
é----F‘art Description

To make it easier to map fields in a text file, you may want to sort the fields in another application,
such as Excel, before attempting to import the data.
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Agile fields are sorted in alphabetical order by the tab on which the field appears, as shown in the
following figure.

Agile Fields

E}El Docurmentation Class

-8 Tit e Block
~Description

-Diocurnent Category
~Diocument Type
—MNumber
-Product Lineis)
- Sites
Size
E}-t_fl Parts Class
.-:u Page Three

-8 Tite Black
~Description

—MNumber
-Part Category
~Part Type
-Product Lineis)
- Sites

e Slze

Reusing a Mapping File

If you routinely import data from the same source (such as PDX packages originating from the
same source system), you can maintain mapping files that correctly map source fields to Agile
fields.

Mapping files are flexible and are designed to be reused for subsequent import sessions. The
import source data generally varies from one import session to another. However, it's possible to
reuse the same mapping file for multiple source files if the mapping file contains fields common to
them. For example, if you create a mapping file that contains mappings for all PDX objects, you can
reuse that particular mapping file for any PDX file, including a file that only includes one type of
object, such as Items. If a target field is mapped but doesn'’t exist in the import source file, the
Import wizard ignores the field and doesn’t import it.

Target fields in the Agile PLM system can also change from one import session to another. For
example, the Agile PLM administrator can make fields invisible that may have been used in your
mapping files. When a target field is mapped but isn't visible in the Agile PLM system, the Import
wizard ignores the field and doesn’t import it.

If you rename column headings in your import source file, any mapping files that you created for
that particular source file will be invalid. To successfully import the data, you need to remap all fields
that have been renamed. The Import wizard ignores any mapped fields that are not found in the
source file.
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If the Agile PLM administrator renamed classes or attributes used in a mapping file, the Import
wizard resolves target fields by referencing their internal IDs. Therefore, mapping files that
reference renamed fields are still valid. The Debug Mapping Window shows a warning message for
every field that the Import wizard resolves to a different name.

To use an existing mapping file:
1. Inthe Import wizard, proceed to the Select Change Order and Mapping File page.
2. Select Use an Existing Mapping File.

3. Type the path of the mapping file, or click Browse to select it.

Note After you select the file, you can confirm the field mappings by clicking Edit
Chosen Mapping.

4. Click Next to continue.

Editing a Mapping File

If an import file has been modified (for example, new columns of data have been added), you need
to modify its associated mapping file. Otherwise, the mapping file could be invalid for the revised
data.

To edit a mapping file:
1. Inthe Import wizard, proceed to the Select Change Order and Mapping File page.
2. Select Use an Existing Mapping File.

3. Type the path of the mapping file, or click Browse to select it.
Note Mapping files have an XML filename extension.

4.  Click Edit Chosen Mapping. The Edit Mapping File window appears.

When you reuse a mapping file to import a new source file, the Import wizard ensures that the
mapping file correctly matches the source data. If the mapping file has errors, an
Errors/Warnings box appears at the top of the window. You can click an error or warning in the
box to highlight its related field.

Edit the mappings.
Click Save As to save the file. The File Download dialog box appears.
Select Save this File to Disk. Click OK.

Type the name of the file, and click Save.

© © N o U

Click Finished to close the Edit Mapping File window.
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Mapping PDX and aXML Packages

When you select Use Default Mapping Definition on the Select Change Order and Mapping File page,
the Edit Mapping File window provides default mappings for core Agile fields. Custom fields are not
mapped by default; you have to map those fields manually.

Only PDX and axXML elements present in the source file are assigned default mappings. For
example, if the file contains only items and no other types of import data, then the Edit Mapping File
window shows default mappings for item fields only. If you save the mapping file to reuse it later,
you can use it only to import items.

To create a mapping file with mappings for all types of import data, make sure all objects are
selected in the Select Contents to Import page of the Import wizard. That way, default mappings are
assigned for all objects, regardless if all objects are contained in the selected source file.
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Creating Transformation Definition Files

This chapter includes the following:

About Transformation DEfINItION FIIES...........eiiuiuririiririeiiee e
Required Columns and Column HEATINGS ........veurrireiririririeeireisseese et
Using PREFIX, SUFFIX, or REPLACE OPEIALIONS ......cvuviriererireirieesireeestsessesesssssssssssssssessssssssssssessssssessssssens
Using Regular Expressions in the SourcePattern Field
Replacing Blank Fields with a Default Value
Generating a Transformation TEMPIALE..........ccovervrrririresreee e erenns
Transforming Different Types of Data................

Reusing Transformation DefiNition FIlES ...t

About Transformation Definition Files

Source data that originates from a supplier or partner can contain incompatible data. That is, the
data may be invalid or inconsistent with your company's Agile PLM system. Before you import data,
you may need to transform the values in some fields to make them compatible with the target
system.

Transformation definition files are especially helpful for importing data from PDX or aXML
packages. Generally, PDX or aXML packages are read-only. You cannot change the values
contained in an archived file. If there are data inconsistencies in a PDX or aXML package, you must
try to correct them using a transformation definition file.

A transformation definition file is a comma-delimited text file. Optionally, you can qualify text strings
in the file using double-quotes (). The file must contain a set of required fields needed to transform
import data.

Transformation definition files are optional for the Import wizard. If your source data does not need
to be modified for your target system, you can skip the Select Transformation Definition File step in
the Import wizard.

Every transformation that occurs during an import session is noted in the import log file.

The Import wizard does not support transformation definition files created with previous Agile
Product Cost Management or Agile Product Collaboration releases.
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Required Columns and Column Headings

If you are importing AML data from a PDX package, and you are using a transformation definition
file, you should include the same transformations for fields in related objects (Manufacturer Part
Number, Manufacturer Name) so that the corresponding attributes for AML rows, manufacturers,
and manufacturer parts will have the same values.

Column heading Description

ObjectTypeName The class or subclass name on the target system, for example, Parts Class.

PropertyGroupName The name of the group (or tab) containing the property, for example, Title Block.

PropertyName The name of a target field.

Operation The transformation operation. Valid operations are “REPLACE,” “PREFIX,” or “SUFFIX.”

SourcePattern A string to match the entire source value for the specified field. You can use regular expressions to
match patterns of text. The pattern you specify is case-sensitive.

ParameterValue The replacement, prefix, or suffix text used to transform the SourcePattern string.

Note You can add an optional Comments column to document each row of the file.

Optionally, you can include the following three columns: ObjectTypeld, PropertyGroupld, and Propertyld.
These columns appear automatically in a transformation template that you can generate from the
Import wizard. The columns are not required, but they map the ObjectTypeName, PropertyGroupName,
and PropertyName columns to unique internal Agile ID numbers. The ID columns ensure the validity
of the transformation definition file in the event that an Agile field name—such as the name of a
custom field—changes.

Caution Do not change the column names as they appear in column headings. They must match
the specified names exactly. Otherwise, the transformation definition file is invalid. Oracle
recommends that you dowl

You can change the order of columns as long as you also change the respective column header.
For example, you can make column A the PropertyName column.

The header row (that is, the row with column names) must be the first row in the file. There should
be no blank columns to the left of the first data column. For example, in an Excel file, the table
should start at column A.

You can perform only one transformation per target value. This means that you cannot, for
example, use a PREFIX and SUFFIX transformation on the same value. Nor can you chain
transformations together in sequence to modify a value iteratively.

Transformations occur in sequential order from top to bottom in the transformation definition file.
Only the first transformation for a target field’s value is used; other transformations for the same
value are ignored.
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Using PREFIX, SUFFIX, or REPLACE Operations

Transformation definition files allow you to add a prefix or suffix to values, or replace values.

A PREFIX operation simply adds a specified string to the beginning of a value.

Operation SourcePattern ParameterValue Result
PREFIX 12345 P- 12345 -> 67890
PREFIX 1 P- 1->P-1
A SUFFIX operation adds a specified string to the end of a value.

Operation SourcePattern ParameterValue Result
SUFFIX 12345 -S 12345 -> 67890
SUFFIX 1 -S 1->1-S

A REPLACE operation replaces the entire value. You cannot replace a portion of a value. You also
cannot replace a value with an empty string.

Operation SourcePattern ParameterValue Result
REPLACE 12345 67890 12345 -> 67890
REPLACE 1 Agile 1-> Agile

Using Regular Expressions in the SourcePattern Field

When you specify values in the SourcePattern field of the transformation definition file, you can use
regular expressions to match patterns of text. A regular expression can contain symbols or syntactic
elements used to represent one or more characters.

The simplest regular expression is a literal text string, such as IPN100012. Any alphanumeric
character in the SourcePattern field matches the same character in the source data.

You can also use special symbols to match text patterns in a generalized way, much like wildcards.
The following table lists the regular expression symbols you can use in the SourcePattern field.

Symbol Description
Period (.) Matches any single character.
Asterisk (*) The preceding character appears zero or more times.
Plus (+) The preceding character appears one or more times.
Question mark (?) The preceding character appears zero or one time.
Note The source pattern you specify must match the entire incoming value. Otherwise, the

value won't be transformed.

Although regular expressions enhance the types of transformation you can specify, they are
optional. If you don't find them helpful, you don’t have to use them. The following table shows

several examples of regular expressions.
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SourcePattern Matching values

X Any value, including an empty string.

4 Any value except an empty string.

A* Values that start with A.

AGILE.* Values that start with AGILE.

FAGILE Values that end with AGILE.

FAGILE * Values that contain AGILE.

P0012+ P0012, P00122, P001222, P0012222, and so on. However, it does not match PO01.
P0012* P001, P0012, P00122, P001222, P0012222, and so on.

P00127? P001 or POO12.

P00*20 P020, P0020, P00020, P000020, P0000020, and so on.

P00.+20 P00020, P00120, P00220, P00320, P00123456789020. However, it does not match P020.

Replacing Blank Fields with a Default Value

You can use a transformation template to provide default values for blank fields in your source file
that have been mapped. This is a particularly handy use for transformation templates. For example,
if the Product Line(s) field is blank in your source data, you can still map the field and set it to import
a default product line value for your Agile PLM system.

Remember, you must map the empty field you want to replace with a default value. Otherwise, the
Import wizard skips the unmapped field.

Use the following SourcePattern string to represent an empty field: *$ (the caret and dollar sign
characters). The ParameterValue you specify must be a valid value for the specified field.

The following figure shows how to replace all empty Product Line(s) fields in the source file with a
default value Ultra.

A [ B [ C ey E [ F | G
_1 |ObjectTypeName PropertyGroupName PropertyMame Operation SourcePattern ParameterValue Comments
If the Product Lines
field iz empty, set it

_ 2 |Parts Class Title Block Product Line(s) REPLACE *§ Ultra to Ultra
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Generating a Transformation Template

The Import wizard lets you generate a transformation template, a comma-delimited text file that has
the appropriate fields for the target Agile PLM system.

To create a transformation template:

1. From the Select Transformation Definition File page of the Import wizard, select Apply
Transformations.

2. Click Download Transformation Template. The File Download dialog box appears.
3. Save the file to your local computer.

4. In Download Transformation Template window's Popup, click OK.

The default transformation template filename is TransformTemplate.csv. It is a comma-separated
file that can be edited in a text editor or a spreadsheet program.

Important Do not change the default values in the ObjectTypeName, PropertyGroupName, and
PropertyName columns. Otherwise, the transformation will fail. To avoid changing these
values, Oracle recommends that you download the template and avoid creating new ones
that require typing in the values.

After you create a transformation template, fill in the following columns:
@ QOperation
= SourcePattern

o ParameterValue

The Import wizard skips lines in the transformation definition file that don’t have an operation
defined. If you specify an operation in a row, you must also specify a source pattern and parameter
value in that row.

The Comments column is optional and is used to document each transformation. The three rightmost
columns, ObjectTypeld, PropertyGroupld, and Propertyld, should not be edited. They show the internal
Agile PLM ID numbers for each field.

Transforming Different Types of Data

Depending on the fields you are trying to transform and their data types, there are different
transformation considerations. This section describes issues involved in transforming item numbers,
manufacturer names, and product lines.

The following topics describe how you can use transformation definition files to modify different
types of import data to make it valid for your Agile PLM system:

@ Transforming Item Numbers
o Transforming MultiList Values
= Transforming Manufacturer Names

= Transforming AML Data
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If you are importing attachments from an aXML file or a PDX package, you cannot use a
transformation definition file to modify attachment filenames.

Transforming ltem Numbers

In the Agile PLM system, the Title Block > Number field uniquely identifies an item. Similarly, the
BOM > Item Number field identifies a component part of an assembly. The same item number can be
used for both fields.

If you are importing bills of material and you are transforming Title Block > Number values for items,
you should also use the same transformation for the BOM > Iltem Number field.

Do not specify a blank ParameterValue. Remember, the Import wizard skips blank fields.

The following figure shows an example of a transformation definition file that modifies the values for
both the BOM > Item Number and Title Block > Number fields, adding a prefix to each item number.

A | B | ® [ = | F
1 |ObjectiTypeName PropertyGroupdame PropertyMame Operation SourcePattern ParameterValue
_ 2 |Parts Class BOM ltermn Mumber FREFIX .7 DE-
.3 |Parts Class Title Block Mumber PREFEX .7 DE-

Transforming MultiList Values

Although the value for a MultiList field is displayed as a comma-delimited string, the Agile PLM
system validates the string against the full list of values. To transform values for a MultiList field, you
specify source and target values for each individual list value, not for the entire delimited string of
values.

The Product Line(s) field for items is an example of a MultiList field. To import a value into a MultiList
field, the value must be a comma-delimited string. (You can click the Preferences button in the Import
wizard to specify another character, such as a semicolon, for the MultiList delimiter.) For example, a
Product Line(s) value might look like this:

“Analog, Tools, Memory”
Suppose you want to change these individual values to “Analog & Interface Products,”

“Development Tools,” and “Memory Products,” respectively. You can specify a simple REPLACE
operation for each value in the transformation template, as shown in the following figure:

A | B | C | D | E | F
_1 |ObjectTypeName  PropertyGroupMame PropertyName Operation SourcePattern Parameterifalue
_2 |Pans Class Title Block Product Lineis) REFLACE  Analog Analog & Interface Products
_ 3 |Parts Class Title Block Product Line(s) REPLACE  Tools Developrment Tools
_4 |Parts Class Title Block Product Line(s) REPLACE  Memary hemary Products

Important Product Line(s) values, like all Agile lists, are case-sensitive.
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Transforming Manufacturer Names

If you are importing approved manufacturers lists, manufacturers, or manufacturer parts, it is
possible that the manufacturer names in the source data do not match exactly the manufacturer
names used in the Agile PLM system. Any difference in manufacturer names, however slight,
should be corrected using a transformation definition file. If you do not transform invalid
manufacturer names, you can end up with multiple objects representing the same manufacturer,
such as CPQ and Compag.

The following figure shows a transformation definition file that modifies manufacturer names when
you import manufacturers. There are six different manufacturer names in the source file: CPQ,
DELL, FLEX, MARSHALL, SLCTRN, and TI. The transformation definition file specifies the six

replacement values for these names.

A | B G RN E F
_1 |ObjectTypeName  PropertyGroupName PropertyName Operation  SourcePattern ParameterValue
2 |Manufacturers Class | General Info Mame REPLACE CPQ Compag
3 |Manufacturers Class  General Info Marne REFLACE DELL Dell Computer Carparation
_4 |Manufacturers Clazs  General Inf Mame REPLACE  FLEX Flestranics
& |Manufacturers Class | General Info Marme REPLACE  MARSHALL  Marshall Industries
_B |Manufacturers Class | General Info Marme REPLACE | SLCTRN Solectran
7 |Manufacturers Class  General Info Marne REFLACE Tl Texas Instruments

Here is a similar transformation definition file that modifies the manufacturer names in an AML.

Transforming AML Data

A | B C D E F
| 1 |ObjectTypeName  PropertyGroupName PropertyMame Operation  SourcePattern ParameterValue
| 2 |Pars Class hlanufacturers Mfr. ame REPLACE CPQ Compan
| 3 |Parts Class Manufacturers Mt Marne REPLACE DELL Dell Computer Corporation
| 4 |Parts Class Manufacturers Mfr. Marne REPLACE  FLEX Flextronics
| & |Pars Class Manufacturers Mfr. Mame REPLACE  MARSHALL  Marshall Industries
| B |Pars Class Manufacturers Mfr. Mame REPLACE  SLCTRM Solectran
| 7 |Pars Class Manufacturers hfr. Mame REPLACE Tl Texas Instruments

If you are importing AML data from a PDX package, and you are using a transformation definition
file, you should include the same transformations for fields in related objects (Manufacturer Part
Number, Manufacturer Name) so that the corresponding attributes for AML rows, manufacturers,

and manufacturer parts will have the same values.
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Reusing Transformation Definition Files

You can maintain a transformation definition file that correctly transforms data for all types of import
data. You may also find it helpful to create a transformation definition file for each manufacturer, as
your manufacturers may use different conventions for entering product data.

Note Make sure you give recognizable names to transformation definition files so that they can
easily be associated with a particular manufacturer or an Agile PLM system. Otherwise,
you may use the wrong transformation definition file and modify the import data the wrong
way.

To use an existing transformation definition file:

1. From the Select Transformation Definition File page of the Import wizard, select Apply
Transformations.

2. Type the path of the transformation definition file, or click Browse to select it.

Click Next to continue.
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What to Do After Importing

This chapter includes the following:

= Checking the Status of YOUr IMPOMt SESSION .....c..vvevrrcrrirrceeireisireresi s e ssesssees 109
= Cancelling an IMPOrt OPEIALION .........ccireuriiirirereieirieis et ses sttt s st s 109
# REAAING the IMPOIT LOG ...vuveviireiriiieisieeisi sttt ettt 110
B TEOUBDIESNOOIING ... ceeeectei ettt bbb s bbb bbb bbbt 110

Checking the Status of Your Import Session

If you are importing a large amount of data, the Import wizard may take a while to process the data.
As it processes records, it keeps a running count of records that were imported or rejected. It also
displays messages related to each object that it processes.

When all the data for an import session has been processed, the Import wizard formats the warning
and error messages into a log that you can read onscreen or save to a file.

Cancelling an Import Operation

When you click Import in the Import wizard, the wizard begins to import the data. You can cancel the
import operation at any time.

To cancel a running import operation:
1. From the Import Status page, click Cancel.

2. A message box appears that reads “Cancel running import operation? All unsaved data will be
lost.”

3. Click OK. The Import Summary Report page appears.

When you cancel an import operation, any data that was already imported by the time you clicked
Cancel remains in the database. Also, data is imported in batches, and the Import wizard finishes
importing the current batch before the import operation stops as a result of cancellation. The
Records Processed section of the Import Summary Report page shows how many objects were
accepted.
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Reading the Import Log

When you click Import in the Import wizard, the Import Server starts to process the data. When it
finishes processing the data, it displays a log, which includes the following sections:

= Time Information — Shows the duration of the import session.

@ Records Processed — Shows how many records were imported to the Agile PLM system and
how many were rejected.

o Message Summary — Shows messages generated for each object.

To print the log file:

Right-click the message summary, and choose Print.

To save the import log to an XML file:
1. Onthe Import Summary Report page, click Save Log. The File Download dialog box appears.

2. Select Save This File to Disk. Click OK. Type the filename, or use the default filename:
LogFile.xml. Click Save.

Note LogFile.xml is an XML file, which is not ideal for viewing in most applications. You can use
your own XSL templates to create custom reports from the log file.

To save the import log to an HTML file:

1. Right-click the Import Summary Report page, and choose View Source. The HTML source for
the page appears in Notepad.

2. Choose File > Save As to save the HTML file.

3. To return to the Web Client or Java Client, Click Done.

Troubleshooting
If you have problems importing data into the Agile PLM system, read this section for help.
Common Error Messages

The following table provides additional information about common error messages you may
encounter when you try to import data into the Agile PLM system.
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Problem Error Message Cause
Area

General Could not import record because key fields within the This error can occur for a couple reasons:
import data are blank. L )

o The mapping file is wrong. Key fields
must be mapped.

o The source file is tab delimited, but the
Import wizard field delimiter is set to
comma.

General Could not convert value 'text' into the appropriate You tried to import a text value into a numeric field.
datatype (java.lang.Double).

Text values [Character Set Name(s)] character sets are valid for A text value you are trying to import contains one or
[AttributeName] field. more characters that are invalid for the field's

character set(s).

Date values Could not convert value '12.10.2003" into the The format for date values in your source file does
appropriate datatype (java.util.Date). not match the preferred date format specified in the

user's profile.

Numeric Datatype mismatch while performing Scale validation on | You tried to import a row with a blank value in a

values value ". Expected datatype was java.lang.Number; Numeric field.
actual datatype was java.lang.String.

Money values Could not convert value into the appropriate datatype You tried to import a row with a blank value in a
(Money). Money field.

Excel files An error occurred: The selected file is not a valid The message refers to delimited text files because
Delimited Text File. A valid DTF must contain exactly the Import wizard converts Excel files into delimited
one header row and at least one data row. text files before importing data. The first row in the

selected Excel source file cannot be blank. Make
sure you specify the correct location of the header
row.

Mapping The markup in the document preceding the root This error appears if you select a mapping file that is
element must be well-formed. not properly formed XML (such as a delimited text

file). You must select a mapping file previously
saved by the Import wizard.

Supplier Continent|country|region is invalid. You selected an invalid geographical location

represented by the combination of Continent,
Country, and Region values.

Supplier Offerings you are trying to create are already covered You cannot import a new supplier offering for a Ship
by a broader Manufacturer offering. To location that is already covered by a broader

offering.

Mapping Object properties are mapped, but the key is not fully Some objects, like price, supplier, and customer,
mapped. have several key fields that must be mapped. The

current mapping does not map all required key
fields.

Price Lines Effective From Date cannot be greater than the You tried to import price lines with an effective from

Effective To Date.

date greater than the effective to date.
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Problem Error Message Cause
Area
Price Lines [Price Line] is a duplicate price line and cannot be The Allow Qty Breaks field for the Price object has
processed when quantity break is disallowed on the been set to No. Therefore, only one price line can
price object. be imported for each set of different Ship To, Ship
From, Effective To, and Effective From values.

Importing Blank Fields

When you use the Import wizard, it cannot perform a destructive operation. Existing Agile data is
always preserved, never destroyed. Therefore, you can't import a blank value to a non-empty Agile
field. The Import wizard ignores blank source fields.

Note A transformation can be applied to source data to change blank values into nonblank
values.

Mapping All Required Fields

To import data for an object, you must always map all required fields, even if you are importing data
to an existing object. This includes required fields on Page Two and Page Three. If you are trying to
update a BOM table for an item, you may not want to update required fields that have already been
entered on Page Two and Page Three. In such a case, you can map the Page Two and Page Three
required fields to blank columns in your source data. As mentioned above, the Import wizard
ignores blank source fields.

Configuring Parent/Child Fields

Several fields have a child relationship with other parent fields. Child fields derive their values from
parent fields. The administrator of the Agile PLM system must ensure that parent/child fields are
configured identically for the system to work properly.

An item’s Title Block.Rev field and a change order’s Affected Item.New Rev field are perfect examples of
parent-child fields. The Agile PLM administrator must ensure that both these fields are configured
identically. Otherwise, problems could occur when you import data. For example, if you set the Title
Block.Rev field to include all characters, you cannot set the Affected Items.New Rev field to include only
“Alpha Upper Case” characters. Otherwise, problems will occur when you import items in Redline
mode.

Another example of parent/child fields are the Title Block.Number field for an item and the Affected
Items.ltem Number field for a change. If these fields are configured differently, you may experience
problems importing items.
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Importing Supplier Offerings

When you import supplier offerings, the Import wizard determines if a rating exists based on either
the Ship-To location or the geographical values. It does this by checking the status of the supplier
before importing the source file. If the source file has conflicting offerings, you may see unexpected
results. Here's an example:

Suppose an existing supplier named ACME has no commaodity offerings. On the Agile PLM server,
the defined Ship-To locations include San Jose and Milpitas. Let's say you attempt to import a
source file with two offerings:

E | F [ 6 [ H [ 1 | J |
Commodity Continent Country/Area Region  Ship-To Rating
CPU Morth America United States | California Appraved
CPU man Jose | Offered Active

The Import wizard creates the first offering based on its geographical values. The second offering is
rejected because the Ship-To location San Jose is covered by the first offering’s region, California.
Remember, you cannot create an offering with a location already covered by a broader offering.
The end result is that one broad offering and two ratings are created. The ratings for San Jose and
Milpitas, which are located in the California region defined by the offering, both have a value of
“Approved.”

Workaround: To import different ratings for offerings located in the same geographical region, import
the offerings and their ratings in two separate import operations.

Managing SmartRules

The Agile PLM server checks for SmartRule violations after each row of a table is updated, not after
the entire table is updated. This can cause problems if you are importing BOM, Manufacturers, or
Price Lines tables in Redline mode and have set the Multi Row Update Mode preference to “Complete
Replace.” In such situations, you want to update the entire table before validating it.

Workaround: To avoid SmartRule problems in import, the Agile PLM administrator should use the
Agile Java Client to set the following SmartRules from “Disallow” to “Warning”:

o DuplicateFindNumbers

o DuplicateltemNumbers

o DuplicateRefDes

o MultipleltemsPerManufPart

= Qverlap Price Line Effectivity Periods

In the Import wizard, set the Smart Rules Warning Violation Behavior preference to “Accept
Objects.” That setting allows you to import objects that would otherwise trigger a SmartRules
warning.
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Updating Pending or Released Items and Prices

If you are importing pending or released items and prices in Authoring mode (instead of Redline
mode), don't specify a change order (ECO or PCO) if you are importing only items or prices AND
you are not updating any fields related to change control. If you are updating any fields related to
change control, such as Title Block.Lifecycle Phase, you must specify a change order to import the
object.

How Import Handles Duplicate Records

For performance reasons, the Import wizard groups records into batches of 100 that it sends to the
server for processing. When the server finishes processing a batch, the client sends the next batch
of 100 records to the server. The Import wizard does not reject duplicate records, whether they are
contained within one batch or in different batches. If a duplicate record is encountered within the
same batch, it is combined with the earlier matching record and counted as only one object. If a
duplicate record is encountered in two different batches, the count of imported records is
incremented by one.
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Exporting Data
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= Exporting PLM Objects

The Export Wizard

Agile PLM provides a simple Export wizard that lets you extract data from selected objects and
export it to a Microsoft Excel file, a comma-delimited (CSV) text file, or a PDX package. You can
launch the Export wizard from either the Agile Web Client or the Java Client. Exporting data is an
easy process. After downloading the export file to your desktop, you can either email or FTP it to a
supply chain partner or import it into another application.

Note PDX packages can be viewed or imported only with PDX-enabled applications. Agile
provides a free PDX viewer called Agile eXpress.

What is New in Exporting Data for 9.2.2.5?

No new features or enhancements were implemented in the Export component in this release. The
only changes made were new Part and Release numbers and the publication date.
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Export Roles and Privileges

To use the Export wizard, you must have the Export privilege. The Export privilege is included with

the following supported roles:

o (Restricted) Material Provider

@ Change Analyst

= Compliance Manager
@ Content Manager

o [tem Content Manager
@ Price Administrator

@ Price Manager

o Product Content Read Only

= Souring Administrator

Object Classes that You Can Export

The following table lists the types of objects that the Export wizard allows you to export.

I BaseClass I Class I

Items

Parts

Documents

Manufacturers

Manufacturers

Manufacturer Parts

Manufacturer Parts

Prices

Historical Quotes

Published Prices

Changes

Change Orders (ECOs)

Change Requests (ECRs)

Deviations

Manufacturer Orders (MCOs)

Price Change Orders (PCOs)

Site Change Orders (SCOs)

Stop Ships

Declarations

Homogeneous Material Declarations

Part Declarations
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IPC 1752-1 Declarations*

IPC 1752-2 Declarations*

JGPSSI Declarations*

Substance Declarations

Supplier Declarations of Conformance

Discussions Discussions
Part Groups Commodities
Part Families
Programs Activities (only for Root Programs)

Program Service Requests

Non-Conformance Reports

Problem Reports

Quality Change Requests

Audits

Corrective and Preventive Actions

Specifications Specifications

Substances Materials
Subparts
Substance Groups
substances

Suppliers suppliers

Users Users

Users Groups

Users Groups

* This Declaration class provides special export and import commands that enable suppliers to
integrate data with other Agile PLM systems, or complete the compliance request form in other

clients, such as Microsoft Excel or Adobe Reader. See Using Special Export and Import

Commands to Complete Declarations on page 71.

Export File Formats

You can export Agile PLM data to Microsoft Excel, comma-delimited text, PDX Package, or aXML
Package formats. The following table lists the objects that can be exported for each format.

Object Excel/CS PDX axXML
\Y
ltems Yes Yes Yes
Manufacturers Yes Yes Yes
Manufacturer Parts Yes Yes Yes
Changes Yes Yes Yes
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Object Excel/CS PDX axXML
\Y

Prices Yes Yes
Declarations Yes Yes
Part Groups Yes Yes
Specifications Yes Yes
Substances Yes Yes
Programs Yes

Program Service Requests Yes Yes
Quality Change Requests Yes Yes
Suppliers Yes Yes
Discussions Yes Yes
Users Yes Yes
User Groups Yes Yes

In addition to text data, the PDX and aXML Packages can also contain attachment files and
redlines.

Note CSV files created by the Export wizard contain additional header information that cannot
be imported using the Agile PLM Import wizard. To import data from these files into Agile
PLM, make sure you set the header row correctly in the Import wizard’s Delimited Text
File Configuration dialog box.

Guidelines for Exporting to Microsoft Excel Files and
Text Files

When you export data to a Microsoft Excel file, you end up with a single worksheet. When you
export data to a text (CSV) file, you end up with a file of comma-delimited data. Both file types can
be opened in Microsoft Excel to see the data in cell format.

Keep these guidelines in mind as you export data to Microsoft Excel files and text files using the
Web Client:

= You can export a single object or multiple objects. Each object tab is a separate delimited text
output, placed one after the other in the text file. If you export multiple objects, they are added
to the export file one after the other.

o You can export only the information that appears on the tabs of the included objects. So, for
example, if you export a single part with a BOM, the resulting file includes information on the
part's BOM tab, but it does not include actual BOM items.

o You cannot add the following objects:
® deleted objects
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* objects for which you do not have the necessary privileges
® objects that are already in the export file

B You can export Attachments tab information to a text file, but you cannot export the actual
attachments. Only PDX and aXML files support actual attachments.

= You can export the Sites tabs of items and the Where Used tab of items, manufacturers, and
manufacturer parts.

@ If you select the Manufacturers Tab when filtering items, and you select a number of levels to be
exported with the BOM, your export file will include the AML information for the selected
number of levels of the BOM.

o If you include both BOM and AML data in your export file, the AML data is interlaced with the
BOM data in the resulting file.

@ Regardless of its position in a BOM hierarchy, you can export an Item in Level Template format
as shown below.

a. InWeb Client, select an Item, for example a part.
b. Select Actions>Microsoft Excel> Export to Excel (or Download Template).

The Excel file containing Title Block, BOM, and Manufacturers Tab data is exported.

About aXML and PDX Packages

Agile Extensible Markup Language (aXML) format is an XML representation of Agile PLM’s
business schema. aXML contains all product content managed in Agile PLM. When the transfer
order is published, a .ZIP file containing the aXML file and any attachments is created.

Product Data Exchange (PDX) packages contain product content, such as item or change details,
plus BOM data, manufacturer information, drawings, and other attached files. They differ from Agile
package objects in that they are XML-based documents that conform to the PDX 1.0 standard. PDX
packages are based on an industry-standard format for encoding structured data in an XML format.
This standard provides an application-independent way to describe product content.

You can use aXML and PDX packages to send data from one Agile system to another. In addition,
you can download them to your desktops, email or FTP these packages. For PDX packages, you
can import them into a PDX-enabled application, such as Agile eXpress.

For more information about PDX, including a link to the DTD, see following Web page:
http://webstds.ipc.org/2571/2571.htm

The information in each aXML or PDX package is secure because the data that flows between the
user, the Web Client, and Agile servers is encrypted (where legal), and supply chain partners
cannot view the contents of each other’s packages. Login, Discovery, and Read privileges can be
set in Agile Administrator to protect partners' information from access by unauthorized users.

Note In the Web Client, you can create, but you can’t view aXML or PDX packages.
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Guidelines for Exporting to aXML and PDX Packages

Use these guidelines when you export data to aXML or PDX packages using the Web Client:
= You must have the Export privilege to export data to PDX packages.

= You cannot add deleted objects, objects for which you don't have appropriate privileges, or
objects that are already added to the Objects To Extract table.

= The Web Client supports direct access to latest released revisions of items. It also lets you
access back revisions or pending revisions.

o If you export Change objects, you can use a custom filter to export redline changes to BOMs
and AMLs of affected items. See Exporting Redline BOMs and AMLs for Affected Items on
page 125.

= PDX packages include Sites and Where Used tab information, but they are exported as additional
attributes, without their own element tags like <sites> or <whereUsed>.

= If you choose PDX export, the Compliance tab of items and manufacturer parts is not exported.
This is only applicable to PDX packages.

o Agile eXpress does not support the Sites tab of items or the Where Used tab of items,
manufacturers, or manufacturer parts. This is only applicable to PDX packages.

Starting the Export Wizard

You can start the Export wizard from either the Web Client or Java Client using one of the following
methods:

Java Client

= Open an object to export, and then choose Tools > Export.
Web Client

= Choose Tools > Export.

= Open an object to export, and then choose Actions > Export.

@ Search for objects that can be exported, select one or more objects on the Search Results
page, and then choose Tools > Export.

Note Although you can select any object from search results, the Export Wizard does not
support all object types.
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Export Wizard Steps

This section describes all Export wizard steps, although most are optional. You can choose to
download the export file at any step without completing the remaining steps.

To export data to a file:

1. Start the Export wizard. See Starting the Export Wizard on page 120 above.

The Objects to Extract page appears. If you started the Export wizard from Actions > Export or
after selecting objects in search results, some objects are already listed on this page.

2. Inthe Export To field, use the drop-down list to specify whether you want to export to a PDX
package, or an aXML, Excel, or a text (CSV) file.

3. Inthe Site field, select a site. To export data for all sites, select All.

Note The Site field is only available if your Agile system includes the Sites server
license.

4. If you don’'t need to add any more objects to the list, proceed to step 6. To add more objects,
click Add.

The Add Objects dialog appears.
Search to find appropriate objects.
Click Finish to add the objects to the export file.

Adjust values in Revision column, if necessary.

© N o u

When you have found and added all objects to include in the export file, click Next to display the
Select Filters page.

9. Filters let you specify which information is added to the export file. For details about filters, see
Specifying Filters on page 122.

* To use predefined filters, select Saved Filters and then select the filters you want to use
from the drop-down lists. To see the details of the filters, click H

* To define a custom filter for this operation, select Customize; the wizard will step you
through filter definitions for each object type in the file.

10. Click Next to proceed from the Select Filters step.

11. If you selected Customize, on each Filter page, select the information to include in the file, and
click Next to proceed to the Define Header page.

12. Enter the file type and description, and then click Next (If you are exporting to a text file, header
information appears at the top of the file.). The Summary page appears.

13. Review the contents of the export file.

14. When everything is complete, click Export to compile and download the export file. If you are
exporting to a text file, the encoding type of the exported file is set according to your current
user login profile setting. You can use Web Client or Java Client to view or modify currency
settings.

* In Web Client, click Settings > User Profile > Preferences > Edit.
* InJava Client, click Settings > Current User > Preferences.
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15. Click Close to close the File Download window.

Note When exporting objects in aXML format, either from the object's actions menu
or global export, you can save exported files with the .axml.zip extension. To
save them without the .axml.zip extension, change the Save As Type option to
All Files in the Save As dialog, and then click Save. This will save the file in the
.aXML format.

16. Click Exit to close the Export wizard.

Specifying Filters

Filters let you specify which information is added to the export file. You can use saved filters,
defined by your Agile administrator, or you can create custom filters.

Using Saved Filters

When you select Saved Filters in the Select Filters step of the Export wizard, you can select from lists
of defined filters for all supported object types. These filters are defined by the Agile administrator
using the Agile Java Client. For more information, refer to the “Agile Content Service Settings”
chapter in the Agile PLM Administrator Guide.

To see the details about the selected filter, click the corresponding H button. If you select the
Saved Filters option, but you do not select filters to use, the Export wizard uses the default
customized filters. See Default Custom Filters on page 123 for information.

For items and changes, only filters for the superclasses (Item and Change) are included in the
Export filter lists. Any filters defined specifically for classes—for example, part, document, ECO, and
MCO—are not included in the Export filter lists. This means that, for example, if your export file
includes an ECO and an ECR, the Change filter selected applies to both of the objects. Likewise, if
your export file includes a part and a document, the Item filter selected applies to both of the
objects.

BOM Filters

When you choose to include BOM information in the export file, you must specify the level of BOM
information to include from the following options:

o Tab Only (saved filters, set by the Administrator) or BOM Tab (custom filters) — For all formats, it
includes the information in the BOM tab itself, with only references to the items on the BOM tab
(first level only). If this BOM option is the only one selected, the BOM items themselves are not
included.

o Taband Iltems

* Taband Items, All Levels (saved filters, set by the Administrator) or BOM Items, All Levels
(custom filters) — For PDX and aXML formats, includes all items in all levels of the BOM.
For CSV format, includes references to the items on all levels of the BOM tab, but does not
include the items themselves.
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* Taband Iltems, BOM Level (saved filters, set by the Administrator) or BOM Items, BOM Level
(custom filters) — For PDX and aXML formats, includes the items on the specified level (1,
2, ..., last) of the BOM. Does not include child components of subassemblies. For CSV
format, includes references to the items on the specified level of the BOM tab, but does not
include the items themselves.

Creating Custom Filters

Custom filters let you specify the particular tabs to export for each type of object you've selected.

To create a custom filter:
1. Onthe Filters page of the Export wizard, click Customize.
2. Click Next.

3. Subsequent wizard pages appear for each type of object selected. For each type of object,
click the checkboxes for information to include in the export file, and then click Next.

Note To use the default custom filters, click Next on each filter page.

Default Custom Filters

The default custom filters are the same as those that are used if you choose Customize and then
proceed through each filter step without changing the settings.

If you create an export file without specifying the content filters to use, the Export wizard follows
these guidelines:

= If you download the export file in step 1 of the wizard, the content to be exported is filtered
according to default custom filters.

@ If you download the export file in step 2 of the wizard, content is filtered according to the
selection made in that step. In this case, if you select Customize, but you don’t then proceed
through the steps that define those filters, Export uses the default custom filters. If you select
Saved Filters, but you do not select filters to use, the Export wizard uses the default custom
filters.

If you use the default custom filters, the export file contains the following information:

= |tems — Title Block tab, Page Two, Page Three, BOM tab (and all levels of BOM items),
Manufacturers tab (and manufacturer parts on that tab if the export file is a PDX package), Item
Prices, Sites tab (if the export file is a text file), and Attachments tab (and attached files, if the
export file is a PDX file).

o Manufacturer parts — General Info tab (and the manufacturer on that tab, if the export file is a
PDX package), Page Two, Page Three, Attachments tab (and attached files, if the export file is
a PDX file)

= Manufacturers — General Info tab, Page Two, Page Three, Attachments tab (and attached files, if
the export file is a PDX file)

@ Changes — Cover Page tab, Page Two, Page Three, Affected Items tab (and the items on that
tab, if the export file is a PDX file), Attachments tab (and attached files, if the export file is a
PDX file)

= Prices — General Info tab, Page Two, Page Three, Price Lines, Attachments tab
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o Substance — General Info tab, Page Two, Page Three, Composition, Attachments tab

= Declaration — Cover Page tab, Items, Page Two, Page Three, Item Bill of Substances,
Manufacturer Parts, Manufacturer Part Bill of Substances, Part Groups, Part Group Bill of
Substances, Compliance, Attachments tab

o Specifications — General Info tab, Page Two, Page Three, Substances, Attachments tab

= Part Groups — General Info tab, Page Two, Page Three, Parts, Compliance, Suppliers,
Attachments tab

= Program — General Info tab, Dependencies Dependent Upon, Team, Dependencies Required
For, Discussion, Action Items, Page Two, Schedule, Page Three

= Product Service Requests — General

o Quality Change Requests — General

o Discussions — Discussion, Page Two, Page Three

@ Users — General Info tab, Page Two, Preferences, User Group

o User Groups — General Info tab, Page Two, Users, Page Three

Specifying Filters When Exporting Attachments

For aXML and PDX, when the Attachment tab is included in the selected tabs list, the Attachments
Options selection is enabled and you can select Tab Only or Tab and Files. If you select Tab and Files,
you can provide a comma-separated list of file extensions to be included in the export output file.
Filtering exports by file type gives you the option to exclude certain files such as CAD diagrams
when exporting BOM type data to your suppliers.

Exporting PLM Objects

The following paragraphs document exporting the respective supported file formats for these
objects.

Exporting PSR, QCR, and Supplier Objects

Once you have selected the object type, the procedures and options to export the selected PLM
object are essentially the same. The supported tables and components are:

= Product Service Requests — Cover Page/Page 1, Page Two, Page Three, Affected Items,
Related PSR, Relationships, Attachments, and History. Supported file formats are: CSV/Excel
and aXML.

@ Quality Change Requests — Cover Page/Page 1, Page Two, Page Three, Affected Items,
Relationships, Attachments, and History. Supported file formats are: CSV/Excel and aXML

@ Suppliers — General Information, Page Two, Page Three, Contact Users, RFX Routing,
Manufacturers, Commodities, PSRs, Relationships, Attachments, and History. Supported
formats are: CSV/Excel and aXML
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To export PSR, QCR, or Supplier objects:

Choose and open the target object (PSR, OCR, or Supplier).

Choose Actions > Export for the target object.

In Objects to Export, select the applicable file type from Export to (aXML, Text (CSV), or Excel) > Next.
In Filters, select the applicable filter. Click Next.

In Define header, specify Type and provide the applicable description. This is optional.

o g &M w DN E

Click Next. to view the Summary report, or Export to complete the process.

Exporting Redline BOMs and AMLs for Affected ltems

If you choose the PDX or aXML export formats, an additional filtering option called Redline Changes
Only is available when you export Change objects: This option indicates that only changed BOM
elements should be included in the redline section of the affected items of the changes. Unchanged
elements will not be included. The exported PDX or aXML file could then be used to communicate
BOM and AML changes to supply chain partners.

This feature is targeted for ERP adaptors that are designed to process deltas. Agile Content Service
(ACS) can be used to send the exported PDX or aXML file to an ERP adaptor.

To export redline BOMs and AMLs:

1. Open a Change object (such as an ECO).
Choose Actions > Export.

Choose PDX as the export format. Click Next.

On the Filters page of the Export wizard, Click Customize. Click Next.

a > N

On the Filter Changes page, make sure both the Affected Items Tab > Affected Items and the
Redline Changes Only boxes are checked.

Note If you check the Redline Changes Only box without checking the Affected Items
box, affected items and redline tables are not exported.

6. Click Next to set additional settings.

Click Export.to set complete the process.

Exporting Relationship Tables of Objects

You can export relationship tables containing Item, Change, Manufacturer, Manufacturer Part, and
Part Group objects as CSV/Excel or aXML files. For the aXML file format, there are two additional
tags ControlObjStatus and EffectObjStatus to represent the relationship rule. The exported aXML files
can be imported back into the same or another system.

For information on Relationship tables, refer to Getting Started with Agile PLM. For procedures, see
Export Wizard Steps on page 120.
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Exporting Multiple Revisions of the Same ltem

Export will output multiple revisions of the same item in the order of their respective revision release
dates. Pending revisions will appear first in the output file. They are followed by the released
revisions from earlier releases to the most recent.

Specifying a Header

On the Define Header page of the Export wizard, you can specify optional header information that
describes the export file. Enter values in the Type and Description fields. The Creator field is filled
automatically with your name.

Downloading the File

You can choose to download the export file at any step of the Export wizard without completing the
remaining steps. If you didn’t specify filtering information before downloading the export file, see
Default Custom Filters on page 123 for information on the default filters that are used.

To download the export file:
1. Inthe Export wizard, click Export.

2. If you are downloading a PDX package, skip to step 4. Otherwise, select an Encoding Type for
the text file. The default encoding type is Unicode (UTF-8).

w

Click Continue. The File Download window appears.

E

Click Save to save the file to your computer.

Viewing an Exported File

If you export a text file, you can view it in a spreadsheet program, like Microsoft Excel, or in any text
editor. If you export a PDX package, you can view it using Agile eXpress or another PDX-enabled
application.

You can download the free Agile eXpress viewer from the following Web site:
http://www.myagile.com/eservices/express/
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Overview

FileLoad is a utility that helps load legacy attachment files directly from a source system into the
Agile File Manager where they are attached to the appropriate Agile PLM objects. Files can be
attached to most Agile PLM objects.

FileLoad is activated by choosing Tools > FileLoad from the menu bar of either the Java Client or
Web Client.

Files can be attached to the following Agile PLM object types:

Solution Object Types
All Agile PLM Solutions File Folder
Product Portfolio Management ltem
Change
Manufacturer

Manufacturer Part

Product Governance & Compliance Declaration

Part Group

Specification

Substance

Product Cost Management Price

Request for Quote

RFQ Response

Sourcing Project
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Solution Object Types

Supplier

Product Portfolio Management Program
Product Quality Management Product Service Request
Quality Change Request

FileLoad uses an attachment Index file that you prepare to identify the files to be loaded as
attachments, and to identify the Agile PLM objects to which they will be connected. FileLoad places
the attached files into the Agile File Manager vault and then updates the Agile PLM database.

Note Once legacy files have been loaded into your Agile PLM system, they may be attached to

Agile PLM objects “as is,” and they may also be recast (using the Save As command) as
new objects in the File Folders class.

Choosing a FileLoad Client

Both the Web Client and Java Client have FileLoad utilities. Although they are very similar, they
perform differently and offer slightly different options.

Feature Java Client Web Client

Loads files Yes Yes

Loads references to URLs (Web Yes Yes
locations)

Loads references to files in a Yes
Custom (read-only) file vault
(INPLACE attachments)

Supports files up to 40 Gb in size yes yes

Supports multiple dedicated Yes
threads

Supports uploading files remotely Yes yes

Locates files on the local machine yes
(unless a network location is
specified)

Locates files on the Web proxy Yes
server (unless a network location is
specified)

Page - 128 Agile Product Lifecycle Management



Chapter 12

Feature Java Client Web Client
Can load data into attachment flex Yes Yes
fields
Can load multiple files into one file Yes Yes
folder
Can attach files to the latest Yes Yes

revision when the specified
revision cannot be found

Can attach files to incorporated Yes Yes
items

Generates log files in the location Yes
you specify

Generates log files on the server. Yes
You can download them to your
local machine.

Performance

Although FileLoad performs faster in the Java Client, performance varies depending on the capacity
of the client and server computers. If the client and server computers are multiprocessor machines,
you can naotice a significant improvement in FileLoad performance when you use the Java Client.

How FileLoad Locates Files

Unless you specify a network location for files, the Java Client FileLoad utility locates files on the
local machine, whereas the Web Client FileLoad utility locates files on the Web proxy server (which
can be on the same computer as the application server).

The FileLoad utility in both Agile PLM clients can access files remotely through a network path. For
more information, see Uploading Files Remotely on page 131.

Loading References to Files

The FileLoad utility in the Agile Java Client supports an additional attachment type, INPLACE. You
can use the INPLACE attachment type value to upload a reference to a file located in a Custom file
vault. The reference to the file is stored in the Agile PLM database, but the actual physical file
resides in the Custom vault. The Custom vault is read-only. Files stored in a Custom vault can be
checked out, but when they are checked back in, they are copied to the Primary Read/ Write
location of the vault. Before trying to load references to files, make sure the Custom vault is set up.
See Setting Up a Custom File Vault on page 131.

Note The Agile Web Client FileLoad utility does not support the INPLACE attachment type.
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FileLoad Options

The FileLoad user interface varies slightly depending on the Agile PLM client you use. For a
complete list of FileLoad options, see the table in Processing Attachments on page 139.

Before You Begin

Before you begin using FileLoad, make sure you have set up your environment correctly and have
proper privileges described in this section.

File Size and Batch Limits

FileLoad can handle files up to 40 Gb in size. It can also process many files in one batch. Agile
recommends not exceeding 15,000 files per processing batch.

Disabling Synchronous Full-Text Indexing

Before using FileLoad, turn off synchronous full-text indexing of files. When synchronous full-text
indexing is enabled, FileLoad does not report progress, the browser times out on long uploads, and
file-loading is extremely slow. After you finish using FileLoad, you can turn on synchronous full-text
indexing of files again.

To disable synchronous full-text indexing:

1. Start Agile Java Client and log in as an administrator.
2. Click the Admin tab.

3. Choose Settings > System Settings > Full Text Search.

The Full Text Search window appears.

4. Click the Indexing list and select Manual or Scheduled.

5. If you chose Scheduled, click the Recurrence field and schedule indexing to start after file-loading
will be finished.

6. Click Save.

For more information about how to change full-text indexing settings for Agile PLM, see the Agile
PLM Administrator Guide.

Turning Off Antivirus Software

If you use an antivirus tool, turn it off before using FileLoad. An antivirus tool will scan every new
uploaded file, which will slow down the loading process.
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Required Agile PLM Privileges

To use FileLoad to load file attachments to Agile PLM objects, you must have the same privileges
as you would need to modify those objects in Agile PLM clients. In other words, you must have the
Modify privilege for any object to which you are attaching a file.

In addition, you must also have the necessary FileLoad privilege.

To change your Agile PLM roles and privileges, see your Agile PLM administrator.

Uploading Files from Local Drives

Agile recommends that you upload files from a local drive. Otherwise, there is a risk that network-
stored files, especially if they are very large, may cause FileLoad to quit, leaving the loading
process only partially completed.

Uploading Files Remotely

Although Agile recommends uploading files from a local drive, you can also upload files remotely.
Before trying to upload files from a remote computer, make sure:

8 There is a shared folder in which to save attached files.

o If you are using the Agile Web Client, the operating system user that runs the Agile Application
Server (such as System for Windows or Root for Solaris) must have Read access to the
referenced file.

= If you are using the Agile Java Client, the operating system user logged into the client computer
must have Read access to the referenced file.

@ The network path is included in the Index files. For example:
ITEM, P00001,, \\computer\sharedfolder\file.txt,FILE,description

If these criteria are not met, you will see the following error message when you try to upload files
remotely:
“Cannot find the file to be attached.”

Setting Up a Custom File Vault

If you are using the Agile Java Client to upload references to files stored in a Custom file vault, the
Agile PLM administrator must set up the vault first. For more information about administering Agile
File Manager, see the Agile PLM Administrator Guide.

To set up a Custom file vault:

1. Start the Agile Java Client and log in as an administrator.

Click the Admin tab.

Choose Server Settings > Locations. The Server Location window appears.

Click the File Manager tab to bring it forward.

o > WD

Double-click the entry to display the File Manager dialog box.
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Click the L button to add a new vault.

6.

7. Inthe Vault Type field, select Custom.

8. In the Description field, type a description of the vault.

9. Inthe Base Storage Directory field, enter the primary location where the files are stored. There
can be other subdirectories containing files located beneath this directory.

10. Click OK.

11. Restart the Agile File Manager.

Important If you don’t restart the Agile File Manager after setting up the Custom vault, the
FileLoad utility won't be able to find the vault.

Process Qutline

The FileLoad process follows the steps listed below. Each step is discussed in detail in the sections
that follow next.

u]

Stage 1: Prepare the Index File (see Preparing the Index File on page 133 ) — Prepare an
attachment Index file.

Stage 2: Process Attachments (see Processing Attachments on page 139) — Use FileLoad and the
Index file to process the attachments.

Stage 3: Evaluate the Results (see Evaluating the Results) — Evaluate the results. If any
attachments were rejected, open the FileLoad log file and view the error messages.

Stage 4: Revise and Reload Rejected Attachments (see Revise and Reload Rejected Attachments
"Revising and Reloading Rejected Attachments" on page 143) — Revise the rejected
attachment rows in the “Bad” file. Save the Bad file as a new Index file, and load it.

Repeat Stages 3 and 4 until all attachments are loaded successfully.
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The following illustration summarizes the FileLoad process.

Prepare Index File

l

Use FileLoad to
load attachments

Save the Bad file as a new Index file >

T

Revise rejected rows in the Bad file
based on the error messages in the Log file

~

v T Yes
\
Examine the

FileLoad Summary

Were any attachments

rejected?
l No

Done

v

Important It is recommended that no more than 200-300 items be loaded against one change. If a
larger number of affected items are loaded against a change, FileLoad will take much
longer to load the files and it will take much longer to bring up revisions of any item on that
change.

Preparing the Index File

The first stage in batch-loading attachments with FileLoad is to prepare an attachment Index file.
The Index file is a text file in which each row describes one file to be loaded as an Agile PLM
attachment.

Each row that is updated must have at least six entries separated by delimiters, such as commas.
To support uploading information to flex fields, additional attribute-value pairs can be specified.
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Index File Structure

Each row in the Index file must have the following structure:

ObjectType, PrimaryKey, SecondaryKey, Path/Filename, AttachType, Description
[,attribl=valuel,attrib2=value2,...attribn=valuen]<CR>

Where:

ObjectType

PrimaryKey

SecondaryKey

Path/Filename

AttachType

Description

[,attribl=valuel,attrib2=v
alue2,...attribn=valuen]

A keyword identifying the object type.

The value of a primary key field for the specified object type. For most objects, the primary key
is the object number. The object you specify must already exist; FileLoad won't create it.

The value of a secondary key field for the specified object type. If the object doesn’t require a
secondary key, leave the field blank.

A URL or a fully qualified path and filename.
If you specify a URL, make sure it's correct. FileLoad does not validate URLS.

For the INPLACE attachment type (see below), the path you specify should be relative to the
Base Storage Directory of the Custom file vault. For example, if the Base Storage Directory is
d:ffiles, and the file you want to load is located in d:/files/cad/0021c.dwg, enter the following
relative path: cad/0021c.dwg. The Agile File Manager iterates through all vaults (both standard
and custom) until it finds the first matching file.

Note: Although Windows supports pathnames with back slashes (\), Solaris and other Unix
operating systems do not. Consequently, forward slashes are used in path examples in this
chapter.

Enter one of the following case-insensitive values:
@ FILE — Uploads a file to a Standard file vault.

@ URL — Adds a URL attachment to the object. A URL is a Web location,
such as
http://www.agile.com. You can specify non-HTTP URLSs, such as an FTP
site.

= INPLACE — Uploads a reference to a file located in a Custom file vault,
which is read-only.

Note: The INPLACE attachment type is supported only in the Java Client and only if a Custom
vault has been set up by the Agile PLM administrator.

An optional description of the file.

Optional pairs of attribute names and attribute values used to load data into flex fields. The
default separator character for attribute names and values is an equal sign (=), but you can
specify another character. Separate each attribute/value pair with an attribute delimiter, such as
a comma.
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The following is an example of one row of an Index file:

ITEM,P00010,,C:/temp/logo_color.bmp,FILE,Description="Fileload,Test",Date01=12/12/00,List01=Selectl, Text01="
Test_Fileload", Text02=DFSF<CR>

To make sure the line is interpreted correctly, the value for the Description attribute is “Fileload,
Test". Quotes are included around the text containing a comma so that it is not interpreted as an
entry separator.

PrimaryKey and SecondaryKey field content requirements depend on the attachment object type. The
specific requirements for each object type are described in Primary and Secondary Keys on page

136.

Here are some general notes on the Index file structure:

m]

All attachment flex fields must be enabled (made visible) from the Admin tab of the Java Client.
Flex fields that are used in the Index file but are not enabled will cause FileLoad to report an
error.

Note You cannot access administrative functions unless you have been assigned
the Administrator privilege; please see your Agile PLM administrator for
assistance.

Each field must be separated by a delimiter character, such as a comma. The same delimiter
character must be used throughout the Index file. The delimiter used in the index file must
match the Attribute Delimiter that you select in the FileLoad utility. For more information about
delimiter options, see the table under Processing Attachments on page 139.

The flex field attributes and values must be separated by a different delimiter from the delimiter
used for the rest of the Index row.

Doubled delimiters identify a blank field. In comma-delimited files, a blank field is specified by
two commas, with no space between them, like this: ,,

Each row must always have a minimum of six delimited fields.
Each attachment row must end with a carriage return.

Short Index files of 100 to 200 lines can help you monitor what is going on and correct any
problems more easily.

Agile PLM does not change the incorporation date on the target object.

To accommodate temporary files, FileLoad requires twice as much disk space as the size of
the attachments being loaded by each Index file. If you do not have room to load all
attachments at once, try using more Index files with smaller total attachment sizes to reduce
the space required for each one. The temporary files are automatically deleted after the loading
process is done.

Successful attachments are logged in the History tab for the object.

Maximum number of characters allowed:

* Filename — 255 characters or the number of characters specified for the MaxLength
property of the File Folders > Files > File Name field, whichever is less.

* Description field — 100 characters or the number of characters specified for the MaxLength
property of the File Folders > Files > File Description field, whichever is less.
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Object Type Keywords

The following table lists object type keywords for each base class that FileLoad supports. Use these
keywords in the ObjectType field of your Index file.

Object Type Keyword
Change CHANGE
Declaration DECLARATION
File Folder FILEFOLDER
[tem ITEM
Manufacturer MFR
Manufacturer Part MFR_PART
Part Group COMMODITY
Price PRICE
Product Service Request PSR
Program ACTIVITY
Quality Change Request QCR
Requests for Quote RFQ
RFQ Response RESPONSE
Sourcing Project PROJECT
Specification SPECIFICATION
Substance SUBSTANCE
Supplier SUPPLIER

Primary and Secondary Keys

The following table lists the primary and secondary keys required for each object type that FileLoad
supports. If a secondary key is not required for an object, you may leave that field blank in the index

file.
Object Type Primary key Secondary key
Change Change number [blank]
Declaration Declaration number [blank]
(equivalent to the Cover Page > Name field)
File Folder File Folder number [blank]
ltem ltem number Revision (optional)

See “ltem Revisions” below.
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Object Type

Primary key

Secondary key

Manufacturer Manufacturer name [blank]
Manufacturer Part Manufacturer Part number Manufacturer name
Part Group Part group number [blank]

Price Price number [blank]

Product Service Request Product Service Request number [blank]

Program Program number [blank]

Quality Change Request Quality Change Request number [blank]

Request for Quote Request for Quote number [blank]

RFQ Response Request for Quote number Supplier number
Sourcing Project Project number [blank]
Specification Specification number [blank]
Substance Substance number [blank]

Supplier Supplier number [blank]

Item Revisions

If you are loading files for Items, you can specify an optional revision identifier in the SecondaryKey
field. Use a valid revision identifier. For example, your company may use letters to identify revisions,
such as A, B, C, and D. The following example loads a file for revision A:

ITEM,P00561,A,D:/dwg/00561a.dwg,FILE, Torque Widget
Important Do not specify the “?” in the revision filed. The FileLoad utility will fail if used.

To specify an Introductory revision (one that is newly created and unreleased), leave the
SecondaryKey field blank, as in the following example:

ITEM,P00545,,D:/dwg/00545.dwg,FILE,Battery Cover
To specify a pending revision (one for which the change order has not yet been released), enclose
the revision in parentheses, as in the following example:
ITEM,P00561,(B),D:/dwg/00561b.dwg,FILE, Torque Widget

Note If any revisions have been specified incorrectly in the Index file, the FileLoad utility has an
option named Attach to the latest revision when the specified revision cannot be found to handle

them.
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Sample Index Files

This section shows examples of how the comma-delimited Index files should look. Although these
examples show the use of FILE, INPLACE, and URL attachment types in different Index files, they
can also be used in the same file.

Sample Index File Used to Upload Files

The following rows are from a sample comma-delimited Index file that uses the FILE attachment
type. The object types have been arranged in alphabetical order for readability.

ACTIVITY,PG0278,,D:/myprograms/phasecost.doc, FILE, Phase Cost Report
ITEM, P00545, ,D:/dwg/00545.dwg, FILE, Battery Cover

ITEM, P00561,A,D:/dwg/00561a.dwg, FILE, Torque Widget

ITEM, P00561, (B),D:/dwg/00561b.dwg, FILE, Torque Widget

CHANGE, 25000, ,D:/dwg/00561b.dwg, FILE, Torque Widget

COMMODITY, PG0278, ,D: /groups/guidelines.doc, FILE, Part Group Guidelines
DECLARATION,MD00007, ,D:/docs/DecInstr.doc,FILE, Instructions
FILEFOLDER, FOLDER00042, ,D:/specs/92master.doc,FILE, 9.2 Master Spec
MFR,Manutech, ,D:/dwg/0021c.dwg, FILE, Torgue Widget
MFR_PART,WE10023-45,Manutech,D:/dwg/0021c.dwg, FILE, Torque Widget
PRICE, CONTRACT00001, ,D:/pricing/price sheet.xls, FILE, Price Sheet
PROJECT, PRJ00046, ,D: /projects/dell/resources.xls, FILE, Resource Spreadsheet
PSR, PR00004, ,D:/pr/sn00241.doc, FILE, Support Notes

QCR, CAPA00001, ,D:/capa/details.doc, FILE, Problem Details

RESPONSE, RFQ00001,SUP00067,D:/rfg/notes.doc, FILE, Notes

RFQ,RFQ00001, ,D:/quotes/guidelines.doc, FILE, Price Quote Guidelines
SPECIFICATION, SPEC0023,,D:/specs/rohs.doc,FILE, ROHS Guidelines
SUBSTANCE, SUB0104, ,D:/subs/cas_numbers.doc, FILE, CAS Numbers

SUPPLIER,DISTRIBUTOR00001, ,D:/suppliers/wextronics.doc,FILE, Wextronics
Profile

Sample Index File Used to Upload References to Files

The following rows are from another sample comma-delimited Index file that uses the INPLACE
attachment type.

Important The INPLACE attachment type is supported only if you use the FileLoad utility in the Agile
Java Client and the Agile PLM administrator has set up a Custom (read-only) file vault.
See Setting Up a Custom File Vault on page 131. The Agile Web Client FileLoad utility
does not support INPLACE attachments.

ITEM, P00240,A,dwg/00240a.dwg, INPLACE, CAD Drawing
ITEM, P00262,B, dwg/00262b .dwg, INPLACE, cAD Drawing
ITEM, P00262, (C) ,dwg/00262c.dwg, INPLACE, CAD Drawing
ITEM, P00310,A,dwg/00310a.dwg, INPLACE, CAD Drawing
ITEM, P00337,A,dwg/00337a.dwg, INPLACE, CAD Drawing
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Sample Index File Used to Upload URLs

The following rows are from another sample comma-delimited Index file that uses the URL
attachment type.

FILEFOLDER, FOLDER00010, ,http://www.yourcompany.com, URL, Home Site

FILEFOLDER, FOLDER00010, ,http://www.yourcompany.com/Mfg/,URL, Manufacturing
Services Site

FILEFOLDER, FOLDER00010, ,http://www.google.com, URL, Google
Loading Multiple Files into the Same File Folder

If consecutive rows of the Index file have the same PrimaryKey value (that is, they reference the
same object), FileLoad can either create a separate file folder for each file or put the files in one file
folder. For example, the following rows from an Index file reference the same item, 76-2063:

ITEM,76-2063,D,C:/load/fileload/2063P1.tif, FILE,AMP Specifications
ITEM,76-2063,D,C:/load/fileload/2063P2.tif FILE,

If you unchecked the box named Create a Separate Folder for Each File, the same description will be
used for both files and they will be added to the same file folder. If you check the Create a Separate
Folder for Each File box, then separate file folders will be created for them with separate file
descriptions.

Another way to create separate file folders and separate file descriptions for consecutive rows that
have the same PrimaryKey value is to add a blank row with a carriage return between the rows. This
works regardless whether the Create a Separate Folder for Each File box is checked or unchecked.
However, the consecutive rows that have the same PrimaryKey value must also have the same
attachment type. A FILE and a URL attachment cannot be added to the same file folder

How File Manager Locates INPLACE Files

To locate a file, File Manager iterates through all vaults (both standard and custom) until it finds the
first matching file. If there are files with duplicate filenames in different vaults, it's possible to upload
a reference to the wrong INPLACE file. To uniquely identify an INPLACE file located in a file vault,
make sure its path is unique even if its filename is not.

Note File Manager information is downloaded and cached when the server is started. If you
used the Agile Java Client to add a new custom (read-only) vault, don't forget to restart
the File Manager. Otherwise, File Manager won't be able to find the new vault.

Processing Attachments

After you have created your attachment Index file, you can start FileLoad and process the
attachments.

Caution Be aware that different users may have rights to load files to different file vaults. If you are
supervising the loading of a large number of files with different users (for example, over
day and night shifts), be aware of the influence of the login user on any machine being
used for processing.

Page - 139



Import/Export Guide

To start FileLoad:
12. In either Java Client or Web Client, Choose Tools > FileLoad.
13. Specify the Index file and other FileLoad options. For a list of options, see table below.

14. Click OK (in Java Client) or Start Loading (in Web Client) to begin loading files.

The following table lists and describes FileLoad options.

Option Description

Index File Click Browse to locate and select the attachment Index file. The path and filename of the
attachments Index file appears.

Note: It is recommended that .LOG and .BAD not be used as filename extensions for the
Index file. The extension of the Index file can be anything as long as its content is in ASCII
encoding, but it is helpful to pick an extension that will not be confusing.

Attribute Delimiter Select the delimiter used in the Index file. You can select Tab or select Other and provide
another delimiter in the field. For Other delimiters, only the following characters are allowed:

<space> , | ;' []'<>?"{}~1@#$SN"&*()_+-=

You cannot use any characters that are created by pressing ALT+keypad combinations. Do
not use alphanumeric characters.

Note: Do not use a colon (:), period (.), slash (/) or backslash (\) in the Attribute Delimiter,
Attribute Name-Value Separator, Text Qualifier, and MultiList Delimiter fields, as those
characters can be used in the filename or path.

Attribute Name-Value Separator Select the delimiter used in the flex fields. This delimiter must adhere to the same rules listed
for attribute delimiters, but cannot duplicate the choice for any other delimiter.

Text Qualifier The delimiter used to specify a text string within the Index row. It is recommended that this be
set to quotes, but it can be set to any valid delimiter. This delimiter must adhere to the same
rules listed for attribute delimiters, but cannot duplicate the choice for any other delimiter.

Multilist Delimiter This delimiter is used to separate entries in a multilist field. The default is a semicolon, but it
can be set to any valid delimiter. This delimiter must adhere to the same rules listed for
attribute delimiters, but cannot duplicate the choice for any other delimiter.

Note: The Attachments tab does not have MultiList flex fields, but the Files tab of File Folder
objects does. Consequently, the Multilist Delimiter is used only if you are loading files into File

Folders.
Number of Dedicated Threads Enter a value from 1 to 100 to specify the number of threads dedicated to the FileLoad
(Java Client) process. Increasing the number of dedicated threads, particularly if the client and server are

multiprocessor machines, can improve FileLoad performance.
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Option

Description

Attach to the latest revision
when the specified revision
cannot be found

Select this option if you want files for items containing revision values that do not exist in the
Agile PLM database to be attached to the latest released revision of objects in Agile PLM. If no
released revisions exists, Fileload adds the file to the Introductory revision. (The
SecondaryKey field in the Index file holds the revision value of the item.)

The attachment is rejected and written to the Bad file and Log file under the following
conditions:

o If you do not select this option, the Index file attachment rows for items containing revision
values that do not exist in the Agile PLM database are rejected and written to the Bad file
and the Log file for later troubleshooting.

o If Attach to the Latest Revision is checked, the file is attached to the latest released
revision of the object. If the object is in Preliminary status, it is attached to the Introductory
revision.

= When an Index file contains a blank SecondaryKey field, the file is attached to the
Introductory revision of an item. The Null revision in the Index file means the Introductory
revision.

= To upload files to pending revisions, the revision value in the Index file should be enclosed
in parentheses, for example, (A) or (1.0).

Attach Files to Incorporated
Items

Check this box if you want to allow attachments to be added to incorporated Items (assuming
you have appropriate privileges). If this box is not checked, and FileLoad attempts to attach
files to an Item that has been incorporated, you may see the message “Cannot perform this
operation because the object <Object number> has been incorporated.”

Note: If any item in your Index file is already incorporated, make sure Attach Files to
Incorporated Items is checked.

Create a Separate Folder for
Each File

When this box is checked, FileLoad load files into separate file folders.

Otherwise, FileLoad handles consecutive rows that have the same PrimaryKey value
differently. It uses the same file description for both files and adds the files to the same file
folder.

Log File Directory
(Java Client)

Specify a location in which to create log files.

OK (Java Client)
Start Loading (Web Client)

Starts reading the Index file and processing attachments.

Close (Java Client)
Cancel (Web Client)

Closes the FileLoad window or page.

Note: The Cancel and Close buttons are disabled once the loading process has started.

Important If FileLoad stops without a completion message, it may have encountered severe network
difficulties and not completed the load. In this case, you must validate that the last file in
the “load” is in the target database. If it is not and it does not appear in the Bad file, you
must determine where FileLoad stopped, then load the remaining files.

Page - 141




Import/Export Guide

Evaluating the Results

This section describes how to evaluate FileLoad results in the Java Client and Web Client.

Evaluating FileLoad Results in Java Client

In Agile Java Client, the FileLoad summary appears in an expanded portion of the FileLoad window.

Total 10 Processed 10
Bad 4 loaded &
Start Time 10/28/2005 1:54:38 End Time 107282005 1:55:6

FileLoad log files are stored in the specified Log File Directory. You can open the log files in a text
editor to view them. For each session, FileLoad creates the following log files:

o indexfile.date.time_BAD — Contains the rows from the Index file that were rejected during the
FileLoad process.

o indexfile.date.time_LOADED - Contains the rows rejected from the Index file that were
successfully loaded during the FileLoad process.

= indexfile.date.time_LOG — Contains each row from the Index file that was rejected during the
FileLoad process, along with an error message.

o indexfile.date.time_SUMMARY — Contains the FileLoad summary information.

Note If you rename the log files and give them a .TXT extension, they will
automatically be associated with a text editor.

Evaluating FileLoad Results in Web Client

In Agile Web Client, the FileLoad Summary appears after FileLoad has finished processing the
Index file attachments.

Attachment loading results are shown in FileLoad Summary.

Click View Bad File to open or save the log of bad records (LogFile.BAD). It contains rows from the
Index file that were rejected during the FileLoad process.

Click View Log File to open or save the log file (LogFile.LOG), which contains each row from the
Index file that was rejected during the FileLoad process, along with an error message.

Note Agile recommends that you save log files to disk first and then view them. When you save

a log file, add .TXT as the extension so the file is automatically associated with a text
editor.

To close the FileLoad page, click Done.
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Sample Log File Output

Each rejected Index file row in the Bad file is also written to the Log file with an explanatory error
message:

CHANGE,23450,,D:/dwg/0021c.dwg,FILE, Torque Widget
< Cannot find the file to be attached. >

ITEMBAD,1000-02,666,D:/dwg/0021c.dwg,FILE, Torque Widget
< Invalid object type. >

MFR,MFR_TEST1,,D:/dwg/0031e.dwg,FILE,Cap Widget
< Object not found. >

Revising and Reloading Rejected Attachments

Each rejected row from the Index file is written to both the Bad file and the Log file.
= The Bad file contains only the rows rejected from the Index file.

= The Log file is the same as the Bad file, but also includes an explanatory error message for
each rejected attachment row.

Use the error messages in the Log file as a guide to revising the rejected rows in the Bad file.

Important Do not commit to using the loaded-in files until you have verified that they are exact
copies of the source files. That is, all source files should be preserved while there remains
any possibility that a file or files could be needed if there was a problem during the loading
operation.

To work with the Log and Bad files:

15. Locate the Bad file and Log file, and open each in a text editor.

16. Revise the rejected attachment rows in the Bad file, using the error messages in the Log file.

17. Save the revised Bad file as a new Index file, but add a number to the filename. For example,
IndexBADL1.txt. This allows you to avoid overwriting the original Index file, and maintains an
archive of processed Index files.

18. Select and process the new Log file. See Processing Attachments on page 139.

19. Repeat this revision and reloading process until no more bad records appear in the FileLoad
Summary.

Caution FileLoad will attach all specified files again if it is re-run against an Index file that has
already been loaded. If you are using multiple Index files, always track which files have
been loaded successfully. It is difficult and time-consuming to determine and remove
duplicate attachments.
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Error Messages

This section lists FileLoad error messages you may encounter with applicable descriptions:

Attachment tab is invisible.

Attachment tab of the objects that you want to add files is not active in Administrator.
Attachment tab must be marked visible by an Agile PLM administrator using Agile Java Client.

Cannot find the file to be attached.

Revise and correct the path and spelling of the attachment file name in the Index file entry. If
you attached a URL, note that the supported protocols are FTP, HTTP, file, and HTTPS; there
is no verification of the address.

Cannot find object <primary key>.

The target object to receive the attachment cannot be located in the database. The object is the
combination of the first three row fields: ObjectType, PrimaryKey, and SecondaryKey. Verify
that the values for these fields are entered correctly in the Bad file and that an object of that
name exists in the database. Add the object or modify the Index file, as necessary.

Cannot find specified revision.

The Item revision identifier in the Index file does not exist in the database, and Attach to latest
revision was not selected in the FileLoad Options. See Processing Attachments on page 139.

Cannot find the Index file or the Index file is empty.

The path of the Index file is not correct (if you entered the Index file path manually) or the Index
file you located is empty.

Cannot find the list value.

All or some list values for flex List or Multilist fields are not valid.

Cannot perform this operation because the attachment is checked out

The file folder for the specified attachment is checked out, so the file can’t be uploaded. Make
sure the file folder is checked in, and then use FileLoad again to upload the file.

Cannot perform this operation because the object <Object number> has been incorporated.

The attachment table is read-only because the Item is incorporated by an ECO. To add
attachments to incorporated Iltems, make sure Attach Files To Incorporated Items is checked in the
FileLoad Options dialog box.

Failed to attach files.

Reason for rejection unknown or the result of multiple errors. Make sure the object exists in the
database, check the Index file entry, and retry. Make sure that you have the Creator role.
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Empty files are not valid to be added.

Attached files are 0 (zero) in size.

File Servers may be down. Please check the File Server Configuration.

The Agile File Manager server is down. Go to the machine where File Manager is installed and
start it. On Windows, this involves starting the Apache Tomcat service.

Invalid date format.

The date format in flex Date fields is not in accordance with the Date/Time formats in the user's
profile.

Invalid number.

The value for flex Numeric fields is not numeric (for example, it could include a letter string).

Invalid object type.

Be sure the Index file row starts with a valid object type keyword. See Object Type Keywords
on page 136.

Invisible attribute fields.

The specified flex field is not visible. Flex fields must be enabled (that is, made visible) in the
Administrator function.

Not a legal attachment type. Must be FILE or URL or INPLACE.

If you use the FileLoad utility in the Agile Web Client, the AttachType (attachment type) field
value must be FILE or URL. If you use the FileLoad utility in the Agile Java Client, a third
attachment type, INPLACE, is supported.

Number of fields provided is less than the minimum required.

Each Index file row must have at least six delimited fields. Empty fields must be marked by a
double set of delimiter characters.

Note When using the tab as the delimiter, be sure there is no tab after the last field in each row.

Primary Key (2nd) field empty.

The second field — PrimaryKey — is always required. It must always contain, depending on the
base class, a valid object number or name. See Primary and Secondary Keys on page 136.

The attribute fieldname was not found in the Attachments tab.

This message indicates that the specified flex field name cannot be found. Flex fields must be
enabled (that is, made visible) in the Administrator function. Also, if the Attribute Name-Value
separator in Index files is not correct, the field name cannot be properly identified.
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The number length exceeds Maxlength.
The string length for flex Numeric fields exceeds the Maxlength defined in Administrator.

The number value is not between Min Value and Max Value.

The value for flex Numeric fields is not between Min Value and Max Value defined in
Administrator.

The string length is not between 0 and Maxlength.

The string length for flex Text fields exceeds the Maxlength defined in Administrator

The user has insufficient privileges.

The user has insufficient privileges to files attached to objects.

Unable to connect to Agile Application Server.

Make sure that the Agile Application Server is running and that you log in as a user with the
Checkin privilege.
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